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Introduction

This section provides the general information for the Teledyne Paradise Datacom line of controllers. While previous models
of the controllers were specifically built to handle a certain type of system, the new system controllers with the touchscreen
display can be configured to handle a variety of system types without the need for special hardware modifications.

Legacy controllers include:

e RCP2-1100 for 1:1 redundant systems;

RCP2-1200 for 1:2 redundant systems;

FPRC-1100 for 1:1 phase combined systems;

FPRC-1200 for 1:2 phase combined systems;

RCP2-SWITCH for use as a maintenance switch controller;

RCP2-1000-CO as a remote control panel for a remote Compact Outdoor SSPA.

e o o o o

All of the configurations listed above may now be controlled by the system controller with touchscreen. Any mention of RCP,
FPRC or RCP2 throughout this manual refers to the new line of system controllers with touchscreen display.

This section describes the supplied equipment and safety precautions.



Description

The controller is used to monitor and control amplifiers configured in 1:1 and 1:2 redundant systems, 1:1 and 1:2 phase
combined systems, as a maintenance switch controller, or as a remote control panel for a single remote amplifier. The
controller can be configured provide control of one, two, or three amplifiers and any corresponding transfer switch.

&% Note: The RCP2-1000-CO is programmed with a different firmware set than the other controllers. It can
only act as a RCP2-1000-CO remote control panel.

The controller can be used in LNA, LNB, and SSPA systems as well as frequency converter systems. A RF Signal Path
Display on the front panel indicates the RF path and the fault status of the equipment. User interface and control is provided
in several forms:

¢ Front panel, local control via touchscreen

« 37-pin parallel control port with contact closures and opto-isolated inputs

¢ Serial data control via RS232 or RS485 (2 or 4-wire)

* 10/100 Base-T Ethernet interface. Ethernet control options include embedded web page, SNMP interface and
propriety IP interface to connect over Paradise Universal M&C software

Additional features include:
« User-friendly front panel touchscreen display for local monitor & control;

¢ Universal input, power factor corrected power supply;
¢ Dual AC mains entries with removable power supplies.



Equipment Supplied

The following equipment is supplied with each unit:

e System Controller
¢ (2) IEC Line Cord Sets

Optional equipment includes:

¢ Rack Slides

¢ 100 ft. (30 m ) Control Cable

« Switch Plate Mating Connector
e DC Operation



Specifications
Refer to the specification sheet for complete specifications on the RCP2/FPRC Redundant System Controllers.

Outline Drawing

Figure 1 shows an outline drawing of an redundant controller.
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Figure 1: Outline Drawing, Typical Redundant System Controller Unit

The system controller is also available with 24/48VDC input, or with a high output power option (-HP), both of which have
removable power supply assemblies of the respective type.
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Safety Considerations

Potential safety hazards exist unless proper precautions are observed when working with this unit. To ensure safe operation,
the user must follow the information, cautions and warnings provided in this manual as well as the warning labels placed on

the unit.

High Voltage Hazards

High Voltage for the purpose of this section is any voltage in excess of 30 volts. Voltages above this value can be hazardous
and even lethal under certain circumstances. Care should be taken when working with devices that operate at high voltage.

& Al probes and tools that contact the equipment should be properly insulated to prevent the operator
from coming in contact with the voltage.

&% The work area should be secure and free from non-essential items.

& Operators should never work alone on high voltage devices. There should always be another person
present in the same work area to assist in the event of an emergency.

Ay Operators should be familiar with procedures to employ in the event of an emergency, i.e., remove all
power, CPR, etc.

& An AC powered unit will have 115 VAC or 230 VAC entering through the AC power connector. Caution is
required when working near this connector, the AC circuit breaker, or the internal power supply.

High Current Hazards

Many high power devices are capable of producing large surges of current. This is true at all voltages, but needs to be
emphasized for low voltage devices. Low voltage devices provide security from high voltage hazards, but also require higher
current to provide the same power. High current can cause injury from burns and explosion. The following precautions should
be taken on devices capable of discharging high current:

/% Remove all conductive personal items (rings, watches, medals, etc.)
&% The work area should be secure and free of non-essential items.

& Wear safety glasses and protective clothing.

& Operators should never work alone on high risk devices. There should always be another person present
in the work area to assist in the event of an emergency.



& Operators should be familiar with procedures to employ in the event of an emergency, i.e., remove all
power, CPR, etc.

Electrical Discharge Hazards

A spark can not only create ESD reliability problems, it can also cause serious safety hazards. The following precautions
should be taken when there is risk of electrical discharge:

& Follow all ESD guidelines

% Remove all flammable material and solvents from the area.

& Al probes and tools that contact the equipment should be properly insulated to prevent electrical
discharge.

&% The work area should be secure and free from non-essential items.

iy Operators should never work alone on hazardous equipment. There should always be another person
present in the same work area to assist in the event of an emergency.

& Operators should be familiar with procedures to employ in the event of an emergency, i.e., remove all
power, CPR, etc.

Keep in mind that ground potential on both ends of long cable runs may be significantly different due to various factors.
These ground potentials equalized by a cable ground signal line. Hence, it always a good practice to make
connect/disconnect interface connectors when the equipment on both ends of a long cable run is powered down. This
practice will minimize risk of damage of electrical interfaces due to unbalanced ground potentials.
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Introduction

This section provides information for the initial inspection, installation, and external connections for the RCP controller.



Inspection

When the unit is received, an initial inspection should be completed. First ensure that the shipping container is not damaged.
If it is, have a representative from the shipping company present when the container is opened. Perform a visual inspection

of the equipment to make sure that all items on the packing list are enclosed. If any damage has occurred or if items are
missing, contact:

Teledyne Paradise Datacom
11361 Sunrise Park Drive
Rancho Cordova, CA 95742 USA
Phone: +1 (814) 238-3450



Mounting

The Teledyne Paradise Datacom RCP controller is designed to be mounted in a standard EIA 19 inch equipment rack. The
depth of the chassis, excluding rear panel connectors, is 13.19 inches (335 mm). The height of the chassis is 1.7 inches (44
mm) or 1 rack unit.

Optional 22 inch (559 mm) rack slides with extensions are available.



Storage and Shipment

To protect the controller during storage or shipping, use high quality commercial packing methods. Reliable commercial
packing and shipping companies have the facilities and materials to adequately repack the equipment.



Cable Connections

The controller has a wide range of I/O interconnections available at the rear panel. The controller rear panel is shown in
Figure 1.

Figure 1: Rear Panel, System Controller

Control Cable Connector (J3) - MS3112E16-23S

The primary connection between the controller and the LNA/LNB (Low Noise Amplifier/Low Noise Block Converter) switch
plate or SSPA (Solid State Power Amplifier) switch assembly is through J3. The connector is a 23-pin circular connector, type
MS3112E16-23S (See Figure 2 and Table 1). For external waveguide switches, a standard 100 ft. (30m) cable, L201061
should be used.

Figure 2: Control Cable Connector (J3)
Table 1: Switch Connector (J3) Pin-Outs

Pin Description
Power Supply #1; +13-17 VDC, 900mA; or, +24V, 1.5A (-HP version only)
Power Supply #2 +13-17 VDC, 900mA; or, +24V, 1.5A (-HP version only)
Power Supply #3 +13-17 VDC, 900mA; or +24V, 1.5A (-HP version only)
Switch Common, +26 VDC, 5A max
AMP Support GND
Switch Common, +26 VDC, 5A max

Switch #1, Position 1 (Tx) (primary)
Switch #1, Position 1 (Tx)
Switch #1, Position 2 (Tx)

Switch #1, Position 2 (Tx) (primary)

Switch Common, +26 VDC, 5A max

Switch Common, +26 VDC, 5A max
Switch #2, Position 1 (Rx)

Switch #2, Position 1 (Rx) (primary)
Switch #2, Position 2 (Rx)

Switch #2, Position 2 (Rx) (primary)

AMP Support GND

AMP Support GND
Switch Common, +26 VDC, 5A max
Switch Common, +26 VDC, 5A max
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& Note: The RCP2-1000-CO remote control panel does not require connection to this port.

Serial Port, Main (J4) - DB9 (F)

The main serial port is for connection with any host computer. This port contains both RS-232 and RS-485 communication in
half duplex. RS-485 interface is compatible with 2- or 4-wire interface connection. As an additional protection measure, this
port features full galvanic isolation from the chassis ground. For convenience, a set of Form C relay contacts are available at
this port as a Service Request. The Service Request is essentially a Summary Alarm for any system faults that occur. The
baud rate and other communication parameters are selectable via the front panel menu.

The pin-out is shown in Table 2. Note that the pin-out is standard DTE; a null modem is not required when connecting to a
standard PC serial port.

Table 2: Serial Port, Main (J4) Pin-Outs

Pin Description Notes
1 RS-485 TX+
2 RS-232 Out or RS-485 TX-
3 RS-232 In or RS-485 RX-
4 RS-485 RX+
5 Signal Ground
6 Service Request 1 Closed on Fault
8 Service Request 2 Open on Fault
7 Service Request Common Form C Common
9 Termination (120 Ohm) Connect to pin 4 to terminate unit on end of bus

Serial Port, Local (J5) - DB9 (M)

The local serial port is used to support special transceiver systems and remote control panels. The baud rate of this port is
fixed at 9600 Baud and cannot be changed. J5 is permanently configured for RS-485 half duplex communication. Table 3
details the local serial port pin-out. Port features full galvanic isolation from chassis ground.

Table 3: Serial Port, Local (J5) Pin-Outs

Pin Description Notes
1 RS-485 RX+

RS-485 RX-

RS-485 TX-

RS-485 TX+

Signal Ground

Ol || W|N

Termination (120 Ohm) Connect to pin 1 to terminate unit on end of bus

Service Port (J6) - Mini USB

A 5-contact Mini USB connector is used to provide flash re-programmability for the controller card. In order to reload
controller board firmware, connect this port to a standard PC USB port. See the Fault Analysis and Troubleshooting
section for a description of the firmware upgrade procedure.

Parallel /0 Connector (J7) - DB37 (F)

The controller has a full compliment of parallel monitor and control lines. A 37-pin D sub-style connector is used for the
parallel I/O signals, which are detailed in Table 4.



Table 4: Parallel /0 Port (J7) Pin-Outs

Identification Signal Pin Function Notes
Amp 1 Alarm Output | 1 Closed on Fault Relay contacts: 30VDC @ 0.5A
Amp 1 Alarm Output | 20 Common
Amp 1 Alarm Output | 2 Open on Fault
Amp 2 Alarm Output | 21 Closed on Fault Relay contacts: 30VDC @ 0.5A
Amp 2 Alarm Output | 3 Common
Amp 2 Alarm Output | 22 Open on Fault
Amp 3 Alarm Output | 4 Closed on Fault
Amp 3 Alarm Output | 23 Common
Amp 3 Alarm Output | 5 Open on Fault
Auto/Manual Mode Output | 24 | Closed on Manual
Auto/Manual Mode Output | 6 Common
Auto/Manual Mode Output | 25 Closed on Auto
Local/Remote Mode Output | 7 Closed on Local
Local/Remote Mode Output | 26 Common
Local/Remote Mode Output | 8 Closed on Remote
Switch #1 Position Output | 27 | Switch #1, Position 1
Switch #1 Position Output | 9 Common
Switch #1 Position Output | 28 | Switch #1, Position 2
Switch #2 Position Output | 10 | Switch #2, Position 1
Switch #2 Position Output | 29 Common

Switch #2 Position Output | 11 | Switch #2, Position 2
Power Supply #1 Alarm | Output | 30 Closed on Fault

Power Supply #1 Alarm | Output | 12 Common

Power Supply #1 Alarm | Output | 31 Open on Fault

Power Supply #2 Alarm | Output | 13 Closed on Fault

Power Supply #2 Alarm | Output | 32 Common
Power Supply #2 Alarm | Output | 14 Open on Fault
Priority Setting Output | 33 | Closed on Priority 2
Priority Setting Output | 15 Common
Priority Setting Output | 34 | Closed on Priority 1
Fault Clear Input 37 | Ground to Activate 5mA max current on all inputs
Priority Select Input 17 | Ground to Activate Toggle Function
Auto/Manual Input 16 | Ground to Activate | Toggle Function; Alternate function: External Mute Input
Amp 3 Standby Input 36 | Ground to Activate
Amp 2 Standby Input 35| Ground to Activate
Amp 1 Standby Input 18 | Ground to Activate

Inputs Ground (isolated) | Common | 19

Ten Form-C relays are used for converter, switch position, and mode control. Each Form-C contact has a rating of 30 VDC @
0.5A, 110 VDC @ 0.3 A, and 125 VAC @ 0.5 A. The inputs and ground pins are isolated from the rest of the unit's circuitry.
Inputs are activated by pulling it down to the isolated ground pin. In order to fully utilize the built-in inputs protection, it is
recommended to keep the input's ground isolated from the chassis ground.

See the External mode description in the Touchscreen Operation section for instructions on how to use the Auto/Manual
Input (Pin 16) as an External Mute Input.



& Note: The RCP2-1000-CO remote control panel does not require connection to this port.

External Alarm Port (J8) - DB9 (F)

An external alarm port is provided to allow maximum flexibility of configurations. This allows the user to interface with the
alarm output of other equipment into the controller. Inputs are protected against ESD of £15 kV using the Human Body
model; against ESD of +8kV using the Contact Discharge method specified in IEC1000-4-2; and against ESD of £15 kV
using the Air Gap method described in IEC1000-4-2. Table 5 shows the external alarm pin-out.

Table 5: External Alarm Port (J8) Pin-Outs

Function Pin Notes
External Alarm 1 1 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage
External Alarm 2 2 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage
External Alarm 3 3 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage
Ground 4,8,9
Auxiliary Alarm 1 5 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage
Auxiliary Alarm 2 6 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage
Auxiliary Alarm 3 7 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage

& Note: The RCP2-1000-CO remote control panel does not require connection to this port.

Ethernet Port (J9) - RJ45 (F)

This is a RJ45 connector with integrated magnetics and LEDs. This port becomes the primary remote control interface when
the Interface option is selected to "IPNet" or SNMP interface as described in the Communication > Interface description of
the Touchscreen Operation section.

This feature allows the user to connect the controller to a 10/100 Base-T office Local Area Network and have full-featured
Monitor & Control functions through a web interface. See Table 6.

Table 6: Ethernet Port (J9) Pin-Outs

1 TX+

2 TX-

3 RX+

6 RX-
4578 Ground

& Note: IP address, Gateway address, Subnet mask, IP port and IP Lock address need to be properly
selected prior to first use.

LED lamps on the connector indicate network status. A steady Green light indicates a valid Ethernet link; a flashing Yellow
LED indicates data transfer activity (on either the Transmit and Receive paths). Starting with firmware version 6.00, the
controller can support multiple remote control interfaces. See the Remote Control Interface section for details.



Prime Power Connection (J1, J2)

Two separate removable power supplies are provided for fully redundant operation. Either of the two supplies is capable of
operating the system and its associated switches. Two AC power connectors are provided on the rear panel (J1,J2).



Removable Power Supply Modules

The unit has a redundant power supply array consisting of two modules. A failed power supply module may be removed from
the chassis by loosening the two captured thumbscrews and sliding the module out of the chassis, then unplugging the
quick-disconnect power pole connectors.

24V Power Supply Module

Figure 3 shows an outline drawing of a power supply module.
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Figure 3: Outline Drawing, 24V Power Supply Module
The following list comprises the specifications for the standard power supply module:
Plug: IEC, 250V, 10A, Male plug with wire-form AC Cable Clamp
Fuse: 2 Amp 5x20mm
Power Supply: 85-264 V input, 28V output, 175W
Connector to chassis: Quick-connect Power pole

See the Fault Analysis and Troubleshooting section for directions on identifying and replacing a failed power supply
module.

24V Power Supply Module, High Power option

Figure 4 shows an outline drawing of a power supply module for units utilizing the High Power (-HP) option.
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Figure 4: Outline Drawing, -HP Option Power Supply Module
The following list comprises the specifications for the -HP option power supply module:
Plug: IEC, 250V, 10A, Male plug
Fuse: 2 Amp 5x20mm
Power Supply: 85-264 V input, 28V output, 175W
Fan: 40mm, 24V, 4.9 CFM
Connector to chassis: Quick-connect Power pole

See the Fault Analysis and Troubleshooting section for directions on identifying and replacing a failed power supply
module.

48V Power Supply Module

Figure 5 shows an outline drawing of a 48V power supply module.
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Figure 5: Outline Drawing, 48V Power Supply Module
The following list comprises the specifications for the 48V power supply module:

Plug: MS3112E10-6P Circular MIL connector, 6-pin (MS3116F10-6S mating)
Circuit Breaker: 6 Amp

Power Supply: 48V, 150W

Connector to chassis: Quick-connect Power pole

See the Fault Analysis and Troubleshooting section for directions on identifying and replacing a failed power supply
module.
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Design Philosophy

The redundant controller was designed to achieve a new level in high reliability, maintenance free operation. A tightly
integrated modular assembly approach has been used to realize an extremely versatile controller while maintaining its user
friendly operator interface. Four basic building blocks are combined in the redundant system controller:

1. Redundant Power Supplies
2. Digital Core Board Assembly
3. /0 Board Assembly

4. Touchscreen Display

Redundant Power Supplies

A block diagram of the controller is shown in Figure 6. Two power supplies are provided in the controller. These supplies can
be connected to two independent AC sources for absolute system redundancy. Either supply is capable of operating the
controller and its associated transfer switches. Both power supplies have universal input capability operating over an input
voltage range of 85 to 265 VAC and line frequencies of 47 to 63 Hz. The power supplies have a power factor of 0.93
ensuring minimum line harmonic products. Each power supply produces +26 VDC.

28V 5 Amp peak output
to RF Switch Drive

PS Overload Protection

PS2 28V 7A* M ¢ PS1 28V 7A"

+13VITVI24V
0.9A/1.54"

HIVATVI4V
09/1.54*

+13VITVI24V
0.9A/1.54"

+13V/17VI24V Out to LNA/LNB Plate

* Continuous 1.5A output only available with -HP version,
Standard RCP2 4A with 1.5A peak current, 0.9A continuous

Figure 6: Block Diagram, Power Supply Configuration

The controller provides three channel power outputs for connecting external LNA/LNB units. In standard configuration, each
LNA/LNB channel can be selected to supply 13V or 17V with up to 900 mA DC current output. Output voltage is user-
selectable either from the front panel menu or over the remote control interface. The -HP model provides an additional 24V
1500 mA output option for use with higher power external equipment.

All channels are protected from overload and will reduce output if the maximum power output capacity is exceeded by an
external load.

% Note for 24V 1500 mA channel output: In order to provide an equal load to both internal AC/DC supplies,
channels derive their power asymmetrically: Channel 1 from PS2, Channel 3 from PS1; and Channel 2 from
either PS2 or PS1. See Figure 6. This configuration allows default standby Channel 2 to power up in case
one of the AC/DC power supplies fails. In order to conserve power from the remaining power supply, the
LNA/LNB channel will reduce its power output to 13V, 900 mA.

Digital Core Board
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The Digital Core Board is operated by a microcontroller unit. All digital 1/O lines feature transient absorbing devices and a
ground isolated barrier for extra protection. The power supply lines are protected by current limiting devices. The digital core
board also contains a USB port that allows the controller to be firmware upgradeable in the field.

I/0 Board Assembly

The 1/0 Board Assembly contains the primary parallel (hardware) interface circuitry of the controller. It is physically attached
to the Digital Core Board by a 40-pin header. The I/O Board provides user selectable output voltage: +13, 17 and 24 VDC
supply output for the LNB units.

Each output on a standard unit can supply continuously up to 0.9A and up to 1.5A in peak current. The -HP version can
supply 1.5A continuously. All channels are short circuit protected. The 10 Form C relays and opto isolated inputs for the
parallel I/O interface are included on this board assembly. A series of rugged N-channel enhancement mode MOSFET
devices provide the current sink circuitry to drive either one or two waveguide transfer switches.

Touchscreen Display

Rarely found in redundant controllers, the controller provides a large full-color touchscreen panel. This provides an extremely
user friendly interface. The touchscreen is directly interfaced to the microcontroller via the address and data bus. Virtually all
of the controller's setup and adjustments are accessible from the touchscreen. There is no need to access the interior of the
controller to make any setup changes.

The touchscreen may be configured as a redundant system controller (1:1 or 1:2), as a phase combined controller (1:1 fixed
phase combined or 1:2 phase combined), or as a maintenance switch. A great deal of human engineering has gone into the
design of this membrane panel. A full complement of alarm indicators are provided along with the mimic display which shows
the switch positions of the redundant system. An intuitive menu structure allows the user to easily set the operating
parameters, and monitor and control the connected system. Separate Action Buttons have been provided for frequently used
functions, further enhancing the controller's ease of use. See the Touchscreen Operation section.



Control Cable Considerations

The redundant controller is designed to drive negative 28 VDC latching style transfer switches. Latching means that the
switch has a self cutoff and does not require continuous current consumption. Some commonly used waveguide transfer
switches used in Teledyne Paradise Datacom Redundant Systems are given in Table 7.

Table 7: Commonly Used Waveguide Transfer Switches

Part Number Description Manufacturer Voltage Range Current
75SBOS 10.7-14.5 GHz (Waveguide/Coax) Sector -20to -30 VDC 0.80 Amps
3NBGS 5.8-6.4 GHz (Waveguide/Coax) Sector -20 to -30 VDC 2 Amps
2SBGS 3.7-4.2 GHz (Waveguide/Coax) Sector -20to -30 VDC 3 Amps
4BF 1.7-2.6 GHz (Waveguide) Sector -20 to -30 VDC 4 Amps

As Table 7 shows, the switch drive current is dependent on the frequency band which determines the physical size of the
switch motor. Therefore the system designer must consider the resistive cable losses when choosing a control cable length.

Similarly, the system designer must ensure use of the proper cable insulation for the particular installation. Teledyne
Paradise Datacom uses both standard service and burial grade for redundant system control cables. Standard service cable
has a PVC jacket which is ultra violet ray (UV) stable in outdoor use. However, standard service cable should not be
immersed in water or be buried underground for long periods of time. For such applications, burial grade cable should be
installed.

The controller sources a maximum +26 VDC @ 5 Amps to the transfer switch. A typical -28 VDC waveguide switch will
operate over a range of -20 to -30 volts. Therefore, the minimum voltage required at the waveguide switch is -20 VDC. Using
this as a design guideline, the control cable should be sized so that it does not drop more than 6 VDC from the controller to
the switch.

Teledyne Paradise Datacom control cables utilize 20 conductors of #18 AWG stranded wire. The control cable schematic is
shown in Figure 7. The resistance of #18 AWG stranded wire is 6.5 ohms per 1000 feet. The controller switch connector (J3)
allows contacts for two wires per switch connection. Therefore, two conductors can be paralleled for both the source and
return lines for the transfer switch. With a maximum allowable voltage drop of 6 volts, this equates to a 3 volt drop in the
source wires and 3 volt drop in the return wires. This is shown schematically in Figure 7. Using four (4) parallel #18 AWG
conductors gives a resultant cable resistance of 1.6 ohms per 1000 feet, or 0.0016 ohms per foot.
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Figure 7: Cable Losses to Transfer Switch

To calculate the maximum cable length that can be accommodated to the transfer switch, first consider the current draw by
the switch either from the manufacturer's data or from Table 7. Next divide this current into 6 volts. This gives the maximum
cable resistance to and from the switch. Finally, divide this cable resistance by 0.0016 ohms/ft. to find the maximum cable
length. This is shown in the following example:

Switch Current draw = 3 Amps

6 V / 3 Amps = 2 ohms (maximum cable resistance)
2 ohms/0.0016 ohms/ft. = 1250 ft.;

maximum cable length using (4) #18 AWG connectors

Table 8 gives the maximum cable length for some popular switches.


http://stc-ppapp-web02/Intranet/xml/216351DRAFT/images/cable-losses-to-switch.png
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Table 8: Maximum Cable Length for Selected Switches (Single Switch Systems)

Part Number Description Manufacturer Maximum Cable Length
75SBOS 10.7-14.5 GHz (Waveguide/Coax) Sector 4,690 ft. (1,430 m)
3NBGS 5.8-6.4 GHz (Waveguide/Coax) Sector 1,880 ft. (572 m)
2SBGS 3.7-4.2 GHz (Waveguide/Coax) Sector 1,250 ft. (381 m)

4BF 1.7-2.6 GHz (Waveguide) Sector 938 ft. (286 m)
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Introduction

All versions of the RCP controller are available with a front panel touchscreen, from which the user can control the connected
amplifier or amplifier system, and obtain information about the operational status of the connected amplifiers.

There are four main areas on the touchscreen display, as shown in Figure 1:
* Menu [1]

* Fault Indicators [2]

» RF Signal Path Display [3]

* Action Buttons [4]
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Figure 1: Main Areas of the RCP2-1000-CO Touchscreen Front Panel

Menu

This area is where all menu selections are made. See the Local (Front Panel) Menu Structure section below for a
complete description of the menu selections.

Fault Indicators

Up to five fault indicators are shown in the left-most section of the touchscreen display. The Summary fault indicator is
always displayed at the top. The user can select up to four other fault indicators to be displayed. See the Config Faults
section.

By default, in addition to the Summary fault indicator, the following fault indicators are shown:
e Temperature
e DC Current
e DC Voltage
e Unit Online

If the fault indicator is green, it means there is no fault present for that fault parameter. If the fault indicator is flashing red, a
fault exists for that fault parameter. If the fault indicator is yellow, a communication error with the module exists.

Depending on fault settings, the presence of certain types of faults will also trigger a Summary fault.

RF Signal Path Display

To the right of the fault indicators is the RF Signal Path Display of the connected unit. The display shows the operational
state of the connected ampilifier, input RF path and output RF path. It also displays the current attenuation setting and RF
output power value.
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Figure 2: RF Signal Path Display

A green amplifier symbol (triangle symbol) indicates that the amplifier is functioning normally. A red amplifier symbol
indicates that the amplifier has a fault condition.



Action Buttons

Up to two action buttons may appear to the far right of the touchscreen. These buttons are typically used to trigger common
functions without having to navigate through the menu structure.

By default, the Mute (TX) button is on top, and the Attenuation button is on the bottom. See Figure 3. The button selection
may be customized by the user. See the Config Buttons section.

Figure 3: Action Buttons

Mute (TX) Button

The Mute (TX) Action button allows the user to quickly mute or unmute the connected amplifier.

Tapping the Mute (TX) button results in a confirmation window (unless prompts are disabled in the Options > Front Panel >
Confirm Prompt menu) to change the mute state of the connected amplifier. Tap the OK button to change the mute state or
the Cancel button to keep the current mute state. See Figure 4.

Confirmation X
Are you sure you want to set:

[ 0K ) Mute State = Mute (Cancel)

Figure 4: Action Button > Mute Setting

If confirmation prompts are disabled, tapping the Mute (TX) button will toggle the mute state of the amplifier between muted
and unmuted.

Attenuation Button

The Attenuation Action button gives the user the ability to alter the gain setting of the connected amplifiers from the
touchscreen. Any adjustments to attenuation using this button are immediately applied to the connected amplifiers.

Tapping the Attenuation button opens the attenuation setting screen. See Figure 5. The current attenuation setting is
displayed in the green window. The user may adjust the ones place and the tenths place by touching the up and down
arrows on the screen. Tap the OK button to accept the attenuation setting.

Attenuation

Attenuation settings are applied
immediately.

Figure 5: Action Button > Attenuation Setting
Standby State Button

The Standby State Action button allows the user to switch the standby state of the connected amplifier between the Standby
state and the Online state.

Tapping the Standby State button results in a confirmation window (unless prompts are disabled in the Options > Front
Panel > Confirm Prompt menu) to change the standby state of the connected amplifier. Tap the OK button to change the
standby state or the Cancel button to keep the current state.

Control Mode Button

The Control Mode button allows the user to switch between Local control or Remote only control of the controller. Tapping
the Control Mode button results in a confirmation window (unless prompts are disabled in the Options > Front Panel >
Confirm Prompt menu) to change the control mode to either Local or Remote mode. A yellow indicator on the button shows
which mode is currently active for the unit. Tap the OK button to change the control mode or the Cancel button. See Figure 6.

Confirmation X
Are you sure you want to set:

t 0K ) Control Mode = Remote (Canceli

Figure 6: Action Button > Control Mode Setting Confirmation



If confirmation prompts are disabled, tapping the Switch Mode button will toggle the control mode between Local and

Remote.

Note that when the unit is in Remote mode, the user will not be able to access any functions from the touchscreen except the
Local/Remote Action button. A message on the display will indicate "Unit in Remote Mode". See Figure 7.
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Unit in Remote Mode

Figure 7: Display When in Remote Mode



Local (Front Panel) Menu Structure

Figure 8 shows the Main Menu hierarchy.

Figure 8: Main Menu Buttons

There are eight main levels of menu selections.

« Status - Unit information menu sublevel

« Communication - All communication-related settings

» Operation - Unit operation related settings

« Fault Setup - Fault handling settings

» Redundancy - All settings related to redundant system modes

» Options - Miscellaneous settings and functions

» Info - Display of connected unit/controller information and time settings

The user should tap the button of interest to proceed to the next menu level. When navigating the menu, the user can tap the

Home icon to go back to the main menu at any time. There are also icons that may be used to go back to the previous
screen.

Status Menu

Figure 9 shows the Status menu.

Figure 9: Status Menu

The Status menu includes the following buttons:

« Fault Panel

RCP-1000
* RF/Temp

DC Voltage

« DC Current

» Custom Status
Fault Panel Menu

Figure 10 shows the Fault Panel.

Figure 10: Status > Fault Panel



The Fault Panel displays the fault status for various parameters monitored by the unit's controller. A green icon next to the
unit condition title indicates a non-faulted state. A red icon next to the unit condition title indicates a faulted state. A yellow
icon indicates a communication error. A black icon designates a condition not applicable to the unit.

Fault states for the following conditions are displayed: Summary fault, Temperature fault, DC Current fault, DC Voltage fault,
Forward RF fault, External Mute status (green = no external mute), Internal Mute status (green = no internal mute), BUC
fault, Spare fault, Reflected RF fault, Auxiliary fault, RF Switch 1 fault, RF Switch 2 fault, Comm Link status and Unit Online
status (green = unit online).

RCP-1000 Menu

Figure 11 shows the RCP-1000 menu.
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The RCP-1000 menu summarizes the quality of the serial control link to the remote amplifier, as well as the internal
temperature of the RCP unit and the current provided to an external LNB.

Figure 11: Status > RCP-1000

Parameters displayed include:

o Missed Packets - Displays the number of unanswered request packets since the last RCP power-up or since the
last "Clear Faults" command was initiated.

¢ TX/RX Ratio - Shows the percentage of successful request/response packets out of total number of sent packets.
This value begins calculation upon RCP power-up and gets reset when a "Clear Faults" command is executed by
the operator.

¢ Disconnects - This value indicateds the number of disconnect events (5 or more unanswered packets in a row) that
have occurred since the last RCP power-up or since the last "Clear Faults" command.

o Temperature - Shows the internal temperature of the RCP unit.

o LNB Current - Displays the current consumption of an externally connected LNB (if equipped).

RF/Temp Menu

Figure 12 shows the RF/Temp menu.

Figure 12: Status > RF/Temp Menu

The RF/Temp menu displays the following measured values from the connected amplifier:

e Forward RF - The forward RF output power of the amplifier, in dBm or Watts (depending on operator selection),
with an accuracy of 0.1 dB.

¢ Record High RF - The record high RF output of the amplifier.

e SSPA Temperature - The current temperature of the amplifier's internal baseplate in degrees Centigrade.

¢ Record High Temp - The record high temperature of the amplifier is displayed here, displayed in degrees
Centigrade.

o Attenuation - Displays the amplifier's gain attenuation setting (in dB), with an accuracy of 0.1 dB.

¢ Reflected RF - Shows the reflected RF to the amplifier (if the amplifier includes a reflected power monitor, and the
RCP is configured to display this value).

DC Voltage Menu

Figure 13 shows the DC Voltage menu.

Figure 13: Status > DC Voltage Menu

The DC Voltage menu shows the following values:



e Master PS - Main power supply 1q output voltage with an accuracy of 0.1V. Normal output voltage should be in a
range of 11 to 58 V.

¢ Slave PS - Displays "N/A" unless connected amplifier is configured with a master/slave power supply.

* Master Reg. - Voltage regulator output. In an unmuted state, depending on the model of the connected amplifier,
thisvalue should read close to 10V for GaAs-based units and anywhere from 20 to 55V for GaN-based units. If the
SSPA is muted, this value should be close to OV for all units.

¢ Slave Reg. - Displays "N/A" unless the connected amplifier includes a master/slave power supply.

o Master Gate - Negative RF GASFET gates bias voltage. This value varies depending on the temperature and mute
state of the connected amplifier. The approximate value window is 1.5to 7 V.

* Slave Gate - Displays "N/A" unless the connected amplifier includes a master/slave power supply.

¢ PreAmp Gate - For units which include a preamplifier, displays the gate bias voltage of the pre-amp. Otherwise
displays "N/A".

DC Current Menu

Figure 14 shows the DC Current menu.

Figure 14: Status > DC Current Menu

The DC Voltage menu shows the following values:

e Master Current - DC current draw by the RF module of the remote amplifier from the main power supply. This value
varies depending on the model of the connected unit. If the ampilifier is muted, this value should drop to a range of
0 to 5A.

¢ Slave Current - Displays "N/A" unless connected amplifier is configured with a master/slave power supply.

o Total Current - Total of Master and Slave current draw.

Custom Status Menu

Figure 15 shows the Custom Status menu after the operator selected the parameters to be displayed. Up to eight (8)
parameters may be displayed. See the

Figure 15: Status > Custom Status Menu

Figure 16 shows the default display until the user assigns a set of parameters to be shown on this screen. See the Config
Status section.

()
-+ Configure custom status in Options —= Front Panel —> Config Status.

Figure 16: Status > Custom Status Menu

Communication Menu

Figure 17 shows the Communication menu.

Figure 17: Communication Menu

The Communication menu includes the following buttons:



« Serial

IP Setup

SNMP Setup

» Trap Setup

RCP Address

RCP Interface

Panel Setup

Serial Button

Tapping the Serial button opens the Serial menu, from which the user can select the Baud Rate and Serial Protocol used by
the controller. See Figure 18.

Figure 18: Communication > Serial Menu

Baud Rate Menu

Tapping the Baud Rate button opens the Baud Rate menu. The user may select from the available baud rates. Default baud
rate is 9600. See Figure 19.

Figure 19: Communication > Serial > Baud Rate Menu

Serial Protocol Menu

Tapping the Serial Protocol button opens the Serial Protocol menu. The user may select either Normal or Terminal
communication protocol. See Figure 20.

Figure 20: Communication > Serial > Serial Protocol Menu

IP Setup Button

Tapping the IP Setup button opens the IP Setup menu, from which the user can select the IP address and parameters used
by the controller. See Figure 21.

Figure 21: Communication > IP Setup Menu

IP Address

Tapping the IP Address button opens the IP Address menu, from which the user can enter the IP Address for the controller.
Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap each section to enter the
values for that octet. Default IP Address is 192.168.0.9. See Figure 22.



Figure 22: Communication > IP Setup > IP Address Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

& Note: Teledyne Paradise Datacom products use IPv4, Class C addressing.

Subnet Mask

Tapping the Subnet Mask button opens the Subnet Mask menu, from which the user can enter the Subnet Mask for the
controller. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap each section to
enter the values for that octet. Default Subnet Mask is 255.255.255.0. See Figure 23.

Figure 23: Communication > IP Setup > Subnet Mask Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

Tapping the Gateway button opens the Gateway menu, from which the user can enter the Gateway for the controller. Use the
numbered keypad on the screen to enter the numbers for the highlighted selection. Tap each section to enter the values for
that octet. Default Gateway is 192.168.0.1. See Figure 24.

Figure 24: Communication > IP Setup > Gateway Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

Local Port

Tapping the Local Port button opens the Local Port menu, from which the user can enter the Local Port for the controller. Use
the numbered keypad on the screen to enter the numbers for the highlighted selection. Default Local Port is 1007. See
Figure 25.

Figure 25: Communication > IP Setup > Local Port Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu. Tap the Cancel button to revert to the last
saved Local Port and return to the IP Setup Menu.

Lock IP

Tapping the Lock IP button opens the Lock IP menu, from which the user can enter the IP address from which requests will
be accepted by the controller. Use the numbered keypad on the screen to enter the numbers for the highlighted selection.
Tap each section to enter the values for that octet. See Figure 26. Default Lock IP Address is 255.255.255.255.



Figure 26: Communication > IP Setup > Lock IP Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

The LockIP selection gives the user the ability to increase the security measure for the IPNet protocol. The controller will
answer a request which comes only from the assigned IP address. For firmware prior to version 6.00, set this address value
t0 0.0.0.0 or 255.255.255.255 to disable this feature.

Starting with version 6.00, the Lock IP address function has been updated to allow "Binding" and "Masking" functions.
"Binding" means that the first datagram retrieved for this socket will bind to the source IP address and port number. Once
binding has been completed, the SSPA will answer to the bound IP source until the unit is restarted or reset. Without binding,
the socket accepts datagrams from all source IP addresses.

Address 0.0.0.0 allows all peers, but provides binding to first detected IP source; Address 255.255.255.255 accepts all
peers, without binding. If Lock IP is a multicast address, then the amplifier will accept queries sent from any IP address of
multicast group.

MAC Address

Figure 27: Communication > IP Setup > MAC Address Display
Web Password

Tapping the Web Password button opens the Web Password menu, from which the user can enter the web password which
is requested when the user attempts to communicate with the controller over IPNet using a web browser. Use the alpha-
numeric keypad on the screen to enter the value for the web password. When the alphabetic keypad is displayed, Tap the "#"
symbol to switch to the numeric keypad. When the numeric keypad is displayed, tap the "A" to switch to the alphabetic
keypad. Tap the "OK" button to confirm the entered password and return to the IP Setup Menu. Maximum password length is
20 characters. Erase all characters to disable password protection. Default Web Password is paradise. See Figure 28.

Figure 28: Communication > IP Setup > Web Password Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

SNMP Setup Button

Tapping the SNMP Setup button opens the SNMP Setup menu, from which the user can select the Community Get and
Community Set passwords, and review the User Info. See Figure 29.

Figure 29: Communication > SNMP Setup Menu

Community Get




Tapping the Community Get button opens the Community Get menu, from which the user can enter the Community Get
password which is requested when the user attempts to communicate with the controller over IPNET using SNMP. Use the
alpha-numeric keypad on the screen to enter the value for the web password. When the alphabetic keypad is displayed, tap
the "#" symbol to switch to the numeric keypad. When the numeric keypad is displayed, tap the "A" to switch to the
alphabetic keypad. Tap the "OK" button to confirm the entered password and return to the IP Setup Menu. Maximum
password length is 20 characters. Erase all characters to disable password protection. See Figure 30. Default Community
Get password is public.

Figure 30: Communication > SNMP Setuip > Community Get Selection

Tap the OK button to accept the entered values and return to the SNMP Setup Menu.

Community Set

Tapping the Community Set button opens the Community Set menu, from which the user can enter the Community Set
password which is requested when the user attempts to communicate with the controller over IPNET using SNMP. Use the
alpha-numeric keypad on the screen to enter the value for the web password. When the alphabetic keypad is displayed, tap
the "#" symbol to switch to the numeric keypad. When the numeric keypad is displayed, tap the "A" to switch to the
alphabetic keypad. Tap the "OK" button to confirm the entered password and return to the IP Setup Menu. Maximum
password length is 20 characters. Erase all characters to disable password protection. See Figure 31. Default Community
Set password is private.

Figure 31: Communication > SNMP Setup > Community Set Selection
Tap the OK button to accept the entered values and return to the SNMP Setup Menu.

User Info

Tapping the User Info button opens the User Info display screen. See Figure 32.

Figure 32: Communication > SNMP Setup > User Info Display

This screen is reserved for future development.

Trap Setup Button

Tapping the Trap Setup button opens the Trap Setup menu, from which the user can set the various SNMP trap parameters,
and assign the Network Management System (NMS) IP address which will receive the trap notifications. See Figure 33.

Figure 33: Communication > Trap Setup Menu

Tapping the Send FLT Trap button opens the Send FLT Trap menu, from which the user can set the Send FLT Trap
parameter. The value entered equals the number of attempts the unit will make to send all fault information to the assigned
NMS IP address. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Entering "0"
disables this feature. Tap the "OK" button to set the entered value. See Figure 34.
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Figure 34: Communication > Trap Setup > Send FLT Trap Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

Tapping the Send Cond. Trap button opens the Send Cond. Trap menu, from which the user can set the Send Cond. Trap
parameter. The value entered equals the number of attempts the unit will make to send the selected condition information to
the assigned NMS IP address. Use the numbered keypad on the screen to enter the numbers for the highlighted selection.
Entering "0" disables this feature. Tap the "OK" button to set the entered value. See Figure 35.

Figure 35: Communication > Trap Setup > Send Condition Trap Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

Tapping the Condition Trap button opens the Condition Trap menu, from which the user can select the controller condition
that will be monitored and trigger a trap notification if it falls outside the upper and lower limits defined by the user. See
Figure 36.
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Figure 36: Communication > Trap Setup > Condition Trap Selection
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Tick the checkbox beside the controller condition that will be monitored.

Tapping the Trap Subset button opens the Trap Subset menu, from which the user can set the Trap Subset parameter. This
parameter is required when the trap condition selected has multiple sources, such as multiple power supplies in a unit. The
value entered corresponds to the condition source selected. Use the numbered keypad on the screen to enter the numbers
for the highlighted selection. See Figure 37.

Figure 37: Communication > Trap Setup > Trap Subset Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

Tapping the Trap Lower Limit button opens the Trap Lower Limit menu, from which the user can set the lower limit of the
selected condition being monitored. Use the numbered keypad on the screen to enter the numbers for the highlighted
selection. See Figure 38.
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Figure 38: Communication > Trap Setup > Trap Lower Limit Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

Tapping the Trap Upper Limit button opens the Trap Upper Limit menu, from which the user can set the upper limit of the
defined condition being monitored. Use the numbered keypad on the screen to enter the numbers for the highlighted
selection. See Figure 39.

Figure 39: Communication > Trap Setup > Trap Upper Limit Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

Tapping the Trap Setup button opens the Trap Setup menu, from which the user can assign the Network Management
System IP address which will receive the trap notifications. Use the numbered keypad on the screen to enter the numbers for
the highlighted selection. Tap each section to enter the values for that octet. Tap the "OK" button to set the selected address.
The default address is 192.168.0.9. See Figure 40.
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Figure 40: Communication > Trap Setup > Trap NMS IP Selection

Tap the OK button to accept the entered values and return to the Trap Setup Menu.

RCP Address

Tapping the RCP Address button opens the RCP Address menu, where the user can assign the network address of the RCP
unit. See Figure 41.

Figure 41: Communication > RCP Address Menu

Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap the OK button to accept the
entered value and return to the Communication Menu. Tap the Cancel button to revert to the last saved value and return to
the Communication Menu.

RCP Interface

Tapping the RCP Interface button opens the RCP Interface menu, where the user can select the interface method used at
the main serial port of the RCP unit. See Figure 42.




Figure 42: Communication > RCP Interface Menu

Tick the checkbox beside the desired communication interface. Select between "RS232", "RS485", "IPNET" and "SNMP".

Panel Setup

Tapping the Panel Setup button opens the Panel Setup menu. See Figure 43.

Figure 43: Communication > Panel Setup Menu

Poll Mode

Tapping the Poll mode menu opens the Poll Mode menu, where the user can select the polling method for communcating
between the RCP and remote amplifier. See Figure 44.

Figure 44: Communication > Panel Setup > Poll Mode

e Compatible - This option sets the RCP unit to work with legacy Compact Outdoor amplifiers. This mode must be
selected for Teledyne Paradise Datacom amplifiers with serial numbers of 399999 and below. Extended serial
protocol fields such as the Reflected RF detector reading are disabled in this mode.

¢ Extended - This mode can be used for newer Teledyne Paradise Datacom amplifiers with serial numbers of
400000 and above. This mode must be enabled to work with SSPA units equipped with a Reflected RF detector.

& Unless otherwise directed by the factory, this setting should be set to Extended mode.

Remote Address

Tapping the Remote Address button opens the Remote Address menu, where the user can assign the network address of
the RCP. See Figure 45.

Figure 45: Communication > Panel Setup > Remote Address Menu

Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap the OK button to accept the
entered value and return to the Panel Setup Menu. Tap the Cancel button to revert to the last saved value and return to the
Panel Setup Menu.

Fiber Link

Tapping the Fiber Link button opens the Fiber Link menu. Teledyne Paradise Datacom no longer supports communication
with its amplifiers over fiber-optics. See Figure 46.

Figure 46: Communication > Panel Setup > Fiber Link Menu



& Note: This setting should be set to "Off".

Operation Menu

Figure 47 shows the Operation menu.

Figure 47: Operation Menu

The Operation menu includes the following buttons:
 Attenuation

* Mute

e Buzzer

» RF Units

« Control

Fan Speed

Gain Control

* Amp Address
Attenuation Menu
Tapping the Attenuation button opens the Attenuation menu, from which the user can select the amount of attenuation (in dB)

that should be applied to the gain of the amplifier. Use the numbered keypad on the screen to enter the numbers for the
highlighted selection. Tap the "OK" button to set the selected value. See Figure 48.

Figure 48: Operation > Attenuation Menu

Enter a value between 0 and 20.0 dB. If Auto Gain is enabled, the system will reserve 5 dB of attenuator range for gain
compensation and attenuation is limited to a value between 0 and 15.0 dB.

Mute Menu

Tapping the Mute button opens the Mute Menu, from which the user can mute or unmute the connected unit. See Figure 49.

Figure 49: Operation > Mute Menu

The Mute On and Mute Off selections offer the same function as the Mute (TX) Action Button.

Buzzer Menu

Tapping the Buzzer button opens the Buzzer menu, from which the user can enable or disable the buzzer alarm that is
triggered whenever a fault condition occurs. The current Buzzer state is checked. See Figure 50.



Figure 50: Operation > Buzzer Menu

Tick the checkbox beside the desired condition of the audible alarm buzzer.

RF Units Menu

Tapping the RF Units button opens the RF Units menu, from which the user can select the type of unit displayed on the
touchscreen. Values are dBm and Watt. The current unit type selected is checked. See Figure 51.

Figure 51: Operation > RF Units Menu

Tick the checkbox beside the RF unit type that will be displayed.

Control Menu

Tapping the Control button opens the Control Menu, from which the user can select either Local or Remote control of the
unit. The current Control mode is checked. See Figure 52.

Figure 52: Operation > Control Menu
Note that this menu performs the same function as the Control Mode Action button.

Tick the checkbox beside the desired control mode. If Remote is selected, all local control will be disabled, except for the
Control Action Button at the right of the touchscreen display. See Figure 53.
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Figure 53: Remote Control Mode Active
Fan Speed

Tapping the Fan Speed button opens the Fan Speed Menu, from which the user can select how the fans of the connected
amplifier operate. Note that no all amplifiers support this function. GaN Outdoor SSPAs with serial numbers greater than
399,999 are equipped with a Fan Speed Control option. See Figure 54.

Figure 54: Operation > Fan Speed Menu



¢ High: This option sets the fan speed to maximum. Air velocity will remain at the same level regardless of other
operation parameters.

o Auto: This setting allows the unit to control the cooling fan speed according to the internal RF module temperature.
If the module plate temperature remains below 50 °C, the fan speed will be set to minimum. If the registered
module plate temperature is above 50 °C, unit will gradually increase the fan speed. Fan speed will reach
maximum at a plate temperature of 65 °C.

¢ RF Level: This setting should be set on units without the fan speed control option. It will allow proper functioning of
the RF power monitor analog output. Applying this setting on units with the fan speed control option allows the fan
speed to be proportional to the output RF level. Fan speed will be set at the minimum when output RF is below a
detectable level. Fan speed will gradually increase when RF output increases within the detectable RF range. Fan
speed will be at maximum level when unit reaches saturated power (Psat).

Tick the checkbox beside the desired fan speed mode.
Gain Control

Tapping the Gain Control button opens the Gain Control Menu. The operator may select how gain attenuation is applied to
the connected amplifier. See Figure 55.
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Figure 55: Operation > Gain Control Menu

Ext. Analog - In analog voltage control mode, the operator needs to apply positive voltage between (J4, Pin A) and Ground
(J4, Pin V) from an external source. The applied voltage will be translated to the SSPA attenuation level and will determine
the linear gain of SSPA unit as follows:

e 2.5VDC = Maximum Gain: 75 dB (Attenuator set to 0 dB);
¢ 0.5 VDC = Minimum Gain: 55 dB (Attenuator set to 20 dB);

Voltage increments by 0.1V in a range between 0.5 to 2.5V will reduce the amount of attenuation by 0.1 dB steps. Voltages
below and above this limit will be treated as lower and upper limits of adjustment range. Gain adjust input typically has 20
kOhm pull down to the signal ground. Hence, with no external voltage applied, the SSPA will default to minimum gain (55
dB).

Serial Port - This attenuation control is the default method of controlling SSPA linear gain. In this method of control, the
specific attenuation is defined by the RCP controller, selected using the Embedded Web page or Universal M&C GUI, or sent
as a remote control command. The SSPA will retain the selected attenuation level in non-volatile internal memory until a new
command or selection is issued by the user.

Tick the checkbox beside the desired gain control mode.

Amp Address

Tapping the Amp Address button opens the Amp Address screen, where the operator can assign a network address to the
remote amplifier. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap the "OK"
button to set the selected value. See Figure 56.

Figure 56: Operation > Amplifier Address

Enter a value between 0 and 255.

Fault Setup Menu

Figure 57 shows the Fault Setup menu.
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Figure 57: Fault Setup Menu
The Fault Setup menu includes the following buttons:
» BUC Fault
e Aux Fault
» Forward Pwr

* Refl Pwr

Fault Latch
» High Temp
BUC Fault

Tapping the BUC Fault button opens the BUC Fault menu, from which the user can select the action and logic type that any
BUC faults would trigger. See Figure 58.

Figure 58: Fault Setup > BUC Fault menu
Tap the Action button to open the Action menu, or tap the Logic button to open the Logic menu.

Action Button

Tapping the Action button opens the Action menu, where the user can select how the amplifier responds to a BUC fault. See
Figure 59.

Figure 59: Fault Setup > BUC Fault > Action Menu

Tick the checkbox beside the desired Action mode for BUC faults.

e Major Fault - If Major Fault is selected, in the event of a BUC fault, the unit will exhibit a Summary fault, as well as
a BUC fault indicator.

e Major w. Mute - If Major w. Mute is selected, a BUC fault will trigger a Summary fault, as well as illuminate the BUC
fault indicator, and will mute the amplifier. This is the default setting for units which include an internal BUC.

¢ Disable - If Disable is selected, no action will be taken by the unit if a BUC fault occurs. This is the default setting
for units without an internal BUC.

Tapping the Logic button opens the Logic menu, where the user can select the parameters that will trigger a BUC fault. See
Figure 60.

Figure 60: Fault Setup > BUC Fault > Logic Menu

Tick the checkbox beside the desired Logic mode for BUC faults.

e Fault on High - Fault on High is the default setting for units which include an internal BUC, where faults are
triggered by a high impedance state.

e Fault on Low - If Fault on Low is selected, faults are triggered by a low impedance state.

¢ Disable - If Disable is selected, no action will be taken by the unit if a BUC fault occurs.

Aux Fault



Tapping the Aux Fault button opens the Aux Fault menu, from which the user can select the action and logic type that any
Auxiliary faults would trigger. See Figure 61.

Figure 61: Fault Setup > Aux Fault menu

Action Button

Tapping the Action button opens the Action menu, where the user can select how the amplifier responds to an Auxiliary fault.
See Figure 62.

Figure 62: Fault Setup > Aux Fault > Action Menu

Tick the checkbox beside the desired Action mode for Auxiliary faults.

¢ Major Fault - If Major Fault is selected, in the event of an Auxiliary fault, the unit will exhibit a Summary fault, and
the Aux fault indicator will turn red.

e Major w. Mute - If Major w. Mute is selected, an Auxiliary fault will trigger a Summary fault, and the Aux fault
indicator will turn red. The amplifier and will mute.

e Minor w. Mute - If Minor w. Mute is selected, an Auxiliary fault will cause the Aux fault indicator to turn red, and the
amplifier will mute.

e Minor Fault - If Minor Fault is selected, in the event of an Auxiliary fault, the Aux fault indicator will turn red, but no
Summary fault will be triggered.

Tapping the Logic button opens the Logic menu, where the user can select the parameters that will trigger an Auxiliary fault.
See Figure 63.

Figure 63: Fault Setup > Aux Fault > Logic Menu

Select from the items listed below:

e Fault on Low - If Fault on Low is selected, faults are triggered by a low impedance state.

e Fault on High - If Fault on High is selected, faults are triggered by a high impedance state.
e Start Low Z -

e Start High Z -

» Disable - If Disable is selected, the unit ignores the Auxiliary line condition.

Tick the checkbox beside the desired Logic mode for Aux faults.
Forward Pwr
Tapping the Forward Pwr button opens the Forward Pwr menu, from which the user can select the type of fault, the Forward

Power level being monitored, and the action to be assigned while monitoring the amplifier's forward RF power level. See
Figure 64.

Figure 64: Fault Setup > Forward Power Fault menu



Tap the Fault Type button to open the Fault Type menu; tap the Level button to open the Level Entry menu; or tap the Action
button to open the Action menu.

Tapping the Fault Type button opens the Fault Type menu, from which the user may select the type of fault that will be
triggered when a forward power fault condition exists. See Figure 65.
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Figure 65: Fault Setup > Forward Power Fault > Fault Type menu
Tick the checkbox beside the desired Fault Type.

e Major Flt. - A detected Forward Power fault will also set a SSPA Summary alarm;

e Major Online - This option can be used when the remote SSPA is configured in 1:1 or Dual 1:1 redundancy mode.
In these modes, a Forward Power fault will be triggered only if the SSPA unit is in the "Online" configuration and
outputting RF to the antenna feed. A fault will be ignored for the "Standby" unit. If the SSPA is in "Standalone”
mode, this option is the same as a "Major FIt";

¢ Major Flt+Mute - In this configuration, the Summary alarm will be triggered when a Forward Power fault is
detected. The SSPA also will be forced to a mute state. The Forward Power fault will be latched by the SSPA to
prevent mute function oscillation. If this condition is triggered by a Forward Power fault, the user will need to
disable the Forward Power fault in order to clear the fault and unmute SSPA;

e Minor Flt. - Forward RF fault function is isolated from the SSPA Summary alarm. Summary alarm will not be
affected by the current state of the Forward RF fault.

Tapping the Level button opens the Level Entry screen. Use the numbered keypad on the screen to enter the numbers for
the highlighted selection. Tap the "OK" button to set the selected value. See Figure 66.

Figure 66: Fault Setup > Forward Power Fault > Level Entry

The level entered is used as the trigger threshold for a Forward Power fault.

Action

Tapping the Action button opens the Action menu, from which the operator may select the parameter to be used to determine
whether the forward RF power should be considered in a fault condition. See Figure 67.
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Figure 67: Fault Setup > Forward Power Fault > Action menu
Tick the checkbox beside the desired Action.

o Low RF Fault - A Forward Power fault will be triggered if the detected RF level falls below the Level assigned.

¢ 10% Window - A Forward Power fault will be triggered if the detected RF level falls outside a value of £ 10% of the
Level assigned.

15% Window - A Forward Power fault will be triggered if the detected RF level falls outside a value of + 15% of the
Level assigned.

High RF Fault - A Forward Power fault will be triggered if the detected RF level rises above the Level assigned.
Disable - Disables the Forward Power fault.

Refl Power

Tapping the Refl Power button opens the Refl Power menu, from which the user can select the type of fault and the
Reflected Power level being monitored. See Figure 68.



Figure 68: Fault Setup > Refl Pwr Fault menu

Tap the Fault Type button to open the Fault Type menu; or tap the Level button to open the Level Entry menu.

Tapping the Fault Type button opens the Fault Type menu, from which the user can select the type of fault a Reflected Power
fault condition will trigger. See Figure 69.

Figure 69: Fault Setup > Refl Pwr > Fault Type menu

Tick the checkbox beside the desired fault type.

e Minor Flt - The Reflected Power fault function is isolated from the Summary alarm. The Summary alarm will not be
affected by the current state of the Reflected Power fault;

e Major Flt - A detected Reflected Power fault will also set a Summary alarm;

¢ Disable - isables the Reflected Power fault.

Tapping the Level button opens the Level Entry screen. Use the numbered keypad on the screen to enter the numbers for
the highlighted selection. Tap the "OK" button to set the selected value. See Figure 70.

Figure 70: Fault Setup > Refl Pwr > Level Entry

The level entered is used as the trigger threshold for a Reflected Power fault.

Fault Latch

Tapping the Fault Latch button opens the Fault Latch menu. See Figure 71.

Figure 71: Fault Setup > Fault Latch menu

Tick the checkbox beside the desired function. If fault latching is enabled, the unit will retain a detected fault condition until
the operator executes a "Clear Fault" command. See the Clear Fault description.

High Temp

Tapping the High Temp button opens the High Temp menu. See Figure 72.

Figure 72: Fault Setup > High Temperature Fault menu



The operator may enter a value that corresponds with the baseplate temperature of the remote SSPA unit. If the baseplate
temperature of the remote SSPA unit meets or exceeds the entered value, a Temperature fault will be triggered.

iy Warning! Consult the factory before changing this value. Setting the value too low may cause
unintentional fault conditions.

Redundancy Menu

Figure 73 shows the Redundancy menu.

Figure 73: Redundancy Menu

The Redundancy menu includes the following buttons:
« System Mode
« Switch Mute

Standby Mode

HPA Status

Standby Select

System Mode

Tapping the System Mode button opens the System Mode menu. See Figure 74.

Figure 74: Redundancy > System Mode Menu

The operator may select from the following items:

¢ 1:1 Mode - Select this mode if the connected amplifier is part of a redundant system configured for 1:1 mode.
Consult the factory for more information.

e Dual 1:1 Mode - Select this mode if the connected amplifier is part of a redundant system configured for dual 1:1
mode. Consult the factory for more information.

e Standalone - This is the default mode for the RCP2-1000-CO controller. This item should be selected if
communicating with a single amplifier that is not part of redundant system.

Tick the checkbox beside the desired mode.

Switch Mute

Tapping the Switch Mute button opens the Switch Mute menu. See Figure 75.

Figure 75: Redundancy > Switch Mute Menu

The operator may select from the following items:



e On - Select this option if the amplifier is part of a system that includes a transfer switch. The Switch Mute function
helps to prevent arcing within the waveguide in high power amplifier systems by temporarily muting the amplifier
any time the switch position changes.

o Off - Select this option if the amplifier is in Standalone mode.

& Note: If an amplifier is in Standalone mode and the Switch Mute function is turned on, the amplifier will
always show an internal mute alarm and will be muted.

Tick the checkbox beside the desired setting.

Standby Mode

Tapping the Standby Mode button opens the Standby Mode menu. See Figure 76.
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Figure 76: Redundancy > Standby Mode Menu
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The operator may select from the following items:
¢ Cold Standby - In Cold Standby mode, the connected amplifier mutes when it enters Standby mode and unmutes
when it it switched to Online mode.
¢ Hot Standby - In Hot Standby mode the connected amplifier retains an unmuted state during any standby period.

Tick the checkbox beside the desired setting.

HPA Status

Tapping the HPA Status button opens the HPA Status menu. HPA Status is used when there are two amplifiers configured in
a 1:1 redundant system. If the connected amplifier is in Standalone mode, this setting selection has no bearing on the
operation of the amplifier. See Figure 77.

Figure 77: Redundancy > HPA Status Menu

The operator may select from the following items:

e HPA1 - Sets the amplifier status to "HPA1".
e HPA2 - Sets the amplifier status to "HPA2".

Tick the checkbox beside the desired setting.

Standby Select

Tapping the Standby Select button opens the Standby Select menu. Standby Select is used when there are two or more
amplifiers configured in a redundant syste. If the connected amplifier is in Standalone mode, this setting selection has no
bearing on the operation of the amplifier. See Figure 78.

Figure 78: Redundancy > Standby Select Menu

The operator may select from the following items:



¢ Standby - In redundant systems, the Standby amplifier does not transmit to the antenna feed until one of the
Online amplifiers in the system gives away its online status.

¢ Online - In redundant systems, the Online amplifier is transmitting to the antenna feed. Should a fault condition
cause the Online amplifier to mute or otherwise go offline, a properly configured amplifier will automatically give
away its online state to the standby amplifier.

Tick the checkbox beside the desired setting.

Options Menu

Figure 79 shows the Options menu.

Figure 79: Options Menu

The Options menu allows the user to select the System backup and restore utilities, Front Panel configuration options, Menu
Lock options, and Trends configurations.

» System
* Front Panel
¢ Menu Lock

» Config Trends

System Menu

Tapping the System button opens the System menu, from which the user can choose to backup settings, restore settings
from a saved backup, reset the unit, or select the memory mode used by the unit's EEPROM. See Figure 80.

Figure 80: Options > System Menu

Tapping the Backup button opens the Backup menu, which allows the user to backup all settings to nonvolatile memory.
There are two repositories for saved settings, User 1 and User 2. See Figure 81.

Figure 81: Options > System > Backup Menu

A confirmation window will appear after a button is selected and tapped. Tap the OK button to confirm, or the Cancel button
to cancel the action. See Figure 82.

Figure 82: Options > System > Backup Confirmation

Restore Menu



Tapping the Restore button opens the Restore menu, which allows the user to restore settings from nonvolatile memory.
There are three repositories for saved settings, User 1, User 2, and Factory. Selecting Factory restores all factory default
settings. See Figure 83.

Figure 83: Options > System > Restore Menu

A confirmation window will appear after a button is selected and tapped. Tap the OK button to confirm, or the Cancel button
to cancel the action. See Figure 84.
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Figure 84: Options > System > Restore Confirmation

Reset Menu

Tapping the Reset button opens the Reset menu, which allows the user to reset the SSPA controller hardware to activate
certain settings. For example, when the IP Address is modified the SSPA must be reset for it to use the new IP Address. See
Figure 85.

Figure 85: Options > System > Reset Menu

10 Card -- Resets all hardware on the removable M&C card as well as the embedded cards on all RF modules. The amplifier
will be muted during the reset process, therefore the reset will cause a momentary loss of RF output. All communication links
to remote M&C will be dropped until reset process is complete. The amplifier will use the currently selected communication
parameters (IP address, baud rate, etc);

Module -- Resets only the embedded chips in all RF modules. The 1/O card remains operational and maintains a
communication link to remote M&C. The RF module will be muted during the reset process. This function is useful for
clearing latched fault conditions in SSPA units under N+1 system control;

Comms Only -- Resets only communication parameters. If unmuted, the SSPA maintains an unchanged RF output level
during reset. Remote COM links will be dropped and re-enabled with selected parameters;

Clear Faults -- Clears all latched faults and remaining fault history information. SSPA remains fully operational during the
process;

IP Comms -- Resets only IP communication parameters. If unmuted, the SSPA maintains an unchanged RF output level
during reset. Remote COM links will be dropped and re-enabled with selected IP parameters.

When the user selects and taps one of the buttons described above, a confirmation window will appear. See Figure 86. Tap
the OK button to continue the reset function, or the Cancel button to cancel the function.

Figure 86: Options > System > Reset Confirmation

In the case of the Clear Faults button, a different confirmation window will appear. See Figure 87. Tap the OK button to
continue the reset function, or the Cancel button to cancel the function.



Figure 87: Options > System > Clear Faults Confirmation

Memory Mode Menu

Tapping the Memory Mode button opens the Memory Mode menu, from which the user can select options for how the unit
retains settings in memory. See Figure 88.

Figure 88: Options > System > Memory Mode Menu

RAM -- In this mode, the unit will not backup any settings changes to internal EEPROM. This mode is optional and needs to
be set by the user every time the unit endures a power cycle or I/O card reset. This mode is beneficial when the SSPA
application requires frequent changes to the SSPA state (such as mute/unmute or attenuation changes). Since any
EEPROM device has limited write cycles, RAM mode allows the user to execute unlimited settings changes. If the SSPA
experiences a power or reset cycle in RAM mode, it will use the last saved settings setup before RAM was engaged;

EEPROM -- Default mode. Without user intervention, the unit will retain this mode of operation. All changes to settings setup
performed over local or remote interface will be backed up to EEPROM within a 3 second time interval. If the unit
experiences a power cycle or reset, the last saved set of settings will be applied to the unit upon each power up or I/O card
reset. Any EEPROM device has a limited ability to endure write cycles. Maximum write cycles ability for units with firmware
version prior to 6.00 is 150,000. After exceeding this limit, the unit will operate in RAM mode, utilizing a default set of settings
on each power up. Firmware versions above 6.00 allow a minimum of 3,000,000 write cycles before opting out to RAM
mode.

After selecting one of the choices above, a confirmation window will appear. See Figure 89. Tap the OK button to continue
the memory mode selection, or the Cancel button to cancel the selection.

Figure 89: Options > System > Memory Mode Confirmation

Front Panel Menu

Tapping the Front Panel button opens the Front Panel menu, from which the user can select options for the touchscreen, and
configure the customizable fault display, action buttons, and status display, or reset the screen. See Figure 90.

Figure 90: Options > Front Panel Menu

Tapping the Confirm Prompt button opens the Confirm Prompt menu, from which the user can enable or disable the
confirmation prompts that are generated when certain actions (such as changing Mute Status or initiating a Backup/Restore)
are triggered. The current selection is checked. See Figure 91.

Figure 91: Options > Front Panel > Confirm Prompt Menu



Show Refl. Pwr

& Note: If the amplifier or system does not include a Reflected Power Monitor, the Show Refl Pwr button is
disabled and the following menu is inaccessible.

Tapping the Show Refl. Pwr button opens the Show Refl. Pwr menu, from which the user can enable or disable the display of
the Reflected Power measurement in the RF Signal Path Display. See Figure 92.

Figure 92: Options > Front Panel > Show Reflected Power Menu

Selection Timeout

Tapping the Selection Timeout button opens the Selection Timeout menu, from which the user can select the time interval
that must pass (10 Seconds or 30 Seconds) before most menu screens revert to the previous menu screen if a selection is
not made, or disable all confirmation screens. Default setting is 10 Seconds. See Figure 93.
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Figure 93: Options > Front Panel > Selection Timeout Menu

Tapping the Config Faults button opens the Config Faults menu, from which the user can select the fault indicators that are
shown in the Fault Indicator section at the far left of the touchscreen display. The Summary selection is always selected by
default. Other default settings include Power Supply, Temperature, DC Voltage and DC Current. See Figure 94.

Figure 94: Options > Front Panel > Config Faults Menu

The user may select up to four other options besides the Summary selection to be displayed. Tap the OK button to display
the selected settings. Tap the Cancel button to return to the previous menu. Tap the Default button to return to the default
settings.

Config Buttons

Tapping the Config Buttons button opens the Config Buttons menu, from which the user can select the Action Buttons that
appear on the far right of the touchscreen display. Up to two items may be selected. Control Mode and Switch Mode are
selected by default. See Figure 95.

Figure 95: Options > Front Panel > Config Buttons Menu

The first item selected will appear as the top Action Button. The second item selected will appear as the bottom Action
Button. Tap the Cancel button to return to the previous menu. Tap the Default button to return to the default settings.

/& Note: When the unit is set to Remote Only mode, the Control Mode button will appear in the top position
of the Action Buttons area, whether or not it was selected by the user. See Figure 96.
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Figure 96: Remote Only Mode
Config Status

Tapping the Config Status button opens the Config Status menu, from which the user can select the items that appear in the
Custom Status menu (Status > Custom Status). Up to eight items may be selected between two screens of parameters that
may be monitored. See Figure 97 and Figure 98.

Figure 97: Options > Front Panel > Config Status Menu Page 1

Tap the More button to get to page 2.

Figure 98: Options > Front Panel > Config Status Menu Page 2

Tap the Back button to return to page 1. Tap the Clear button to remove the checks from all items in both page 1 and page 2.
Tap the Cancel button to return to the previous menu. Tap the OK button to accept the selected parameters.

Screen Reset

Tapping the Screen Reset button results in a confirmation window. See Figure 99. Tap the OK button to continue the reset
function, or the Cancel button to cancel the function.

Figure 99: Options > Front Panel > Reset Screen Confirmation
The Screen Reset function reboots the touchscreen's microcontroller card and resets all trendlines.
Menu Lock Button

Tapping the Menu Lock button opens the Menu Lock menu, from which the user can set the parameters for locking the
touchscreen menu. See Figure 100.

Figure 100: Options > Menu Lock Menu

Tapping the Password Enable button opens the Password Enable menu, from which the user enable or disable password
protection for the touchscreen menu. The current selection is checked. See Figure 101.

Figure 101: Options > Menu Lock > Password Enable Menu

When this function is enabled, the resulting screen returns to the Main Menu, which will show a red "locked" icon over all
buttons that require a password to access. Only the Status and Info menus are not locked. See Figure 102.



Figure 102: Main Menu With Menu Lock Enabled

If the user selects one of the locked buttons, a password entry screen will appear. See Figure 103. By default, the password
is 170.

Figure 103: Enter Password to Unlock Menu

If the correct password is entered, the "locked" icons will disappear, and the user can access all buttons normally, until the
Lock Timer refreshes (based on its setting).

User Password

Tapping the User Password button opens the User Password menu, from which the user set the password for the
touchscreen menu. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap the "OK"
button to set the selected value. The default value is 170. See Figure 104.

Figure 104: Options > Menu Lock > User Password Selection

Tapping the Lock Timer button opens the Lock Timer menu, from which the user select how often the screen will be
password protected. The current selection is checked. See Figure 105.
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Figure 105: Options > Menu Lock > Lock Timer Menu

If One Time is selected, after the user unlocks the screen for the first time since the menu lock was enabled, the menu lock
function will be disabled. Otherwise, the menu lock function will re-establish the touchscreen menu lockdown after the
selected time interval passes.

Info Menu

Figure 106 shows the Info menu.

Figure 106: Info Menu

The Info menu includes the following buttons:
» System Info

* SSPA Info

* Time

¢ Runtime



« Front Panel

System Info

Tapping the System Info button opens the System Info menu. This screen shows the System ID (serial number) and System
FW (firmware) values. These values are in reference to the RCP unit. See Figure 107.

Figure 107: Info > System Info Menu

Tapping the System ID or System FW buttons will open windows that show the same information shown on the button.

SSPA Info

Tapping the SSPA Info button opens the SSPA Info menu. This screen shows the SSPA ID (model number) and SSPA FW
(firmware) values. These values are in reference to the connected amplifier. See Figure 108.

Figure 108: Info > SSPA Info Menu

Tapping the SSPA ID or SSPA FW buttons will open windows that show the same information shown on the button.
Time

This item is currently not available in RCP2-1000-CO units.

Runtime

Pressing the Runtime button opens the Runtime display, which shows the length of time since the last power-up. This is a
read-only screen. See Figure 109.
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Figure 109: Info > Runtime Menu

Front Panel

Pressing the Front Panel button opens the Front Panel menu, from which the user can review the touchscreen unit's
microcontroller (MCU) version, graphic user interface (GUI) type, and serial number. See Figure 110.

Figure 110: Info > Front Panel Menu

Pressing any of the buttons on this screen results in a more detailed read-only description. These information screens are
not subject to the screen time-out, and will remain open until the user selects the back or home icons. The information
contained within these menus are critical when calling technical support.
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Introduction

The RCP2-1000-CO unit should be installed in an equipment rack in a sheltered environment as close as possible to the
antenna feed.

This set-up procedure requires the following equipment:

¢ Teledyne Paradise Datacom RCP2-1000-CO unit;

e Teledyne Paradise Datacom Compact Outdoor SSPA;

¢ Quick-Start Cable (p/n L207755-2);

e RS-232 Communication Cable (p/n XXXXXX; max. length 50 ft.);

o Power cable for Compact Outdoor SSPA,;

e Line cords for RCP2-1000-CO unit;

e A PC running Teledyne Paradise Datacom's Universal M&C software.

The Universal M&C software may be downloaded from the Teledyne Paradise Datacom web site.



Amplifier Set-up

Perform the following procedure to set up the Compact Outdoor SSPA.

OCONOOAPRWN-=-

/¥ WARNING! Ensure the RF/L-Band input and RF output ports are properly terminated before powering up
the amplifier. RF hazards apply.

. Connect the Quick-Start Cable between the PC and the amplifier;

. Provide power to the amplifier;

. On the PC, open the Universal M&C software;

. Select the Action pull-down menu > Add Unit > Compact Outdoor SSPA,;
. Select Internet Connection;

. In the IP Address field, enter "192.168.0.9" (see Figure 1);

. In the Port field, enter "1007" (see Figure 1);

. In the Amplifier Address field, enter "1" (see Figure 1);

. Press the Search for Unit button;

. M&C should find the amplifier; Click the "OK" button;

. Press the Create button;

. Verify the unit is communicating with the M&C software;

. Go to the Settings tab;

. Verify the following settings: Protocol Select = Binary Mode, Baud Rate Select = 9600, Amplifier Address = 1 (see
Figure 2);

. Remove the Quick-Start Cable from the amplifier;

. Connect the serial cable between port J5 (Serial Local) of the RCP and port J4 (M&C) of the amplifier;

. On the RCP, tap the Operation > Amp Address buttons;

. Enter 1 for the Amp Address and tap the OK button (see Figure 3);

. Cycle the power to the amplifier to enable the changes.

[3 Add Compact Qutdoor SSPA - 0 e

ottt |

" Serial Connection + Internet Connection - SNMP

IP Address

192,168.0.9

Port
1007E|:

Amplifieraddress

1E|:
Search for Unit

™ UsePassThrough

Host Address| 13

Log File Location (REQUIRED) Browse...

Y

Searching while connected to multiple units is not recommended.

Create Cancel

Figure 1: Universal M&C Settings Tab
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Figure 2: Universal M&C Settings Tab

Figure 3: Touchscreen > Operation > Amp Address menu

Connecting to Port J4 of Amplifier

The Teledyne Paradise Datacom outdoor amplifier is available with a standard RS-232/RS-485 serial communications
interface or an optional Ethernet & RS-232/RS-485 interface. Review the Remote Communication Connection section of
the Outdoor SSPA manual.

It is important to note that RS-232 cable lengths are limited to approximately 50 feet (15 meters) or to a capacitance of 2500
pF. RS-485 cable runs are limited to approximately 4000 feet (1219 meters). Ethernet cable lengths are limited to 328 feet
(100 meters) without including a router or other active component.




Controlling the SSPA via RCP2-1000-CO

The operator may now use the RCP2-1000-CO controller to control the mute state and gain level of the connected amplifier,
and monitor the amplifier's operating status.

Mute/Unmute Amplifier

Perform the following sequence on the RCP touchscreen to change the mute state of the amplifier:

1. If not on the Main Menu, tap the Home icon;

2. Tap the Operation button;

3. Tap the Mute button;

4. Tick the desired mute state (Mute On or Mute Off). See Figure 4.

Figure 4: Change Amplifier Mute State

Alternately, tap the Mute (TX) Action Button at the far right of the touchscreen. If confirmation prompts are turned on, a dialog
window will appear asking to verify the state change. Tap the "OK" button to proceed or the "Cancel" button to cancel. See
Figure 5.

Confirmation X
Are you sure you want to set:

t 0K , Mute State = Mute tCanceI

Figure 5: Confirm Mute State Change

Change Attenuation Setting

Perform the following sequence on the RCP touchscreen to change the attenuation setting:

1. If not on the Main Menu, tap the Home icon;

2. Tap the Operation button;

3. Tap the Attenuation button;

4. Use the numeric keypad to enter the desired attenuation value;

5. Tap the "OK" button to proceed or the "Cancel" button to cancel. See Figure 6.

® Attenuation:

Figure 6: Adjust Attenuation Setting (Operation > Attenuation)

Alternately, tap the Atten. Action Button at the far right of the touchscreen. This will open the Attenuation setting screen. Tap
the up or down arrow keys to adjust the attenuation setting to the desired level. Changes are applied immediately. Tap the
"OK" button to save the setting and return to the previous screen. See Figure 7.

Attenuation ~ | { A
%' # [ oKk | Attenuation settings are applied
dB . = — immediately.

(Vv

Figure 7: Adjust Attenuation Setting (Atten. Action Button)

Monitor Fault Status

The Fault Panel displays the fault status for various parameters monitored by the unit's controller. Perform the following
sequence on the RCP touchscreen to view the fault panel:



1. If not on the Main Menu, tap the Home icon;
2. Tap the Status button;
3. Tap the Fault Panel button. See Figure 8.

Figure 8: Monitor Fault Status

A green icon next to the unit condition title indicates a non-faulted state. A red icon next to the unit condition title indicates a
faulted state. A yellow icon indicates a communication error. A black icon designates a condition not applicable to the unit.

Monitor RF Output

The RF Output power of the connected amplifier is shown on the RF Signal Path display. See Figure 9.

T

o

= g & 3
. 9

Figure 9: RF Signal Path Display

The operator may also monitor this value in the Menu area of the touchscreen display. Perform the following sequence on
the RCP touchscreen to view the RF/Temp Menu:

1. If not on the Main Menu, tap the Home icon;

2. Tap the Status button;

3. Tap the RF/Temp button;

4. The Forward RF value is displayed at the top left of the screen. See Figure 10.

5. If the SSPA is configured with a reflected power monitor, and this feature is enabled on the RCP unit, the reflected
RF value is displayed at the bottom left of the screen. Otherwise, this value is displayed as "N/A".

Figure 10: Status > RF/Temp Menu
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Overview

A system which includes a system controller can be managed from a remote computer over a variety of remote control
interfaces (see Figure 1).

Remote control interface stack

10Base-T IP Interface

SNMP

HTTP Web

UDP

I Serial Interface I I

RS485

Protocols:
1. Normal

2. Terminal RS232

| Alarm Contact I I

———

%s )
33

Figure 1: Remote Control Interface Stack
The parallel port on the unit provides a simple form of remote control. There are 10 Form C relay contacts for remote
monitoring. There are six opto-isolated inputs for remote control commands. To enable the remote parallel interface, select
Remote on the front panel Local/Remote key. When in Remote mode, all front panel commands are disabled with the
exception of the Local/Remote key. See the Remote Control - Parallel section.
The serial interface supports both RS-232 and RS-485 standards. The control protocol supports two formats:
* Normal serial protocol, as detailed in the Serial Communication section;
» ASCIlI-based protocol, suitable for HyperTerminal applications (see the Terminal Mode Serial Protocol section).

Serial interface is equipped with overvoltage and overcurrent protection and benefits from full galvanic isolation from the
chassis ground for extra protection.

The Ethernet interface supports multiple communication standards which can be used exclusively or simultaneously
depending on the selected setting:

* |IPNet - UDP encapsulated Normal serial protocol;

* SNMP V1 with support of SNMP traps;

* HTTP web interface

Serial protocol format is set at no parity, 8 bit with 1 stop bit. Baud rate is selectable through the front panel.

If using a Terminal mode protocol, the controller provides remote menu access through a HyperTerminal program or through
an actual hardware terminal.

RS485 interface pin out is compatible with most 9-pin RS485 adapters. Interface always works in half-duplex mode and is
suitable for either 4- or 2-wire RS485 configuration. Maximum achievable node length for this interface is 1500 feet. Proper
termination and use of shielded twisted pair cable is required to achieve long cable runs

Ethernet interface is auto selectable between 10 and 100 MBits/s speeds. Maximum node length is 100 feet. Use of CAT5E
or CAT6 cables are preferred. CAT5 cable can be used for 10Base-T standard or short runs of 100Base-T.

Digicor5 digital platform controller allows simulations support of multiple remote control interfaces.
Table 1 shows a list of enabled interfaces depending on chosen interfaces setting.
Table 1: Interfaces Enabled Based on Chosen Interface Setting Selection

Interface Selection Supported Serial Interface Supported IP Interfaces
RS232 RS232 IPNet, Web M&C (read/write), SNMP (read/write)

RS485 RS485 IPNet, Web M&C (read/write), SNMP (read/write)
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IPNET RS485 IPNet, Web M&C (read/write), SNMP (read only)

SNMP RS485 Web M&C (read only), SNMP (read/write)

Serial protocol is an independent selection and allows support of Normal or Terminal mode protocols. Operation over IP
interface remains unchanged regardless of serial protocol selection.

Digicor5 digital platform controller allows simulations support of multiple remote control interfaces.

Serial protocol is an independent selection and allows support of Normal or Terminal mode protocols. Operation over IP
interface remains unchanged regardless of serial protocol selection.



Remote Control - Parallel

Control Outputs

The hardware behind the form C relay is a single pole, double throw relay. Under normal operation (no alarms) the relays are
in an energized state. When a fault occurs or the controller is powered off, the relays are in a de-energized state. The relay
contacts are capable of handling a maximum of 30 VDC @ 1A . The form C relay is shown schematically in Figure 2. The
form C relay contact outputs are listed in Table 2.

Closed on Fault Closed on Fault
i‘/ C (g/ C
- C | s
Common — C Common —C C
Open on Fault T Open on Fault ‘ W
Y
Relay Energized Relay de-Energized

Figure 2: Parallel /O Form C Relay

Control Inputs

The parallel control inputs are opto-isolated inputs with pull up resistors. To trigger a remote input command, the input should
be pulled to ground. The input does not need to be held to ground continuously but it is acceptable to do so. The input only
need be pulled low for a minimum of 20 msec. For example, to make amplifier #2 the standby amplifier, pulse pin 36 to
ground for 20 msec. If the operator then chooses to make amplifier #1 the standby ampilifier, simply pulse pin 37 to ground
for 20 msec. The schematic representation of the control input is shown in Figure 3.
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Figure 3: Opto-isolated Parallel /0O Input

The external alarm and auxiliary alarm inputs use the same opto-isolated input circuitry shown in Figure 3.
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Serial Communication

This section describes the normal communication protocol between the controller and a host computer over RS232/RS485
serial interface. Serial port settings on host computer must be configured for 8-bit data at no parity, with 1 stop bit. Baud rate
should match selected baud rate parameter on unit.

The unit will only respond to properly formatted protocol packets. Figure 4 shows the basic communication packet. It consists
of a Header, Data, and Trailer sub-packet.

HEADER DATA TRAILER
(4 bytes) (6-32 bytes) (1 byte)

Figure 4: Basic Serial Communication Packet

Header Packet

The Header packet is divided into three sub-packets which are the Frame Sync, Destination Address, and Source Address
packets, as shown in Figure 5.

HEADER DATA TRAILER
(4 bytes) (6-32 bytes) (1 byte)
Frame Sync (2 bytes) Destination Address Source Address
O0xAA55 (1 byte) (1 byte)

Figure 5: Header Sub-Packet

Frame Sync Word

The Frame Sync word is a two byte field that marks the beginning of a packet. This value is always 0xAA55. This field
provides a means of designating a specific packet from others that may exist on the same network. It also provides a
mechanism for a node to synchronize to a known point of transmission.

The destination address field specifies the node for which the packet is intended. It may be an individual or broadcast
address. The broadcast address is OxFF or OxAA. This is used when a packet of information is intended for several nodes on

the network. The broadcast address can be used in a single device connection when the host needs to determine the
address of the amplifier. The unit will reply with its unique address.

Source Address

The source address specifies the address of the node that is sending the packet. All unique addresses, except the broadcast
address, are equal and can be assigned to individual units. The host computer must also have a unique network address.

Data Packet

The data sub-packet is comprised of six to 32 bytes of information. It is further divided into seven fields as shown in Figure 6.
The first six fields comprise the command preamble while the last field is the actual data.

HEADER DATA TRAILER
(4 bytes) (6-32 bytes) (1 byte)
COMMAND PREAMBLE DATAFIELD
Command
Protocol ID | RequestID Command Data Tag grargfdtac!‘t::sé Data Length Data Sub
1 Byte 1 Byte 1 Byte 1 Byte 1B 1 Byte Structure
yte 0- 26 Bytes

Figure 6: Data Sub-Packet
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Protocol ID

This field provides backward compatibility with older generation equipment protocol. It should normally be set to zero. This
field allows the unit to auto-detect other protocol versions, which may exist in the future.

Request ID

This is an application specific field. The amplifier will echo this byte back in the response frame without change. This byte
serves as a request tracking feature.

Command

The RCP2 protocol is a table based protocol. It allows the user to view and modify data tables located on the controlled
device. Throughout the remainder of this description, "sender" will refer to the host PC, and "receiver" will refer to the unit.

Sender and receiver are limited to two commands and two command responses. The Get Request command issued by a
command sender allows monitoring of existing conditions and parameters on the receiver. The Get Request frame should
not have any bytes in the Data Field and be no longer than 11 bytes.

The Response frame from the receiver will contain a Get Response designator in the Command field. If the receiver does not
detect any errors in the Get Request frame, the requested data will be attached to the response frame. The length of the Get
Response frame varies by the amount of attached data bytes. It may contain 11+N bytes where N is the amount of requested
data bytes from a particular table, specified in the Data Length field.

The Set Request command allows the sender to actively change parameters for the receiver's internal configuration. The Set
Request frame must contain a number of bytes in the Data Field as specified in the Data length field. The frame size must be
11+N bytes, where N is the length of the attached data structure. The receiver will respond with a frame where the command
field will be set to a Set Response designator. The frame length is equal to the Request frame.
The byte value for each command is given in Table 2.

Table 2: Command Byte Values

Command Name Command Byte Value

Set Request

Get Request

Set Response

W IN| =~ | O

Get Response

Data Tag

The controller internal structure is organized in several tables, all of which share similar functionality and internal resources.
To access the various tables, the data tag must be specified in the request frame. The data associated with certain tags is
read only. Therefore only the "Get" command request would be allowed to access these data tags. The controller will return
an error on attempts to issue a "Set" request to a read-only table tag. Various tables may contain values formatted either in 1
or 2 bytes format. The data tag byte values are given in Table 3.

Table 3: Data Tag Byte Values

Min. Valid

Length of Description
Data Field

Svstems This tag allows accessing various system settings on remote unit. Host
s et% nas Ta 0 1 Byte access status: Full Read/Write access. Settings can be modified at any
9 9 time. Some of the settings may require hardware reset of the remote unit.

System 1 2 Bvtes This tag allows access to the critical unit thresholds. Host access status:
Thresholds Tag y Tag have read only status.
System This tag allows access to the unit's internal conditions flags, such as fault
Con d?ltions Ta 3 1 Byte status or current system status. Host access status: Read only. This type of
9 the data can not be set or modified remotely.
ADC Channels '
Access Tag 4 2 Bytes ADC legacy access. Don't use for new development
Reserved 6 N/A This tag is reserved.
Reserved 2 N/A This tag is reserved.

Reserved 5 N/A This tag is reserved for factory use only.




Special
Command Tag 10 N/A This tag is reserved for factory use only.
(v.6.00)

Data Address / Error Status / Local Port Frame Length

This field is a tag extension byte and specifies the first table element of the tagged data. If the Data Length is more than 1
byte, then all subsequent data fields must be accessed starting from the specified address. For example, if the requestor
wants to access the amplifier's unique network address, it should set data tag 0 (System settings tag) and data address 8
(see Table 7, System Settings Details table). If the following Data Length field is more than 1, then all subsequent Settings
will be accessed after the Unique Network Address.

& Important! In any response frame, the Data Address field is replaced with the Error Status information.
The various error codes are given in Table 4.

Table 4: Error Status Byte Values

Error Code Name \21)::12 Possible Cause
No Errors 0 Normal Condition, no errors detected
Data Frame Too Big 1 Specified Data length is to big for respondent buffer to accept
No Such Data 2 Specified Data Address is out off bounds for this tag data
Bad Value 3 Specified value not suitable for this particular data type
Read Only 4 Originator tried to set a value which has read only status
Bad Checksum 5 Trailer checksum not matched to calculated checksum
Unrecognizable 6 Error presented in originator frame, but respondent failed to recognize it. All data
Error aborted.

Data Length

This byte value specifies the number of bytes attached in the Data Field. For the Get command, it specifies the number of
data bytes that has to be returned by the unit to a host PC in the Response frame. For the Set command, the value of this
byte specifies the number of data fields to be accessed starting from the address specified in the Data Address byte. In
general, Data Length value plus Data Address must not exceed the maximum data size particular tag.

Data Field

The actual data contained in the packet must be placed in this field. The "Get Request" type of command must not contain
any Data Field. "Get Request" will be rejected if any data is present in the Data Field. Generally, the Bad Checksum error
code will be added to the response from the unit. In case the data length is 2 bytes, each data word is placed in the frame
with its least significant byte first. All data with length of 2 bytes must be represented as integer type with maximum value
range from 32767 to (-32767).

Trailer Packet

The trailer component contains only one byte called the Frame Check Sequence. This field provides a checksum during
packet transmission. See Figure 7.

HEADER DATA TRAILER
(4 bytes) (6-32 bytes) (1 byte)

T

Frame Check
Checksum (1 byte)

Figure 7: Trailer Sub-Packet

Frame Check Sequence
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This value is computed as a function of the content of the destination address, source address and all Command Data
Substructure bytes. In general, the sender formats a message frame, calculates the check sequence, appends it to the
frame, then transmits the packet. Upon receipt, the destination node recalculates the check sequence and compares it to the
check sequence embedded in the frame. If the check sequences are the same, the data was transmitted without error.
Otherwise an error has occurred and some form of recovery should take place. In this case the amplifier will return a packet
with the "Bad Checksum" error code set. Checksums are generated by summing the value of each byte in the packet while
ignoring any carry bits. A simple algorithm is given as:

Chksum=0
FOR byte_index=0 TO byte_index=packet_len-1
Chksum=(chksum+BYTE[byte_index]) MOD 256
NEXT byte_index

Timing Issues

There is no maximum specification on the inter-character spacing in messages. Bytes in messages to amplifier units may be
spaced as far apart as you wish. The amplifier will respond as soon as it has collected enough bytes to determine the
message. Generally, there will be no spacing between characters in replies generated by units. The maximum length of the
packet sent to the amplifier node should not exceed 64 bytes, including checksum and frame sync bytes. Inter-message
spacing, must be provided for good data transmission. The minimum spacing should be 100 ms. This time is required for the
controller to detect a "Line Cleared" condition with half duplex communications. Maximum controller respond time is 200 ms.



Serial Communications Protocol

Table 5 through Table 9 detail the values of the serial communications protocol.

Table 5: Request Frame Structure

Byte Tag Description
1 OxAA Frame Sync 1
2 0x55 Frame Sync 2
Destination
3 Address M-
4 Source Address -/l -
5 Protocol Version Protocol Compatibility Byte, must be set 0
6 Request ID Service Byte
7 Command 0 = Set Request; 1 = Get Request
0 = System Settings; 1 = System Thresholds; 2 = Reserved; 3 = Conditions; 4 = ADC Data; 5
8 Data Tag = Reserved
9 Data Address Setting number, Sensor command, EEPROM address
10 Data Length Total length of the data, valid values: 1 - 10
11+N Data Actual Data
Destination Address + Source Address + Protocol Version + Request ID + Command + Data
AR S Tag + Data Address + Data Length + Data
Table 6: Response Frame Structure
Byte Tag Description
1 OxAA Frame Sync 1
2 0x55 Frame Sync 2
Destination
3 Address -
4 Source Address -/l -
5 Protocol Version Protocol Compatibility Byte, must be set 0
6 Request ID Service Byte
7 Command 2 = Set Response; 3 = Get Response
0 = System Settings; 1 = System Thresholds; 2 = Reserved; 3 = Conditions; 4 = ADC Data; 5
8 Data Tag = Reserved
0 = No Errors, 1 = Too Big, 2 = No Such Data, 3 = Bad Value, 4 = Read Only, 5 = Bad
° Error Status Checksum; 6 = Unrecognized Error
10 Data Length Total length of the data, valid values: 1 - 10
114N Data Actual Data
Destination Address + Source Address + Protocol Version + Request ID + Command + Data
AR Ehiackai Tag + Data Address + Data Length + Data
Table 7: System Settings Data Values
Data #

Address Bytes

Description Limits and Byte Values
0 =1:2 Controller; 1 = 1:1 Controller; 2 = 1:1 Phase
combine; 3 = Dual 1:1 Controller; 4 = Maintenance Mode; 5
= 1:2 Phase combine (v. 6.00)

System Configuration

Switching Mode 0 = Auto Mode; 1 = Manual Mode; 2 = Lock Mode (v. 6.00)

Control Mode 0 = Local; 1 = Remote

Reserved N/A




5 Priority Select 0 = Pol1; 1 = Pol2
6 Communication Protocol * 0 = Normal; 1 = Terminal (v. 4.00)
7 Baud Rate * 0 =9600; 1 =2400; 2 = 4800; 3 = 19200; 4 = 38400
8 Unique network address Valid values: 0 - 255
9 Type of Serial Interface * 0 = RS232; 1 = RS485; 2 = IPnet; 3 = SNMP (v. 4.00)
10 Type of Fault Monitoring b= @y = I%l\;ﬁlt(;n(l\)//.; g-gOI)Both; &= el Gt
0 = Enable non-switching faults; 1 = Ignore; 2 = Enable non-
11 Auxiliary Fault Monitoring switching faults, inverted logic; 3 = Enable switching faults
(v. 6.00); 4 = Enable switching faults, inverted logic (v. 6.00)
12 RF Switch Monitoring 0 = Major Fault; 1 = Alert Only; 2 = Alternate (v. 3.30)
13 Fault Latching 0 = Latch Enable; 1 = Latch Disable
14 Fault Window 0=20%; 1=8%;2=12%, 3=15%
15 Fault Logic 0 = Fault on Low; 1 = Fault on High
16 User Password Valid Values=0 to 255
0 = Amplifier 2 on Standby (default); 1 = Amplifier 1 on
17 Amplifier Standby Configuration Standby; 2 = Amplifier 2 on Standby; 3 = Amplifier 3 on
Standby
18 Buzzer 0 = Enable Buzzer; 1 = Disable Buzzer
19 Password Protection 0 = Protection Off; 1 = Protection On
20 B
21 RF Power Units 0 = Measure RF in dBm; 1 = Measure RF in Watts (v. 3.50)
22 Reserved N/A
0 = Low range 13V, 900 mA; 1 = High range 17V, 900 mA; 2
23 LNA/LNB PS Output Voltage = High Power Range 24V, (2).26;1 .5A (Standard/HP version
24 Standby Mode 0 = Hot Standby; 1 = Cold Standby (v. 6.00)
. O s 9 B S B
26 Remote SSPA Attenuation Valid Values= 0 to 255 (v. 3.10 dBx10 value)
27 Switch Mute 0 = Off; 1 = Internal; 2 = External; 3 = All on (v. 3.30)
28 Fault Tolerance 0 = Disabled; 1 = One Fault; 2 = Two Faults (v. 3.70)
Settings required for normal operation of IP interface.
20-32 1P Address (MSB-LSB)* | SO0 e on the ROP unit Change to hete
settings effective only after controller restart. (v. 4.00)
Settings required for normal operation of IP interface.
3335 P Gateway (MSB-LSB) " | 0 ted on the RCP unit Changes to these -
settings effective only after controller restart. (v. 4.00)
Settings required for normal operation of IP interface.
P Subnet sk (i5e - Lsp) | Consulnebuork admitalor o2 proger seup; AL sfings
settings effective only after controller restart. (v. 4.00)
Settings required for normal operation of IP interface.
Receive P Port (M3 - Log) | Consullneuor aminitlor o roper stup, Al st
settings effective only after controller restart. (v. 4.00)
Settings required for normal operation of IP interface.
43-46 IP Lock Address (MSB - LSB) * Consult network administrator for a proper setup. All settings

physically located on the RCP unit. Changes to these
settings effective only after controller restart. (v. 4.00)




Individual SSPA Unit Attenuation Offset.

Sum of Offset value and Remote SSPA

S s Attenuation value (Data Address 26) VElEIVEEES W o e (% )
must be < 20
* Requires hardware reset
Table 8: System Condition Data Values
Data #

Address Bytes

1

1

Description

Unit 1 Fault State

Limits and Byte Values

0 = No Fault; 1 = Fault; 2 = Ignored

2 1 Unit 2 Fault State 0 = No Fault; 1 = Fault; 2 = Ignored
3 1 Unit 3 Fault State 0 = No Fault; 1 = Fault; 2 = Ignored
4 1 Summary Fault 0 = No Fault; 1 = Fault
5 1 Power Supply 1 Fault State 0 = No Fault; 1 = Fault
6 1 Power Supply 2 Fault State 0 = No Fault; 1 = Fault
7 1 Auxiliary Input Fault State 0 = No Fault; 1 = Fault; 2 = Ignored
8 1 External Port State Bit 0-2 = SSPA Input lines; Bit 3-8 = Auxiliary Input lines
Bit 0 = 1, Faults enabled; Bit 0 = 0, Faults disabled; Bit 1 = 1,
9 1 LNA Faults Unit 1 Fault; Bit 2 = 1, Unit 2 Fault; Bit 3 = 1, Unit 3 Fault; Bits
1-3 =0, No Fault
Bit 0 = 1, Faults enabled; Bit 0 = 0, Faults disabled; Bit 1 = 1,
10 1 SSPA Faults Unit 1 Fault; Bit 2 = 1, Unit 2 Fault; Bit 3 = 1, Unit 3 Fault; Bits
1-3 =0, No Fault
11 1 RF Switch 1 Position 1= Switch Fault; 2 = Switch Ignzore; 3 = Position 1; 4 = Position
12 1 RF Switch 1 Position 1= Switch Fault; 2 = Switch Ignore; 3 = Position 1; 4 = Position
Forward RF Power (available only If Setting RF Power Units = 0, Value x 10dBm; If Setting RF
13-14 2 with systems equipped with Forward | Power Units = 1, Value x 10 W; (See Table 7, Data Address 21
RF power meter) for details) (-100 for N/A (0OxFF9C)); Low Byte First (v. 3.10)
p Yy
Ambient Temperature (in °C)
15-16 2 (available only with systems Value x 1 °C; N/A=0xFFOC (if parameter is not available at
equipped with Forward RF power present time); Low Byte First (v. 3.10)
meter)
Core Temperature of SSPA Unit 1 or. _ . . .
1718 | 2 | (available only with systems with | VA€ X T"Ci N/AS Sr’;';f,gfo\(,\'/fga{:?ﬁ;fr(\'fgﬁto";“’a"ab'e at
remote SSPA control enabled) P ’ y T
Core Temperature of SSPA Unit 2 0. _ . . .
19-20 2 (available only with systems with Vel CiesNe/’r‘;\t_ gézs_gfo&fga{:?ﬁgusg (:tO?vallable e
remote SSPA control enabled) P ’ Y e
Core Temperature of SSPA Unit 3 o. _ . . .
2122 | 2 | (available only with systems with | vauex1°C: A= t‘i)ég_gfo\(,\'fgs{:?ﬁ;?r(\'fg‘;tof)"’a"ab'e at
remote SSPA control enabled) P ’ T
. If Setting RF Power Units = 0, Value x 10dBm; If Setting RF
S Reﬂ\f’v‘fttﬁgyRstFer':}g“gu(if)‘;'('f\?v'ﬁhon'y Power Units = 1, Value x 10 W (See Table 7, Data Address 21
el R e s for details) (-100 for N/A (O)éF:l;g)C)); Low Byte First (version
25-26 2 DC Current (Unit 1 in Amps) Value x 10 Amp; N/A=0XFF9C; Low Byte First (v. 3.60)
27-28 2 DC Current (Unit 2 in Amps) Value x 10 Amp; N/A=0XFF9C; Low Byte First (v. 3.60)
29-30 2 DC Current (Unit 3 in Amps) Value x 10 Amp; N/A=0XFF9C; Low Byte First (v. 3.60)
31-32 2 Forward RF Power (Unit 1 in dBm) Value x 10 dBm; N/A=0XFF9C; Low Byte First (v. 3.60)
33-34 2 Forward RF Power (Unit 2 in dBm) Value x 10 dBm; N/A=0XFF9C; Low Byte First (v. 3.60)
35-36 2 Forward RF Power (Unit 3 in dBm) Value x 10 dBm; N/A=0XFF9C; Low Byte First (v. 3.60)

Table 9: System T

hreshold Data Values




Data

#

Address  Bytes Description Limits and Byte Values
1 2 LNA Unit 1 Calibration | Point conversion: 0.57 mA per 1 value increment, maximum value =4095
Data (2.3A) (read/write)
2 2 LNA Unit 2 Calibration | Point conversion: 0.57 mA per 1 value increment, maximum value =4095
Data (2.3A) (read/write)
3 5 LNA Unit 3 Calibration | Point conversion: 0.57 mA per 1 value increment, maximum value =4095
Data (2.3A) (read/write)
. Point conversion: 0.57 mA per 1 value increment, maximum value =4095
4 2 LNA Unit 1 DC Current (2.3A) (v6.00) (read only)
. Point conversion: 0.57 mA per 1 value increment, maximum value =4095
5 2 LNA Unit 2 DC Current (2.3A) (v6.00) (read only)
. Point conversion: 0.57 mA per 1 value increment, maximum value =4095
6 2 LNA Unit 3 DC Current (2.3A) (v6.00) (read only)
7 2 LNA Unit 1 DC Voltage Point conversion: 0.1 V per 1 value increment, maximum value =1023
(v6.00) (read only)
. Point conversion: 0.1 V per 1 value increment, maximum value =1023
8 2 LNA Unit 2 DC Voltage (v6.00) (read only)
. Point conversion: 0.1 V per 1 value increment, maximum value =1023
9 2 LNA Unit 3 DC Voltage (v6.00) (read only)
Point conversion: 0.1 V per 1 value increment, maximum value =1023
10 2 PS1 DC Voltage (v6.00) (read only)
Point conversion: 0.1 V per 1 value increment, maximum value =1023
1 2 PS2 DC Voltage (v6.00) (read only)
12 2 O Chizese Value x 1 °C (v6.00) (read only)

Temperature




Examples

This section contains several examples of serial data exchange between a host computer and an RCP 1:2 Redundant
Controller. All byte values are given in hexadecimal format. The following controller and system switch positions are used
throughout all examples.

RCP2-1200 Network Address = ©
Host Computer Network Address = OxA
Request ID = Ox6F

Amplifier Status
Amplifier #1= OK
Amplifier #2= Faulted
Amplifier #3= OK

Power Supply Status
Power Supply #1=0K
Power Supply #2=0K

Auxiliary Fault Inputs = Faulted

RF Switch Status
Switch #1 Position
Switch #2 Position

Position 1
Undetermined or Faulted

Example 1

The host computer requests the RCP system conditions. The RCP detects no errors in the request frame and issues a
response. The PC request string is listed below.

Table 10: Example 1: PC Requests RCP System Conditions

Byte Byte Value

Position (Hex) DEEE LT
1 AA Frame Sync Byte 1
2 55 Frame Sync Byte 2
3 0 Destination Address of RCP unit
4 A Source address of Request originating PC Host
5 0 Protocol Version Compatibility Field must always be 0
6 6F Request ID byte is set by originator, will be echoed back by respondent
7 1 Command field for "Get" type request
8 3 "System Conditions" tag indicates which data from respondent required in response frame
9 1 Data Address field indicates the beginning datg address inside of the "System Conditions" data
set to 1 (first element)
10 c Data Length field indicates h(_)w many_data bytes of the "System anditions“ requested from
RCP2 (12 (C) is all available data of "System Conditions" type)
11 8A Arithmetic checksum of bytes number 3 through 10

The RCP replies with the following response string.

Table 11: Example 1: RCP Response (System Conditions)

Byte
Value Description
(Hex)

Byte

Position




1 AA Frame Sync Byte 1
2 55 Frame Sync Byte 2
3 A Destination Address of PC request originator
4 0 Source address of RCP respondent
5 Protocol Version Compatibility Field must always be 0
6 6F Echo of the Originator's Request ID byte
7 3 Command field for "Get" type response
8 3 "System Conditions" tag indicates which data from respondent included in response frame.
9 0 Data Address field omitted and replaced with Error status code. 0 in this field indicates absence of
errors.
10 c Data Length field indicates how many data bytes of the "System conditions" requested from RCP
(12 (C) is all available data of "System Conditions" type).
1 0 Data field 1 contains data element 1 of "System Conditions" data type, which is RCP System
Unit1 Fault State. 0 Indicates that Unit 1 is not faulted.
12 1 Data field 2 contains data element 2 of "System Conditions" data type, which is RCP System
Unit2 Fault State. 1 Indicates that Unit 2 is in fault condition.
13 0 Data field 3 contains data element 3 of "System Conditions" data type, which is RCP System
Unit3 Fault State. 0 Indicates that Unit 3 is not faulted.
14 1 Data field 4 contains data element 4 of "System Conditions" data type, which is RCP System
Summary Fault State. 1 Indicates presence of faults in the system.
Data field 5 contains data element 5 of "System Conditions" data type, which is RCP System
15 0 Power Supply 1 Fault State. 0 Indicates that Power supply 1 is not faulted and functioning
properly.
Data field 6 contains data element 6 of "System Conditions" data type, which is RCP System
16 0 Power Supply 2 Fault State. 0 Indicates that Power supply 2 is not faulted and functioning
properly.
17 1 Data field 7 contains data element 7 of "System Conditions" data type, which is RCP System
Auxiliary Fault State. 1 Indicates presence of faults on one of the Auxiliary Inputs.
18 FF Data field 8 contains data element 8 of the "System Conditions" data type. This data element is
reserved for future applications.
19 FF Data field 9 contains data element 9 of the "System Conditions" data type. This data element is
reserved for future applications.
20 FF Data field 10 contains data element 10 of the "System Conditions" data type. This data element is
reserved for future applications.
21 3 Data field 11 contains data element 11 of the "System Conditions" data type, which is RF Switch 1
state. 3 Indicates that RF Switch 1 is in Position 1.
Data field 12 contains data element 12 of the "System Conditions" data type, which is RF Switch
22 1 2 state. 1 Indicates that RF Switch 2 is has a fault condition or its position can't be reliably
determined.
23 8F Arithmetic checksum of bytes number 3 through 22

Example 2

The host computer requests the RCP system thresholds. The request string is:

Byte

Byte Value

Table 12: Example 2: PC Requests RCP System Thresholds

Position (Hex) LEsEl LT
1 AA Frame Sync Byte 1
2 55 Frame Sync Byte 2
3 0 Destination Address of RCP unit
4 A Source address of Request originating PC Host
5 0 Protocol Version Compatibility Field must always be 0




6 6F Request ID byte is set by originator, will be echoed back by respondent

7 1 Command field for "Get" type request
8 1 "System Thresholds" tag indicates which data from respondent required in response frame
9 1 Data Address field indicates the beginning data address inside of the "System Conditions" data
set to 1 (first element)
10 6 Data Length field indicates how many data bytes of the "System Thresholds" requested from
RCP2 (6 is all available data of "System Thresholds" type)

11 82 Arithmetic checksum of bytes number 3 through 10

The RCP replies with the following response string:

Table 13: Example 2: RCP Response (System Thresholds)

Byte

iz Value Description

Position (Hex)

1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 A Destination Address of PC request originator

4 0 Source address of RCP respondent

5 0 Protocol Version Compatibility Field must always be 0

6 6F Echo of the Originator's Request ID byte

7 3 Command field for "Get" type response

8 1 "System Thresholds" indicates which data from respondent is included in response frame

9 0 Data Address field omitted and replaced with Error status code. 0 = no errors.

10 6 Data Length field indicates how.many data bytes "System Thresholds" requested from RCP (6 is
all available data of "System Thresholds" type)

11 D1 Data field 1 contains least significant byte of data element 1 of "System Thresholds" data type,

which is LNA 1 cal. point

Data field 2 contains most significant byte of data element 1 of "System Thresholds" data type,
12 0 which is LNA 1 cal. point. Data can be normalized to LNA current as follows: Lna1calpoint *
0.57mA/point = 209*0.57 = 119.13 mA

13 F Data field 3 contains least significant byte of data element 2 of "System Thresholds" data type,
which is LNA 2 cal. point

Data field 4 contains most significant byte of data element 2 of "System Thresholds" data type,
14 0 which is LNA 2 cal. point. Data can be normalized to LNA current as follows: Lna1 cal point *
0.57mA/point = 216*0.57 = 123.12 mA

Data field 5 contains least significant byte of data element 3 of "System Thresholds" data type,

15 pe which is LNA3 cal. point.
Data field 6 contains most significant byte of data element 2 of "System Thresholds" data type,
16 0 which is LNA 3 cal. Point. Data can be normalized to LNA current as follows: Lna1 cal point *
0.57mA/point = 220*0.57 = 125.4 mA
17 8 Arithmetic checksum of bytes number 3 through 16
Example 3

The host computer requests the RCP network address. The PC request string is listed below.

Table 14: Example 3: PC Requests RCP Network Address

Byte Byte Value

Position (Hex) Description
1 AA Frame Sync Byte 1
2 55 Frame Sync Byte 2

3 FF Destination Address is broadcast network address




4 A Source address of Request originating PC Host

5 0 Protocol Version Compatibility Field must always be 0

6 6F Request ID byte is set by originator, will be echoed back by respondent

7 1 Command field for "Get" type request

8 0 "System Settings" tag indicates which data from respondent required in response frame

9 8 Data Address field indicates the addrgss of the RCP2's network address inside "System
Settings" data set to 8

10 1 Data Length field indicates how many data bytes "System Settings" requested from RCP (1

byte requested)
11 82 Arithmetic checksum of bytes number 3 through 10

The RCP replies with the following response string.

Byte Byte Value

Table 15: Example 3: RCP Response (Network Address)

Position (Hex) R
1 AA Frame Sync Byte 1
2 55 Frame Sync Byte 2
3 A Destination Address of PC request originator
4 0 Source address of RCP respondent
5 0 Protocol Version Compatibility Field must always be 0
6 6F Request ID byte is set by originator, will be echoed back by respondent
7 3 Command field for "Get" type of the response
8 "System Settings" indicates which data from respondent is included in response frame
9 0 Data Address field omitted and replaced with Error status code. 0 in this field indicates
absence of errors
10 1 Data Length field indicates how many data bytes "System Settings" requested from RCP
11 0 Data field 1 contains data element 8 of "System Settings" data type. "Unique Network
Address"=0
12 7D Arithmetic checksum of bytes number 3 through 11

Example 4

The host computer requests the Priority be set to Polarity #2. The PC request string is listed below.

Table 16: Example 4: PC Requests RCP Priority Set to Polarity #2

Pc?s);:ii n By:ﬁ;l:)lue Description
1 AA Frame Sync Byte 1
2 55 Frame Sync Byte 2
3 0 Destination Address of RCP unit
4 A Source address of Request originating PC Host
5 0 Protocol Version Compatibility Field must always be 0
6 6F Request ID byte is set by originator, will be echoed back by respondent
7 Command field for "Set" type request
8 "System Settings" indicates which data from respondent is required in response frame
9 5 Data Address field indicates the addres§ of the RCP's Priority Select data element inside
"System Settings" (data element 5)
10 1 Data Length field indicates how many data bytes of the "System Conditions" requested from
RCP2 (1 byte requested)




11

Data Field 1. 1 Indicates that priority must be set to Pol2

12

7F

Arithmetic checksum of bytes number 3 through 11

The RCP replies with the following response string.

Table 17: Example 4: RCP Response (Priority Set Failed)

Pc?s)i/:& n By:a;l:)l ue Description
1 AA Frame Sync Byte 1
2 55 Frame Sync Byte 2
3 A Destination Address of PC request originator
4 Source address of RCP respondent
5 Protocol Version Compatibility Field must always be 0
6 6F Echo of the Originator's Request ID byte
7 2 Command field for "Set" type response
8 0 "System Settings" indicates which data from respondent is included in response frame
9 2 Data Address field omitted and replaced with Error status code. 2 indicates "No such
data" error
10 1 Data Length field indicates how many data bytes "System Settings" requested from RCP
1 0 Data field 1 contains rejected data
12 7E Arithmetic checksum of bytes number 3 through 11




Terminal Mode Serial Protocol

The Teledyne Paradise Datacom RCP Redundant System Controller utilizes Terminal Mode Serial Protocol (TMSP) as a
secondary serial protocol for Management and Control through a Remote Serial Interface.

TMSP allows the user to access internal RCP functions via a remote ASCII Terminal or its equivalent (such as HyperTerminal
for Windows). TMSP is accomplished through either the RS-232 or RS-485, half duplex, serial communication link.

U.S. ASCII encoded character strings are used to represent commands and data messages. A remote terminal or controller
initiates a communication session and the RCP takes action and returns a report of requested status. The controller will not
initiate communication and will transmit data only when commanded to do so. Prior to establishing the session with the unit,
this mode must be enabled through the front panel menu.

The remote terminal must be configured with serial settings that match the unit's serial port settings. For example, if the unit

is set at 9600 Baud, the remote terminal must be also configured as ASCII terminal at 9600 Baud, no parity, 8 bit data with 1

stop bit serial connection. The unit will not echo back any incoming characters, so local echo must be enabled on the remote
terminal.

To establish a remote control session with the unit, the user must type "UNIT#XXX" in the terminal window (all letters must
be in upper case), where XXX is the unit's unique network address or the global call address (255). Press the "Enter" key on
Remote Terminal keyboard.

The unit should answer with words "Unit#XXX OnLine" with the first menu screen on the following lines. After a remote
session is successfully established, the unit will stay connected as long as needed. The session interface mimics the unit's
front panel menu. To help the user navigate through the menu, the help string with the list of active keys always follows the
menu strings.

For example: "Active Keys:(U)p+Enter;(D)own+Enter;(C)lrearFlt; (M)enu+Enter; (E)nd+Enter" will be the last transmission
string on all informative menu screens. NOTE: All letters must be in upper case!

To refresh current screen on the Remote Terminal simply press "Enter" key. To end a session, press "E" and then the "Enter"
key.

&y Important! If multiple units are networked on the same serial link, DO NOT ESTABLISH A SESSION WITH
MORE THAN ONE UNIT A TIME. If you do so you will not get a valid response!

The following procedure will guide the user through the remote terminal setup, using the Windows 95/98 HyperTerminal
software. The unit must be connected to a PC com port and configured to use TMSP with 9600 Baud rate prior to setting up
the PC configurations.

Start the Windows HyperTerminal Program (default Windows location at Programs - Accessories - HyperTerminal).

Enter the name of your serial connection ("Compact Outdoor SSPA" for example), and then click "Ok" button. See Figure 8.

Connection Description HEB

: New Connection

Enter a name and choose an icon for the connection:

Name:
|Compact Oudoor S5P4|

SsBeH s

ok | cancel |

lcon:

Figure 8: HyperTerminal Connection Description

Select direct connection to the PC communication port (Com1 for example), which meant to be used for communication with
unit, and then click "OK" Button. See Figure 9.


http://stc-ppapp-web02/Intranet/xml/216351draft/images/hyperterminal-connection.png
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Connect To EHE

% Compact Oudoor SSPA

Enter details for the phone number that you want to diat

Country/region: I;' ted States of Amenca (1 _'I
Area code: IE‘—'

Connect using (AT I - |
|0K|l:ame||

Figure 9: HyperTerminal Communication Port Selection

In the next window, select the following as shown in Figure 10:

1. Set Bits per Second to 9600;
2. Set Data bits to 8;
3. Set Parity to None;
4. Set Stop bits to 1;
5. Set Flow control to none.
6. Click the "OK" button.
COM3 Properties HER
Port Settings I
Bits per second: I‘EIBUD ;l
Data bits: IS ;l
Parity: INone ;l
Stop bits: |1 ;|
Elow control: r'h:une 'I

Advanced... I Restore Defaults I
ok | camca | oo |

Figure 10: HyperTerminal Communication Properties

Normally, the unit will not echo back characters typed by the user in a Terminal window. For added security and convenience,
turn on Local Echo in the HyperTerminal application. To do so, select the following from the HyperTerminal menu: File ?
Properties ? Settings ? ASCII setup. This will bring up a window similar to that shown in Figure 11. In this window, check the
box marked "Echo typed characters locally" and click "OK".
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ASCII Setup EHE

— ASCIl Sending
[~ Send line ends with line feeds
[~ Echo typed characters locally

Line delay: [0 miliseconds.
Character delay: IO miliseconds.

.~ ASCIl Receiving
[~ Append line feeds to incoming line ends
[~ Force incoming data to 7-bit ASCII
[V Wrap lines that exceed terminal width

Figure 11: HyperTerminal ASCII Setup

& NOTE: Due to a software bug on some versions, this feature may not work. Do not use versions prior to
6.3. Download the latest version of HyperTerminal at http://www.hilgraeve.com.

Your PC is now configured to work with the controller in Terminal mode. To establish a session with the controller, type
"UNIT#170"

& Note: When using a RS-485 connection, avoid using the global address (170). Instead, use the unique
RCP address.

An example of a terminal mode session shown on Figure 12.
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UNIT#101
Helcome! Unit#101 Online

PS1:Fault System:Fault SW1:Fault
PS2:Normal  Aux:Normal SW2:Fault
(B)ack; + EnterlrearFlt;(U)p;(D)own;{M)enu;(E)nd;D

Pricl:Terminal Intrfc:RS232 Logic:Lo
Baud: 9600  SysAddr:101 Latch:Dis
Active Keys:(C)lrearF1t;(U)p;(D)own;(M)enu;(E)nd;(B)ack; + Enter

D

Track:Ext. Ctrl:Local Window(%): 87

Prior:Poll  Mode:Manual  Buzzer:D

Active Keys:(C)lrearF1t;(U)p;(D)own; (N)enu (E)nd;(B)ack; + Enter
D

LNA/LNB Faults:N/A  PS10ut(V):00.0

SSPA Faults:None PS20ut(V):28.4
Active Keys:(C)lrearF1t;(U)p;(D)own;(M)enu;(E)nd;(B)ack; + Enter

Figure 12: Terminal Mode Example
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Ethernet Interface

Overview

The RCP2 Ethernet port (J9) supports several IP network protocols to provide a full featured remote M&C interface over an
Ethernet LAN.

« |PNet protocol - redirection of standard Teledyne Paradise Datacom serial protocol over UDP transport layer
protocol. This protocol is fully supported in Teledyne Paradise Datacom's Universal M&C software.

« SNMPv1 protocol - This protocol intended for integration into large corporate NMS architectures.

e HTTP Web interface - This interface is designed to allow platform independent remote control function for a single
RCP2 unit.

In order to utilize either of the protocols listed above, the relevant interface option has to be turned on. Refer to the following
sections:

* IPNET Interface
* SNMP Interface
* Web Interface

Of course, standard IP level functions such as ICMP Ping and ARP are supported as well. There is currently no support for
dynamic IP parameters settings (DHCP).

IPNet Interface

General Concept
Satcom system integrators are recognizing the benefits of an Ethernet IP interface. These benefits include:

e Unsurpassed system integration capabilities;

« Widely available and inexpensive set of support equipment (network cable; network hubs);
¢ Ability to control equipment over Internet;

e Ease of use

Implementation of the raw Ethernet interface is not practical due to the limitations it places on M&C capabilities by the range
of a particular LAN. It is more practical to use an Ethernet interface in conjunction with the standard OSI (Open System
Interconnect) model to carry a stack of other protocols. In an OSI layered stack, an Ethernet interface can be represented as
a Data Link layer. All upper layers are resolved through a set of IP protocols. In order to keep data bandwidth as low as
possible (which is important when M&C functions are provided through a low-bandwidth service channel) the IP/UDP
protocol set is used as the Network/Transport layer protocol on Teledyne Paradise Datacom SSPAs.

UDP (User Datagram Protocol) was chosen over TCP (Transmission Control Protocol) because it is connectionless; that is,
no end-to-end connection is made between the unit and controlling workstation when datagrams (packets) are exchanged.

Teledyne Paradise Datacom provides a Windows ®-based control application to establish UDP-based Ethernet
communication with the unit. The control application manages the exchange of datagrams to ensure error-free
communication. An attractive benefit of UDP is that it requires low overhead resulting in minimal impact to network
performance. The control application sends a UDP request to unit and waits for response. The length of time the control
application waits depends on how it is configured. If the timeout is reached and the control application has not heard back
from the agent, it assumes the packet was lost and retransmits the request. The number of the retransmissions is user
configurable.

The Teledyne Paradise Datacom RCP2 Ethernet IP interface can use UDP ports from 0 to 65553 for sending and receiving.
The receiving port needs to be specified through the front panel menu. For sending, it will use the port from which the UDP

request originated. It is up to the user to select an appropriate pair of ports that are not conflicting with standard IP services.
Teledyne Paradise Datacom recommends usage of ports 1007, 1038 and 1039. These ports are not assigned to any known
application.

As an application layer protocol (which actually carries meaningful data), the standard RCP2 serial protocol was selected.
This protocol proves to be extremely flexible and efficient. It is also media independent and can be easily wrapped into
another protocol data frame. An example of the UDP frame with encapsulated Teledyne Paradise Datacom protocol frame is
shown on Figure 13.

UDP Header |SSPA Serial Protocol Frame| CRC 16
(8 bytes) (11+N Bytes, 0<N<128) checksum

Figure 13: UDP Frame
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This set of Ethernet IP protocols is currently supported by Teledyne Paradise Datacom Universal M&C package
(RCP2/FPRC/RCPD selection). The software is available for download from the web site, http://www.paradisedata.com.

Setting IPNet Interface

All IP-related menu items are consolidated under the following menu: Tap the Home icon to return to the main menu screen;
tap the Communication button; tap the IP Setup button.

Prior to enabling the Ethernet IP interface, the following IP parameters need to be set: IP Address, Gateway, Subnet Mask,
Local Port and Lock IP Address. The Lock IP address is a security measure. Setting this parameter either to 0.0.0.0 or
255.255.255.255 will allow any host to control the unit. Setting the parameter to the specific address of the remote host will
lock RCP2 access to this host. Packets received from other hosts will be ignored. For other parameters (IP Address,
Gateway, Subnet Mask, Local Port) contact your network system administrator.

& Important! If you are planning to access the unit through the Internet, you must exercise the appropriate
security measures. It is strongly recommended to put RCP2 units behind a protective Firewall or set up a
VPN link for remote access.

After selecting the IP parameters, you may turn on IP interfaces through front panel. Tap the Home icon to get to the main
menu; tap the Communication button; tap the Interface button; tick the IPNET checkbox.

Once the Ethernet Interface is selected, the RS232/485 Main port is disabled. IP settings may be adjusted when the IPNet
interface is turned on as needed without losing IP link. New settings will become effective only after a controller hardware
reset or power cycle (Tap "Home" > "Options" > "System" > "Reset" > "Comms Only" > "OK" to confirm reset).

To disable the Ethernet port and enable the RS232/485 port, tap the Home icon to access the main menu; tap the
Communication button; tap the Interface button; tick either the RS232 or RS485 checkbox.

&y Important! At present, the controller supports one remote control protocol selection through its Ethernet
interface port. This protocol is referred to as "Normal" on the front panel display. If the protocol selection
is set to "Terminal”, the controller will force its protocol selection to "Normal".

The Ethernet port can be connected to a network hub through straight through network cable or directly to a work station NIC
card through a null-modem or cross-over cable (Rx and Tx lines are crossed). As soon as an Ethernet interface has been
selected as the primary interface, you should be able to verify the network connection to the unit by using the Ping command
from your host workstation.

To do so on a Windows based PC, open a Command Prompt window and type PING and the dot delimited IP address of the
controller, then press the Enter key. If the unit is successfully found on the network, the request statistic will be displayed.

PING XXX.XXX.XXX.XXX

If the unit does not answer on the ping command, check all hardware connections and verify that the IP settings on your host
workstation and the controller match your network parameters. On a Windows-based PC you may also check ARP table
entries. The new IP address of the unit may be set to another PC or network equipment with a different MAC address. Open
a Command Prompt window and type "ARP -a", the press Enter. The current table will be displayed. If you see the unit IP
address entry in the table, delete it by issuing the command "ARP -d XXX XXX.XXX.XXX" and press Enter

(XXX XXX XXX XXX is the IP address of the unit). Now try the PING command again. More information about how to set up
a network connection with the unit can be found in the Ethernet Interface Set-Up and Cabling section.

Using the RCP2 Web Interface

Starting with firmware version 6.00, the RCP web interface no longer needs to have a pre-installed Java application to
operate. The web interface uses standard hypertext transfer protocol on port 80. The web interface is compatible with most
modern web browsers, such as Firefox, Chrome or Internet Explorer, which support asynchronous JavaScript XML
transactions (aka AJAX).

To connect to the controller internal web page, the user must make sure Web/IPNet interface is enabled on the device and
that an IP address has been assigned to the unit. Connect the unit to an Ethernet network or directly to a PC 10/100 Base-T
adapter and then open a web browser. Refer to the Setting IPNet Interface procedure of the Remote Control Interface
section.
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Figure 14: Web Interface Screen

Enter the IP address of the unit into the address bar of the browser. A security login window will appear. In the User Name
field, enter admin, the default User Name. See Figure 15. The User Name is fixed and cannot be changed by the operator.

X
Authentication Required
The server http://192.168.0.9 requires a username and
password. The server says: RCP2/FPRC Web Server.
User Name: admin
Password:  **YMMM*
LogIn Cancel

Figure 15: Web Interface Login Window

In the Password field, enter the web password assigned to the unit. The factory default password is paradise. The user
name and password are case sensitive. The password may be changed at any time and may comprise up to 15 alpha-
numeric characters.

Click on the [Log In] button to open the M&C control in the web browser (Figure 15).

To select another password, enter the following selection on the touchscreen: Tap the Home icon to return to the Main Menu;
tap the Communication button; tap the Interface button; tick the IPNet checkbox; tap the IP Setup button; tap the Web Pwd
button. Enter the new password using the keypad on the touchscreen. Tap the OK button to accept the entered password.

The top bar of RCP2 Monitor and Control application shows top level fault conditions: Power supply and unit faults as well as
Auxiliary fault status.

The left side of the window displays unit model and serial number, firmware build, device MAC address and device up time
since last I/O card power up or reboot. Additional information is displayed in multipage insert in the middle of the screen:

o Status: A view of all faults and operational parameters.

e« Communication Settings: This tab provides access to all communication related settings. From here, the user can
change the IP settings, Interface, Protocol, Baud Rate, Password and SNMP settings.

e General Settings: Read/Write listing of most adjustable RCP parameters. All options are selectable. To set a
parameter, select the new value and click the "Confirm" button with the mouse pointer.

¢ HPA Control panel: All information and controls related to remotely control HPA system (if available)


http://stc-ppapp-web02/Intranet/xml/216351draft/images/web-interface-screen.png
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& Note: The web server has limited hardware resources to support multiple simultaneously connected
users. In the case that multiple users are connected to the same amplifier, service quality cannot be
assured.

SNMP Interface

Introduction

SNMP-based management was initially targeted for TCP/IP routers and hosts. However, the SNMP-based management
approach is inherently generic so that it can be used to manage many types of systems. This approach has become
increasingly popular for remote management and control solutions for various SSPA systems.

Teledyne Paradise Datacom devices with Ethernet interface support the most popular SNMPv1 format (SMlv1, RFC1155),
SNMP Get, SNMP GetNext and SNMP Set commands. SNMP Traps are currently unsupported in units with serial numbers
of 400000 and below.

In order to utilize SNMP protocol, the user has to enable this feature through the front panel or by remote serial protocol.
SNMP uses the UDP fixed port 161 for sending and receiving requests.

The definition of managed objects described in MIB. The MIB file is available for download from the Software Downloads
section of the Teledyne Paradise Datacom web site, http://www.paradisedata.com.

As with the serial protocol, the RCP2 MIB allows access to a remote SSPA (default state) as well as to the unit itself. To
switch between those devices' MIBs, the proper Device Type has to be selected (OID -1.3.6.1.4.1.20712.1.4).

The Teledyne Paradise Datacom MIB is a table-based MIB, and is the same for all devices. The MIB table is designed to
follow the same pattern as the tables for serial protocol. For additional information about OID values, refer to Table 11
through Table 13. The text values in the tables help automatic value parsing within NMS or make the values readable
through an MIB browser. All text value OIDs follow the same pattern:

1. For settings or parameters with discreet values:
SettingName'ValueName1=xxx, ..,ValueNamex=xxx
Example: ControlMode'Local=0,Remote=1

2. For settings or parameters with continuous values:
SettingName'LowLimit..HighLimit
Example: NetworkAddress'0..255

SNMP V3 Issues in Teledyne Paradise Datacom RCP2 Controller

Simple Network Management Protocol (SNMP) is an interoperable standards-based protocol that allows for external
monitoring of the Content Engine through an SNMP agent.

A SNMP-managed network consists of three primary components: managed devices, agents, and management systems. A
managed device is a network node that contains a SNMP agent and resides on a managed network. Managed devices
collect and store management information and use SNMP to make this information available to management systems that
use SNMP. Managed devices include routers, servers, switches, bridges hubs, computer hosts, and printers.

An agent is a software module that has local knowledge of management information and translates that information into a
form compatible with SNMP: the Management Information Base (MIB). The agent can send traps, or notification of certain
events, to the manager. Essentially, a Teledyne Paradise Datacom SSPA is considered a "SNMP agent".

A manager is a software module that listens to the SNMP notifications sent by SNMP agents. The manager can also send
requests to an agent to collect remote information from the Management Information Base (MIB).

The communication between the agent and the manager uses the SNMP protocol, which is an application of the ASN.1 BER
(Abstract Syntax Notation 1 with Basic Encoding Rules), typically over UDP (for IP networks).

Version 1 (SNMPv1, described in RFC 1157) is the initial implementation of SNMP.

Version 2 (SNMPv2c, described in RFC 1902) is the second release of SNMP. It provides additions to data types, counter
size, and protocol operations.

Version 3 (SNMPv3, described in RFC 2271 through RFC 2275) is the most recent version of SNMP.

SNMP V1

SNMP version 1 (SNMPv1) is the initial implementation of the SNMP protocol. SNMPv1 operates over protocols such as
User Datagram Protocol (UDP), Internet Protocol (IP), OSI Connectionless Network Service (CLNS), AppleTalk Datagram-
Delivery Protocol (DDP), and Novell Internet Packet Exchange (IPX). SNMPv1 is widely used and is the de-facto network-
management protocol in the Internet community.



The Teledyne Paradise Datacom RCP2 family of products utilizes the most popular implementation, SNMP V1 over UDP
transport layer.

SNMP V2

SNMPv2 (RFC 1441-RFC 1452) revises version 1 and includes some improvements in the areas of performance, security,
confidentiality, and manager-to-manager communications. It introduced GetBulkRequest, an alternative to iterative
GetNextRequests for retrieving large amounts of management data in a single request.

However, the new party-based security system in SNMPv2, viewed by many as overly complex, was not widely accepted.

The format of the trap message was also changed in SNMPv2. To avoid these compatibility issues, the trap mechanism was
not implemented in the Teledyne Paradise Datacom SSPA MIB.

SNMP V3

Although SNMPv3 makes no changes to the protocol aside from the addition of cryptographic security, it looks much different
due to new textual conventions, concepts, and terminology. SNMPv3 primarily added security and remote configuration
enhancements to SNMP. Many embedded controllers and microprocessors that are used in electronic components such as
amplifier modules do not have support for SNMP V2 or V3. This is due to the extensive memory resources required by the
computation intensive cryptographic security of SNMP V3.

For this reason V3 has not gained widespread support amongst embedded MCU platform manufacturers. Existing port
implementations are limited to very powerful ARM5 or above cores, running under full-scale OS systems (Linux, Android,
etc.). At large, these configurations require external bulk RAM/FLASH to operate. This requirement ultimately affects the
minimum device startup time (tens of seconds, due to the large boot BIOS) and working temperature range (mostly indoor).

As noted in Cisco's release notes about SNMP V3:

&% SNMP notifications can be sent as traps or inform requests. Traps are unreliable because the receiver
does not send acknowledgments when this device receives traps. The sender cannot determine if the
traps were received. However, an SNMP entity that receives an inform request acknowledges the message
with an SNMP response protocol data unit (PDU). If the sender never receives the response, the inform
request can be sent again. Therefore, informs are more likely to reach their intended destination. However,
informs consume more resources in the agent and in the network. Unlike a trap, which is discarded as
soon as it is sent, an inform request must be held in memory until a response is received, or the request
times out. Traps are sent only once, while an inform can be retried several times. The retries increase
traffic and contribute to a higher overhead on the network.

(http://www.cisco.com/c/en/us/support/docs/ip/simple-network-management-protocol-snmp/13506-snmp-traps.html, last
visited on 19 March 2019.)

SNMP MIB Tree



--paradiseDatacom(1.3.6.1.4.1.20712)
--deviceINFO(1)

+
|
| +-- r-n OctetString deviceID(1)

|  +-- rwn OctetString devicelocation(2)
| +-- r-n OctetString deviceRevision(3)
|  +-- r-n Enumeration deviceType(4)

I

+

--devices(2)

+--paradiseDevice(1)
+--settings(1)
+--settingsEntry (1) [settingIndex]

+-- rwn Integer32 settingIndex(1)
+-- rwn Integer32 settingValue(2)
+-- r-n OctetString settingTextValue(3)

+--thresholds(2)

+--thresholdsEntry(1) [thresholdIndex]

+-- rwn Integer32 thresholdIndex(1)
+-- r-n Integer32 thresholdvalue(2)
+-- r-n Enumeration thresholdStatus(3)
+-- r-n OctetString thresholdText(4)

+--conditions(3)

+--conditionsEntry(1) [conditionsIndex]
I
+-- rwn Integer32 conditionsIndex(1)
+-- r-n Integer32 conditionsValue(2)
+-- r-n Counter conditionsEventCount(3)
+-- r-n OctetString conditionsText(4)

+--paradiseDeviceA(2)
+--paradiseDeviceB(3)
+--paradiseDeviceC(4)

+--modem(5)

Description of MIB Entities
devicelNFO - This field includes general device information.

devicelD - Octet string type; maximum length -60; field specifies device model and serial number; read only access; OID
-1.3.6.1.4.1.20712.1.1

deviceLocation - Octet string type; maximum length 60; filed allow customer to store information about device physical
location or any other textual information related to the device; read/write access; OID -1.3.6.1.4.1.20712.1.2

deviceRevision - Octet string type; maximum length 60; field specifies device firmware revision; read only access; OID
-1.3.6.1.4.1.20712.1.3

deviceType - Enumeration, integer type; field allows simple detection of SNMP device type. Values: rmsspa(1), cosspa(2),
rcp2fpre(3), rep21000rm(4), rep21000co(5), rep21000rcp(6), buc(7), rbe(8), minicosspa(9); read/write access. Setting the ID
to any other value will default type to cosspa. OID -1.3.6.1.4.1.20712.1.4

devices - This field is subdivided into 5 branches: paradiseDevice, paradiseDeviceA, paradiseDeviceB, paradiseDeviceC
and modem. The paradiseDevice branch currently is used for all Paradise Datacom LLC SNMP enabled device except
Modem. See the Evolution Modem manual for specific MIB information for modems. Branches for Device A, B and C are
reserved for future use.

paradiseDevice - Field contents tables hold specific device information: Settings, Thresholds and Conditions. All table
formats follow a common pattern: Index, Value, TextValue. The threshold table has an additional column for parameter
validation. The conditions table has an extra column for event counters.

The Index column provides general table indexing; the Value column presents the current value of the relevant parameter;
the TextValue column provides information about parameter name, measurement units and limits.



Value "1" in the validation column of the thresholds table indicates that relevant parameter is valid under the current system
configuration; value "2" indicates that parameter is invalid or "Not available".

The event counter column of the conditions table indicates how many times a value of a relevant parameter changed its state
since system power-up.

settings - Table contains current device configuration and provides device management. For detailed settings table info for
SNMP device see Table 18 . Read/write access for settingsValue column.

thresholds - Table provides information about device internal limits and subsystems info. For detailed table information refer
to Table 19. Read only access.

conditions - Table contents device fault status information. Read only access. For detailed conditions table info see Table
20.

Table 18: SNMP Detailed Settings

settingindex/ settingTextValue Value OID Description

settingValue

SysMode'1:2=0,1:1=1,
1/INTEGER 1:1PhC1:1=2,Dual1:1=3, 1.3.6.1.4.1.20712.2.1.1.1.2.1 System Operation Mode
SnglSw=4,PhC1:2=5
2/INTEGER SwitchMode'Auto=0, Manual=1 1.3.6.1.4.1.20712.2.1.1.1.2.2 System Switching Mode
3/INTEGER ControlMode'Local=0, Remote=1 1.3.6.1.4.1.20712.2.1.1.1.2.3 System Control Mode
4/INTEGER Reserved'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.4 | Field reserved for factory use
5/INTEGER Priority'Pol1=0,Pol2=1 1.3.6.1.4.1.20712.2.1.1.1.25 Switching Priority
6/INTEGER Protocol'Normal=0, Terminal=1 1.3.6.1.4.1.20712.2.1.1.1.2.6 | Remote Serial Control Protocol
Baud'9600=0,2400=1, .
7/INTEGER 4800=2,19200=3, 38400=4 1.3.6.1.4.1.20712.2.1.1.1.2.7 | Baud Rate of Serial Interface
8/INTEGER NetworkAddress'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.8 Unique Network Address
Interface'RS232=0, Type of Remote Control
9/INTEGER RS485=1 IPNet=2, SNMP=3 1.3.6.1.4.1.20712.2.1.1.1.2.9 Interface
FaultMonitor'SSPA=0, o
10/INTEGER LNA/LNB=1,Both=2, SerCom=3 1.3.6.1.4.1.20712.2.1.1.1.2.10 Type of Fault Monitoring
AuxFaultMonitoring'Off=0, - I
11/INTEGER NonSw=1,NoSwInv=2, Sw=3,Swinv=4 1.3.6.1.4.1.20712.2.1.1.1.2.11 Auxiliary Fault Monitoring
12/INTEGER RFSwitchFaultMajor=0, Alert | 4 36 4 4 1 20712.2.1.1.1.2.12| RF Switch Fault Monitoring
Only=1,Alternate=2
13/INTEGER FaultLatch'Enable=0, Disable=1 1.3.6.1.4.1.20712.2.1.1.1.2.13 Fault Latch
FaultWindow'20%=0, LNB/LNA Current Fault
14/INTEGER 8%=1,12%=2.15%=3 1.3.6.1.4.1.20712.2.1.1.1.2.14 Monitoring Window
FaultLogic'FaultOnLow=0, .
15/INTEGER FaultOnHigh=1 1.3.6.1.4.1.20712.2.1.1.1.2.15| SSPA and Aux Fault Logic
16/INTEGER UserPassword'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.16 User Password
StandbyUnit'Default=0, .
17/INTEGER Unit1=1,Unit2=2, Unit3/combine=3 1.3.6.1.4.1.20712.2.1.1.1.2.17 Unit Standby Select
18/INTEGER Buzzer'On=0,0ff=1 1.3.6.1.4.1.20712.2.1.1.1.2.18 Audible Alarm
19/INTEGER MenuPassword'On=0, Off=1 1.3.6.1.4.1.20712.2.1.1.1.2.19 Menu Password State
HPASysType'Off=0,CO=1, .
20/INTEGER RM=2,Path=3,VBUC=4, 136.1.4.1.20712.24.1.1.220|  1YPe & Optional SSPA
SysX=5,PMAX=6 y
e _ _ Frwd/Reflected Power
21/INTEGER RFPowerUnits'dBm=0, Watts=1 1.3.6.1.4.1.20712.2.1.1.1.2.21 Measurement Units
22/INTEGER Reserved'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.22 | Field reserved for factory use
23/INTEGER LNAPSRange'Low=0, High=1,Max=2 |1.3.6.1.4.1.20712.2.1.1.1.2.23 | LNA PS Output Voltage Range
24/INTEGER StdbyMode'Hot=0,Cold=1 1.3.6.1.4.1.20712.2.1.1.1.2.24 | HPA S“bsysgg?eifa”dby el




SubsystemMute'On=0,
25/INTEGER SR RASUA it 1.3.6.1.4.1.20712.2.1.1.1.2.25 | SSPA Subsystem Mute Control
26/INTEGER | SubsystemAttenuation (dBx10)0..200 | 1.3.6.1.4.1.20712.2.1.1.1.2.26 | SSPA S”bsézﬁrr';f‘“e”“a”o"
SwitchMute'Off=0, . .
27/INTEGER Internars Extomaics Al Onzg | 1:3:6:14.120712.2.1.1.4.2.27 Switch Muting State
28/INTEGER Reserved'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.28 | Field reserved for factory use
29/INTEGER IPAddressByte1'0..255 13.6.1.41.20712.2.1.1.1.2.29| Device 'P(Q%"Brfss Byte1
30/INTEGER IPAddressByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.30|  Device IP Address Byte2
31/INTEGER IPAddressByte3'0..255 1.3.6.1.4.1.20712.2.1.1.12.31|  Device IP Address Byte3
32/INTEGER IPAddressByte4'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.32 | Device IP Address Byte4 (LSB)
, Device Gateway Address
33/INTEGER IPGateWayByte1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.33 AR
34/INTEGER IPGateWayByte2'0..255 13.6.1.4.1.20712.2.1.1.1.2.34| Device Gaéi‘t'gy aliless
35/INTEGER IPGateWayByte30..255 13.6.1.4.1.20712.2.1.1.1.2.35| Device Gaé‘;‘t’;%y Address
q Device Gateway Address
36/INTEGER IPGateWayByte4'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.36 e
37/INTEGER IPSubnetByte1'0..255 1.3.6.1.41.20712.2.1.1.1.2.37| Device S”Z\’}I‘gs'\;'as" Bytet
38/INTEGER IPSubnetByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.38| Device Subnet Mask Byte2
39/INTEGER IPSubnetByte3'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.39| Device Subnet Mask Byte3
40/INTEGER IPSubnetByte4'0..255 1.3.6.1.41.20712.2.1.1.1.2.40| Device S“%r_‘gtB'\)"aSk B
Device Port Address Byte1
41/INTEGER IPPortByte1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.41 | (MSB) (required only for IPNet
Interface)
Device Port Address Byte2
42/INTEGER IPPortByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.42| (LSB) (required only for IPNet
Interface)
Device IP Lock Address Byte1
43/INTEGER IPLockByte1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.43 | (MSB) (required only for IPNet
Interface)
Device IP Lock Address Byte2
44/INTEGER IPLockByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.44|  (required only for [PNet
Interface)
Device IP Lock Address Byte3
45/INTEGER IPLockByte3'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.45|  (required only for [PNet
Interface)
Device IP Lock Address Byte4
46/INTEGER IPLockByte4'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.46| (LSB) (required only for IPNet
Interface)
47/INTEGER Unit_Offset1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.47 | SSPA Unit 1 Attenuation Offset
48/INTEGER Unit_Offset2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.48 | SSPA Unit 2 Attenuation Offset
49/INTEGER Unit_Offset3'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.49 | SSPA Unit 3 Attenuation Offset

thresholdindex/
thresholdValue

Table 19: SNMP Detailed Thresholds

thresholdTextValue

Value OID

Description

LNA1CalibrationPoint LNA1 Current Fault
1/INTEGER (x0.57mA)0..4095 1.3.6.1.4.1.20712.2.1.2.1.21 Threshold

LNA2CalibrationPoint LNA2 Current Fault
2/INTEGER (x0.57mA)0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.2 Threshold




LNA3CalibrationPoint LNA3 Current Fault
3/INTEGER (x0.57mA)0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.3 Threshold
LNA1DCCurrent
4/INTEGER (x0.57mA)0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.4 | LNA1 PS Output Current
LNA2DCCurrent
5/INTEGER (x0.57mA)0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.5 | LNA2 PS Output Current
LNA3DCCurrent
6/INTEGER (x0.57mA)0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.6 | LNA3 PS Output Current
7/INTEGER LNA1PSVoltage (x0.1V)'0..4095 | 1.3.6.1.4.1.20712.2.1.2.1.2.7 | LNA1 PS Output Voltage
8/INTEGER LNA2PSVoltage (x0.1V)'0..4095 | 1.3.6.1.4.1.20712.2.1.2.1.2.8 | LNA2 PS Output Voltage
9/INTEGER LNA3PSVoltage (x0.1V)'0..4095 | 1.3.6.1.4.1.20712.2.1.2.1.2.9 | LNA3 PS Output Voltage
10/INTEGER PS1Voltage (x0.1V)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.10 PS1 Output Voltage
11/INTEGER PS2Voltage (x0.1V)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.11 PS2 Output Voltage
12/INTEGER ChassyTemperature (C)-99..99 | 1.3.6.1.4.1.20712.2.1.2.1.2.12| Chassis Temperature

Table 20: SNMP Detailed Conditions

conditionindex/

conditionValue Value OID

conditionTextValue

1/INTEGER Unit1 FaultState'NoFault=0,Fault=1,N/A=2 1.3.6.1.4.1.20712.2.1.3.1.2.1
2/INTEGER Unit2FaultState'NoFault=0,Fault=1,N/A=2 13.6.1.4.1.20712.2.1.3.1.2.2

3/INTEGER Unit3FaultState'NoFault=0,Fault=1,N/A=2 13.6.1.4.1.20712.2.1.3.1.2.3

4/INTEGER SummaryFaultState'NoFault=0,Fault=1 1.3.6.1.4.1.20712.2.1.3.1.2.4

5/INTEGER PS1FaultState'NoFault=0,Fault=1 13.6.1.4.1.20712.2.1.3.1.2.5

6/INTEGER PS2FaultState'NoFault=0,Fault=1 13.6.1.4.1.20712.2.1.3.1.2.6

7/INTEGER AuxiliaryFaultState'NoFault=0, Fault=1,N/A=2 13.6.1.4.1.20712.2.1.3.1.2.7

8/INTEGER ExternalPortState'0..255 13.6.1.4.1.20712.2.1.3.1.2.8

9/INTEGER LNAFaults'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.9

10/INTEGER SSPAFaults'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.10
11/INTEGER Fa NI poa s Posaza 13.6.1.4.1.20712.2.1.3.1.2.11
12/INTEGER . i,iﬂ”fﬁ/ﬁ%t?ﬁﬂ‘l@?éﬁg; . 1.3.6.1.4.1.20712.2.1.3.1.2.12
13/INTEGER ForwardRFLowByte(OxHLx0. 1RFPowerUnits)0..255 | 1.3.6.1.4.1.20712.2.1.3.1.2.13
14/INTEGER ForwardRFHighByte(OxHLx0. 1RFPowerUnits)0..255 | 1.3.6.1.4.1.20712.2.1.3.1.2.14
15/INTEGER AmbientTemperatureLowByte(OxHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.15
16/INTEGER AmbientTemperatureHighByte(OxHL C)0..255 1.3.6.1.4.1.20712.2.1.3.1.2.16
17/INTEGER Unit1 TemperatureLowByte(OxHL C)0..255 13.6.1.4.1.20712.2.1.3.1.2.17
18/INTEGER Unit1 TemperatureHighByte(OxHL C)0..255 1.3.6.1.4.1.20712.2.1.3.1.2.18
19/INTEGER Unit2TemperatureLowByte(OxHL C)0..255 1.3.6.1.4.1.20712.2.1.3.1.2.19
20/INTEGER Unit2TemperatureHighByte(OxHL C)0..255 1.3.6.1.4.1.20712.2.1.3.1.2.20
21/INTEGER Unit3TemperatureLowByte(OxHL C)0..255 13.6.1.4.1.20712.2.1.3.1.2.21
22/INTEGER Unit3TemperatureHighByte(OxHL C)0..255 1.3.6.1.4.1.20712.2.1.3.1.2.22
23/INTEGER ReflectedRFLowByte(0xHLx 0.1EFPowerUnits)0..255 | 1.3.6.1.4.1.20712.2.1.3.1.2.23
24/INTEGER ReflectedRFHighByte(OxHLx 0.1EFPowerUnits)0..255 | 1.3.6.1.4.1.20712.2.1.3.1.2.24
25/INTEGER Unit1DCCurrentLowByte(OxHLx 0.1Amper)0..255 | 1.3.6.1.4.1.20712.2.1.3.1.2.25
26/INTEGER Unit1DCCurrentHighByte(OxHLx 0.1Amper)0..255 | 1.3.6.1.4.1.20712.2.1.3.1.2.26
27/INTEGER Unit2DCCurrentLowByte(OxHLx 0.1Amper)0.255 | 1.3.6.1.4.1.20712.2.1.3.1.2.27
28/INTEGER Unit2DCCurrentHighByte(OxHLx 0.1Amper)0..255 | 1.3.6.1.4.1.20712.2.1.3.1.2.28




29/INTEGER Unit3DCCurrentLowByte(0OxHLx 0.1Amper)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.29
30/INTEGER Unit3DCCurrentHighByte(0xHLx 0.1Amper)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.30
31/INTEGER Unit1RFOutputLowByte(OxHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.31
32/INTEGER Unit1RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.32
33/INTEGER Unit2RFOutputLowByte(OxHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.33
34/INTEGER Unit2RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.34
35/INTEGER Unit3RFOutputLowByte(OxHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.35
36/INTEGER Unit3RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.36

Configuring RCP2 Unit to Work With SNMP Protocol

Set up the unit IP address. Tap the Home icon to access the main menu; tap the Communication button; tap the IP Setup
button; tap the IP Address button. Enter the desired IP address. The default address of a single controller in a system is
192.168.0.9. Tap the OK button to accept the entered value.

Set up the unit gateway address. Tap the Gateway button; Enter the desitred IP address of the gateway. The default gateway
address of a single controller in a system is 192.168.0.1. If no gateway is needed, set the address to 0.0.0.0. Tap the OK
button to accept the entered value.

Set up the unit subnet mask. Tap the Subnet Mask button; Enter the desired Subnet Mask address. The default subnet mask
address of a single controller in a system is 255.255.255.0. Tap the OK button to accept the entered value.

Set up the unit Community Get string. Tap the Home icon to return to the main menu; tap the Communication button; tap the
SNMP Setup button. Tap the Community Get button; use the keypad to enter the desired Community Get string. The default
string is public. Tap the OK button to accept the entered value.

Set up the unit Community Set string. Tap the Community Set button; use the keypad to entered the desired Community Set
string. The default string is private. Tap the OK button to accept the entered value.

Set up the unit interface to communicate over SNMP. Tap the Home icon to return to the main menu; tap the Communication
button; tap the Interface button; tick the SNMP checkbox.

SNMP protocol now is set and ready to be used.

Connecting to a MIB Browser

For a MIB browser application example, we will use the freeware browser Getlf, version 2.3.1. Other browsers are available
for download from http://www.snmplink.org.

Copy the provided Paradise Datacom LLC MIB file into the Getif Mibs subfolder. The MIB is available for download at
http://www.paradisedata.com.

Start the Getlf application.

Select the unit IP address and community strings in the relevant text boxes on the Parameters tab (see Figure 16) and then
click the Start button.

[ Getif [10.100.50.9] =10 x|
P | interfaces | Add | Routing Table | Ap | Gen. Table | Reachabilty | Traceroute | NSLookup | Ip discovery | MBrowser | Graph |
Host name 10.100.50.9 v | [ SNMP Parameters
Read 1 IPubhc Timeout (ms) Igggg SNMP Port 161

DNS name  [<not in DNS>

IPAddress  [10.100.50.9 Wiite |Public| Retries [3
SysName |<none> IfNumber <none>
SysContact I<m> SysServices [¢none> B

SysLocation I(mne)

SysDeser <none>

SysObjectlD |<mne>

SysUpTime I"‘°"°>

Configuration

Set as default | Load default Factory settings Telnet
Telnet application Ilelnel exe Browse .

Iﬁeady I I Start I Exit
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Figure 16: Enter Parameters into GetIF
Select the MIBBrowser tab.
Click on 'iso main entity' on the MIB tree, then click the Start button.

See update data in output data box (Figure 17).
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Figure 17: Update Data in MBrowser

The controller is equipped with a DigitalCore5 control board and utilizes firmware version 6.00 and above. These units
feature an extended SNMP MIB and support SNMP traps. This extended MIB covers several OID objects related to SNMP
trap functions.

These units allow independent functioning of two SNMP traps (asynchronous notifications): Fault trap and Conditions trap.
Both traps can be enabled or disabled by the operator. The operator can also specify how many times the same trap
notification will be sent back to the SNMP manager.

The SNMP manager IP address is also selectable by the operator. This IP address must be specified in the relevant OID
branch.

Every trap message is marked by the fixed trap community string "trap”. This community name is not user selectable.

Fault Trap

The Fault trap allows asynchronous notification of the RCP2 fault state change. When enabled, trap notification will be sent
to a manager every time either the summary fault state or a fault type is changed.

The Last Fault Time ticks counter will be reset each time the summary fault changes its state to "Alarm” or when a new fault
condition is detected. This counter also resets itself during device power-up. If no faults are present after device power-up,
Fault Trap will issue a "Cold Start" notification to the manager.

Condition Trap

The Condition Trap allows the unit to generate asynchronous notifications independent from the unit fault state. Currently, the
following conditions can be used for this trap triggering: Forward RF Level (each remotely controlled HPA or System RF level
can be selected), Reflected RF Level (for systems equipped with a Reflected RF sensor), DC Current level (each remotely
controlled HPA can be selected), PS Voltage level (both internal PS units can be selected), Temperature (each remotely
control HPA can be selected or Ambient temperature sensor, if equipped), or LNA/LNB current.

To enable this trap, set the Condition Trap Resend option to a non-zero value and determine the upper and lower limits for
the condition window. Window values must be selected according to the relevant selected condition measured by the unit.

For example: Temperature must be selected in degrees, RF power in tenth of dBms, etc. After successful configuration, the
controller will generate a notification every time the selected condition is outside the selected measurement window. For
units with multiple measured parameters, the relevant condition location must be selected (i.e., units with two power supplies
use 1 for PS1, and 2 for PS2).

For other conditions, this value is "don't care". Both traps will send a "Device Up Time" time stamp with every trap
notification.

Extended SNMP MIB Tree
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--paradiseDatacom(1.3.6.1.4.1.20712)

+--deviceINFO((1.3.6.1.4.1.20712.1)

+-- r-n OctetString deviceID(1.3.6.1.4.1.20712.1.1)

+-- rwn OctetString devicelocation(1.3.6.1.4.1.20712.1.2)
+-- r-n OctetString deviceRevision(1.3.6.1.4.1.20712.1.3)
+-- r-n Enumeration deviceType(1.3.6.1.4.1.20712.1.4)
+--deviceTimeTicks(1.3.6.1.4.1.20712.1.5)

+-- r-n TimeTicks deviceUpTime(1.3.6.1.4.1.20712.1.5.1)
+-- r-n TimeTicks deviceFaultTime(1.3.6.1.4.1.20712.1.5.2)

+--deviceCounters(1.3.6.1.4.1.20712.1.6)

+-- r-n Counter deviceSFaultCounter(1)

+--deviceFaultState(1.3.6.1.4.1.20712.1.7)
I

+-- r-n Enumeration deviceSummaryFault(1)
+-- r-n Enumeration devicelastFault(2)

+--deviceTrapedCondition(1.3.6.1.4.1.20712.1.8)
+-- r-n Integer32 deviceTrappedConditionValue(1)
+--deviceTrapControl(1.3.6.1.4.1.20712.1.9)

+-- rwn IpAddress deviceManagerIP(1)

+-- rwn Integer32 deviceFaultsTrapResend(2)

+-- rwn Integer32 deviceConditionTrapResend(3)
+-- rwn Enumeration deviceConditionToMonitor(4)
+-- rwn Integer32 deviceConditionULimit(5)

+-- rwn Integer32 deviceConditionLLimit(6)

+-- rwn Integer32 deviceConditionLocation(7)

+--deviceTraps(1.3.6.1.4.1.20712.1.10)

+-- (1.3.6.1.4.1.20712.1.10.0)

+--deviceFaultsTrap(1.3.6.1.4.1.20712.1.10.0.11)
[deviceUpTime,deviceSummaryFault,devicelLastFault]

+--deviceConditionTrap(1.3.6.1.4.1.20712.1.10.0.12)
[deviceUpTime,deviceConditionToMonitor,deviceTrappedConditionValue]
+--devices(2)

I

+--paradiseDevice(1)
+--settings(1)
I

+--settingsEntry(1) [settingIndex]

I

+-- rwn Integer32 settingIndex(1)

+-- rwn Integer32 settingValue(2)

+-- r-n OctetString settingTextValue(3)

+--thresholds(2)

I
+--thresholdsEntry(1) [thresholdIndex]
+-- rwn Integer32 thresholdIndex(1)
+-- r-n Integer32 thresholdValue(2)

+-- r-n Enumeration thresholdStatus(3)
+-- r-n OctetString thresholdText(4)

+--conditions(3)

+--conditionsEntry (1) [conditionsIndex]

+-- rwn Integer32 conditionsIndex(1)

+-- r-n Integer32 conditionsValue(2)
+-- r-n Counter conditionsEventCount(3)
+-- r-n OctetString conditionsText(4)

+--paradiseDeviceA(2)

+--paradiseDeviceB(3)

+--paradiseDeviceC(4)



+--modem(5)

Extended SNMP MIB Tree Elements in Detail

deviceRevision - Octet string type; maximum length 60; field specifies device firmware revision; read only access; OID
-1.3.6.1.4.1.20712.1.3

deviceUpTime - Device total up time in hundredths of a second; OID - 1.3.6.1.4.1.20712.1.5.1

deviceFaultTime - Time elapsed since last state change of devicelLastFault parameter in hundredths of second; OID -
1.3.6.1.4.1.20712.1.5.2

deviceSFaultCounter - Counts number of Summary alarms since device power up; OID - 1.3.6.1.4.1.20712.1.6.1

deviceSummaryFault - Enumerated value of device last detected fault condition. The following enumerated values are
possible: coldStart(1), overTemp(2), badRegltr(3), lowDCCur(4), aux(5), buc(6), Ina(7), hpa(8), lowFwdRF(9), highRefRF(10),
nPlusOne (11), badPS(12), timeOut(13), other(14), noFaults(15). OID - 1.3.6.1.4.1.20712.1.7 .1

deviceTrappedConditionValue - Condition value trapped by deviceConditionTrap; OID - 1.3.6.1.4.1.20712.1.8.1
deviceManagerlP - Trap recipient IP address; OID - 1.3.6.1.4.1.20712.1.9.1

deviceFaultsTrapResend - Defines how many times deviceFaultsTrap will repeat the message. 0 - Disables trap triggering;
OID - 1.3.6.1.4.1.20712.1.9.2

deviceConditionTrapResend - Defines how many times condition trap will repeat the message. 0 - Disables trap triggering;
OID - 1.3.6.1.4.1.20712.1.9.3

deviceConditionToMonitor - Enumerated value. Object defines which condition to trap. The following enumerations are
possible: fwdRF(1), dcCurrent(2), voltagePS(3), temperature( 4), InaCur(5), refRF(6); OID - 1.3.6.1.4.1.20712.1.9.4

deviceConditionULimit - Conditions upper trap limit. Trap will be sent when the condition exceeds this limit. OID -
1.3.6.1.4.1.20712.1.9.5

deviceConditionLLimit - Conditions lower trap limit. Trap will be sent when condition falls below this limit. OID -
1.3.6.1.4.1.20712.1.9.6

deviceConditionLocation - Parameter specifying condition measuring location in device containing multiple location of the
same type (multiple PS, HPAs, LNAs etc.). Set to 0 for system-wide conditions, 1 .. n for relevant unit. For devices with single
condition location parameter is "don't care", for system wide parameters (System RF power, Ambient temperature etc. select
4).0ID - 1.3.6.1.4.1.20712.1.9.7

deviceFaultsTrap - Trap fires deviceFaultsTrapResend times when devicelLastFault or deviceSummaryFault state changes.
OID - 1.3.6.1.4.1.20712.1.10.0.11
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Ethernet Interface Quick Set-Up

This section describes the procedure for setting up the RM SSPA Ethernet IP interface through the front panel interface. It
also describes basic network setup of a Windows-based host PC for a peer-to-peer network connection with the RM SSPA.

M Important! Do not use a crossover cable to connect to the network hub, use crossover only for direct PC-
to-RM SSPA connection!

Using a crossover null-modem network cable, connect the Ethernet Port (J9) of the RM SSPA to a host PC. See the 10/100
Base-T Ethernet Cable Wiring section for wiring details.

If the PC NIC card has not previously been set, do so now using the following procedure; otherwise skip to the Configure
Unit to Use IPNET Protocol section.

& Note: For PCs running earlier versions of Windows, go to the Control panel and open the Network
settings and open the TCP/IP properties of your LAN card. Pick up the procedure with Step 8.

1. On a PC running Windows 10, click on the Start icon.
2. Type "Settings" and open the Settings window.
3. Click on the Network & Internet icon.
4. Click Ethernet.
5. Click Change Adapter Options.
6. Right-click on the connection that you want to configure and select Properties from the menu.
7. Select Internet Protocol Version 4 (TCP/IPv4) and click on the Properties button.
8. Select "Use the following IP Address" and enter the parameters shown in Figure 1 in the IP Address and Subnet
Mask fields.
Internet Protocel Version 4 (TCP/1Pv4) Properties *
General
‘You can get IP settings assigned automatically if your network supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IF settings.
(C) Obtain an IP address automatically
(®) Use the following IP address:
IF address: 192 . 168. 0 . 3
Submet mesk
Obtain DMS server address automatically
(®) Use the following DNS server addresses:
Preferred DNS server: l:l
Alternate DNS server: l:l
[Jvalidate settings upon exit e
cance
Figure 1: TCP/IPv4 Properties Window
IP Address.....:192.168.0.3
Subnet Mask.....:255.255.255.0

After you press "OK", depending on the operating system, you may need to reboot the workstation.

After optional reboot, open the Command Prompt console window and enter:



C:\>IPCONFIG

This will display the IP settings:

@ Ethernet Adapter:

IP Address: 192.168.0.3
Subnet Mask: 255.255.255.0
Default Gateway:

You can now try to Ping your PC. In Command Prompt window enter the following:

C:\>ping 192.168.0.3

This will display:

Pinging 192.168.0.3 with 32 bytes of data:

Reply from 192.168.0.3: bytes=32 time < 10ms TTL=128

Reply from 192.168.0.3: bytes=32 time < 1@ms TTL=128

Reply from 192.168.0.3: bytes=32 time < 1@ms TTL=128

Reply from 192.168.0.3: bytes=32 time < 1@ms TTL=128

Ping statistics for 192.168.0.3:
Packets: Sent=4, Received=4, Lost=0 (0%loss),
Approximate round trip times I milli-seconds:
Minimum=@ms, Maximum=Oms, Average=0ms

Your network LAN card is now set up.



Configure Unit to Use IPNET Protocol

Use the following procedure to configure your unit to operate using the IPNET protocol.

1. On the RM SSPA unit front panel, tap the Home icon to return to the Main Menu;
2. Tap the Communications button;

3. Tap the IP Setup button;

4. Tap the IP Address button;

5. Enter IP address 192.168.0.0;

6. Tap the OK button to accept the entered values.

Follow the same menu route to select the Subnet, Gateway, IP Port and IP Lock items, and set those parameters to:

Subnet:255.255.255.0;
Gateway:0.0.0.0;
IPLock:255.255.255.255;
IPPort:1038.

Verify that the values entered above are displayed in the Communications > IP Setup menu.

1. On the RM SSPA unit front panel, tap the Home icon to return to the Main Menu;
2. Tap the Communications button;

3. Tap the Interface button;

4. Tick the IPNET checkbox.

The RM SSPA is now set up to work with Ethernet Interface. You may now ping the SSPA unit from host PC:
C:\>ping 192.168.0.0
This will display:

Pinging 192.168.0.0 with 32 bytes of data:

Reply from 192.168.0.0: bytes=32 time < 1@ms TTL=128

Reply from 192.168.0.0: bytes=32 time < 1@ms TTL=128

Reply from 192.168.0.0: bytes=32 time < 10ms TTL=128

Reply from 192.168.0.0: bytes=32 time < 10ms TTL=128

Ping statistics for 192.168.0.3:
Packets: Sent=4, Received=4, Lost=0 (0%loss),
Approximate round trip times I milli-seconds:
Minimum=@ms, Maximum=Oms, Average=0ms

Run the Paradise Datacom Universal M&C software on a host PC to check all M&C functions. When prompted, select an
Internet connection to the unit using IP Address 192.168.0.0, local port address to 1039 and remote port address to 1038.
The SSPA now connected to your host workstation for remote M&C.



10/100 Base-T Ethernet Cable Wiring

This section briefly describes the basic theory related to the physical layer of 10/100Bas-T networking, as well as proper
wiring techniques.

There are several classifications of cable used for twisted-pair networks. Recommended cable for all new installations is
Category 5 (or CAT 5). CAT 5 cable has four twisted pairs of wire for a total of eight individually insulated wires. Each pair is
color coded with one wire having a solid color (blue, orange, green, or brown) twisted around a second wire with a white
background and a stripe of the same color. The solid colors may have a white stripe in some cables. Cable colors are
commonly described using the background color followed by the color of the stripe; e.g., white-orange is a cable with a white
background and an orange stripe.

The straight through and crossover patch cables are terminated with CAT 5 RJ-45 modular plugs. RJ-45 plugs are similar to
those you'll see on the end of your telephone cable except they have eight versus four or six contacts on the end of the plug
and they are about twice as big. Make sure they are rated for CAT 5 wiring. (RJ means "Registered Jack"). A special Modular
Plug Crimping Tool (such as that shown in Figure 2) is needed for proper wiring.

Figure 2: Modular Plug Crimping Tool

The 10BASE-T and 100BASE-TX Ethernets consist of two transmission lines. Each transmission line is a pair of twisted
wires. One pair receives data signals and the other pair transmits data signals. A balanced line driver or transmitter is at one
end of one of these lines and a line receiver is at the other end. A simplified schematic for one of these lines and its
transmitter and receiver is shown in Figure 3.

G A el O

Figure 3: Transmission Line

The main concern is the transient magnetic fields which surrounds the wires and the magnetic fields generated externally by
the other transmission lines in the cable, other network cables, electric motors, fluorescent lights, telephone and electric
lines, lightning, etc. This is known as noise. Magnetic fields induce their own pulses in a transmission line, which may literally
bury the Ethernet pulses.

The twisted-pair Ethernet employs two principle means for combating noise. The first is the use of balanced transmitters and
receivers. A signal pulse actually consists of two simultaneous pulses relative to ground: a negative pulse on one line and a
positive pulse on the other. The receiver detects the total difference between these two pulses. Since a pulse of noise
(shown in red in the diagram) usually produces pulses of the same polarity on both lines one pulse is essentially canceled by
out the other at the receiver. In addition, the magnetic field surrounding one wire from a signal pulse is a mirror of the one on
the other wire. At a very short distance from the two wires, the magnetic fields are opposite and have a tendency to cancel
the effect of each other. This reduces the line's impact on the other pair of wires and the rest of the world.

The second and the primary means of reducing cross-talk between the pairs in the cable, is the double helix configuration
produced by twisting the wires together. This configuration produces symmetrical (identical) noise signals in each wire.
Ideally, their difference, as detected at the receiver, is zero. In actuality, it is much reduced.

Pin-out diagrams of the two types of UTP Ethernet cables are shown in Figure 4.

PC STRAIGHT-THRU HUB PC CROSSOVER PC

X+ (1) D) RX+ TX+(D (1) TX+
- @) @ RX- TX-@ o~ 2) TX-
RX+(3) 3) TX+ RX+(3) (3) RX+
RX- (6) (6) TX- RX- (6 (6) RX-

Figure 4: Ethernet Cable Pin-outs



Note that the TX (transmitter) pins are connected to corresponding RX (receiver) pins, plus to plus and minus to minus. Use

a crossover cable to connect units with identical interfaces. If you use a straight-through cable, one of the two units must, in
effect, perform the crossover function.

Two wire color-code standards apply: EIA/TIA 568A and EIA/TIA 568B. The codes are commonly depicted with RJ-45 jacks
as shown in Figure 5.

If we apply the 568A color code and show all eight wires, our pin-out looks like Figure 6.

Orange

Green

Pair 2 Pair3

Green | Blue |Brown
Pair 3 | Pair1 | Paird4
~ ~ ~—

Orange| Blue |Brown
Pair 2 | Pair1 | Pair4
— —~— ~—

RJ45 JACK RJ-45 JACK
EIA/TIA 568A STANDARD EIA/TIA 5688 STANDARD

Figure 5: Ethernet Wire Color Code Standards
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RX+ 3 € —— )3 TX+ RX+3 ¢

4 I 4 4 4
5 e 1 5 5 5
RX- 6 I 6 TX- RX- 6 6 RX-
7€ — )7 ik —— )7

§ IS § § s 8

Figure 6: Wiring Using 568A Color Codes

Note that pins 4, 5, 7, and 8 and the blue and brown pairs are not used in either standard. Quite contrary to what you may
read elsewhere, these pins and wires are not used or required to implement 100BASE-TX duplexing.

There are only two unique cable ends in the preceding diagrams, they correspond to the 568A and 568B RJ-45 jacks and
are shown in Figure 7.

White-Green
Green
White-Orange
Blue
White-Blue
Orange
White-Brown
Brown

White-Orange
Orange
White-Green
Blue
White-Blue
Green
White-Brown
Brown

568B CABLE

Figure 7: Wiring Using 568A and 568B Color Codes

Again, the wires with colored backgrounds may have white stripes and may be denoted that way in diagrams found
elsewhere. For example, the green wire may be labeled Green-White. The background color is always specified first.

To properly configure the cables, all you need to remember are the diagrams for the two cable ends and the following rules:

« A straight-thru cable has identical ends.
o A crossover cable has different ends.



It makes no functional difference which standard you use for a straight-thru cable. You can start a crossover cable with either
standard as long as the other end is the other standard. It makes no functional difference which end is which. A 568A patch
cable will work in a network with 568B wiring and a 568B patch cable will work in a 568A network.

Here are some essential cabling rules:

« Try to avoid running cables parallel to power cables.

¢ Do not bend cables to less than four times the diameter of the cable.

« If you bundle a group of cables together with cable ties (zip ties), do not over-cinch them. It's okay to snug them
together firmly; but don't tighten them so much that you deform the cables.

* Keep cables away from devices which can introduce noise into them, such as: copy machines, electric heaters,
speakers, printers, TV sets, fluorescent lights, copiers, welding machines, microwave ovens, telephones, fans,
elevators, motors, electric ovens, dryers, washing machines, and shop equipment.

» Avoid stretching UTP cables (tension when pulling cables should not exceed 25 Ibs.).

¢ Do not run UTP cable outside of a building. It presents a very dangerous lightning hazard!

¢ Do not use a stapler to secure UTP cables. Use telephone wire/RG-6 coaxial wire hangers, which are available at
most hardware stores.
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Introduction

This section describes the control of a remote unit using Teledyne Paradise Datacom's free Windows-based Universal
Monitor and Control software.



Download/Install Software

Teledyne Paradise Datacom provides a free version of its Universal Monitor and Control (M&C) Software available for
download from its web site. Install the software on a PC running Windows 7 or later.

Navigate to the Support > Downloads page and click on the latest version of the software to download the zip file.

Unzip the package and run the setup.exe file. This launches the Universal M&C Software installer. Follow the prompts and
agree to the license agreement to install the application. When complete, close the installer.

Ay By default the installer saves the software to C:\Program Files (x86)\Paradise Datacom. When running
the installer, you can change the destination of the installation.

The software may be used to remotely monitor and control any of the following Teledyne Paradise Datacom products:
* Rack mountable (RM) Amplifiers (3RU, 5RU, 7RU)

» Compact Outdoor (CO) Amplifiers

» High Power Outdoor (HPO) Amplifiers

* Indoor PowerMAX Amplifier Systems

» Outdoor PowerMAX Amplifier Systems

» System Controllers
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Add RM Unit to Universal M&C

Launch the Teledyne Paradise Datacom Universal M&C software from the Programs Menu of your PC. During installation, a
shortcut to the software may have been added to your desktop.

To add a new rack mountable amplifier, click the 'Action' menu and select 'Add Unit' from the pull-down menu. Select
'Rackmount' from the menu choices. See Figure 1.

Universal Monitor and Control
File Action About

[ Add Unit > Compact Outdoor SSPA
Remove Unit Mini Compact Outdoor SSPA
High Power Outdoor SSPA

EENIERPETY]

Very Quick Polling
Rackmount

Logging... Weatherproof

Outdoor PowerMAX Controller Box

Controller

Preferences...

Maintenance Switch Controller

3100 VSAT BUC

vBUC

Internal Redundant System >
N+1 System

RF Detector Box

PLO BUC

Figure 1: Universal M&C > Action > Add Unit > Rackmount
An 'Add Rackmount SSPA' dialog window will appear.
Enter a Unit ID (not required although it is recommended). If a Unit ID isn't entered the Unit ID will be assigned by the M&C.

To add a unit connected to a serial port you must supply a Port and a Baud Rate. See Figure 2.

[& Add Rackmount SSPA - a X

" Serial Connection " Internet Connection o SNMP

Serial Port
Select a port v
Baud Rate
Baud 9600 v

AmplifierAddress

1 E|:
Search for Unit

Log File Location (REQUIRED) Browse...

C:Wonitor Logs

Searching while connected to multiple units is not recommended.

Create | Cancel |

Figure 2: Select a COM Port and Baud Rate for Serial COMs

To add a unit connected via UDP (TCP/IP) you must supply either a Hostname or an IP Address. See Figure 3.
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[& Add Rackmount SSPA - a X

" Serial Connection (% Internet Connection o SNMP

IP Address

10.100.225.49

Port
10073:

AmplifierAddress

1 E]:
Search for Unit

Log File Location (REQUIRED) Browse...

C:Wonitor Logs

Searching while connected to multiple units is not recommended.

Create | Cancel |

Figure 3: Enter IP Address and Port Address for UDP COMs

Specify the Unit's unique address in the Amplifier Address box. If you don't know the address of the unit you may search for
it. Be aware that this search feature is only useful when you have only one unit connected to your PC at a time.

Choose a log file location by clicking the 'Browse..." button. The default is the "My Documents" folder. The log file name will
be the UnitID and the extension ".log" appended to it. i.e. "Unit1.log".

Click on the 'Create' button to connect to the unit. The Universal M&C software will open a new window from which you can
control and review the status of the connected unit.
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Overview of RM SSPA M&C

Each SSPA in the Rackmount M&C has six screens:
« Status Tab

 Settings Tab

» Faults Tab

* |P Setup Tab

* N+1 Settings Tab

SNMP Tab

Status Tab

The first screen is the "Status" tab, shown in Figure 4. The Status tab shows the current conditions (or state) of the
connected SSPA. In addition, the Status tab allows the operator to change the Mute state of the carrier and allows
adjustment of the on-board attenuator for gain control.

Universal Menitor and Control - m] X
File Action About
=l |5 €} Devices Unit 1
s
a Status | settings | Fauits | 1P Setup | N +1 | s |
; e unitio [ U1 ]
[ Unit1 ]
) RX @ n L] SSPAType One_Module
- Device Type | Rackmount SSPA IP Address 10.100.225.49
Carrier Enable
@ Model Number HPAC2400AR Unit Address
— Serial Number 123456 VOBoardRevision [ 0 |
00 = Firmware Version Ver 659 Digital Core Board
Forward RF Power (dBm) SSPA Core SSPADC Current
Temperature
¥
PN P ¢ s T e
54 56 53 60 62 60__ Main Supply Voltage 1 Booster Supply Voltage 1
55— 1012 14 4.6
| 3 ms m
Reverse RF Power (dBm) £ 0 L 10
Main Supply Voltage 2 Booster Supply Voltage 2
45 10_12 14 4 6
&6:*_«1&6)1)2 BTy 2T
{ 0L, \10
Query Count: 550 Connected 4

Figure 4: Universal M&C Software > Status Tab

Settings Tab

The second screen is the "Settings" tab, shown in Figure 5. It shows the user all available settings on the SSPA. All user-
adjustable settings are allowed to be modified to suit the specific needs of the customer. However, it should be noted that the
SSPA is configured for the customer at the factory.

If modification of any settings is necessary, details of each setting, condition and threshold are available in the Settings,
Conditions and Thresholds description of the Remote Control Protocol section of any rack mountable amplifier manual.
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Figure 5: Universal M&C Software > Settings Tab
Operation Mode [1]

Select between Standalone Mode, (single unit), 1:1 Mode, 1:2 Mode, 1:1 Phase Combined or 1:2 Phase Combined.

If the amplifier will be configured in a redundant system and controlled with an external controller, each system amplifier
should be set to Standalone Mode.

If the amplifier will be configured in a redundant system but will be controlled using internal control logic, each system
amplifier should be set to the appropriate redundant mode. All amplifiers in the redundant system should be set to the same
mode.

For more information on settings used for internal 1:1 redundancy mode, see the Internal 1:1 Redundant System
Operation section.

For more information on settings used for internal 1:2 redundancy mode, see the Internal 1:2 Redundant System
Operation section.

Switch Mode [2]
Select between Automatic switching, Manual switching or Switch Lock.
Control Mode [3]

Select between Local or Remote control.

Fan Speed [4]

Select between Low, High or Auto.

Mute Enable [5]

Select Muted or Unmuted.

Protocol Select [6]

Select Normal or Terminal. The operator will be asked to verify any to change to the Protocol Select setting. Communication
with the amplifier may be affected.

Baud Rate [7]
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Select a baud rate of 2400, 4800, 9600 (the default), 19200, or 38400. The operator will be asked to verify any to change to
the Baud Rate setting. Communication with the amplifier may be affected.

Serial Interface [8]

Select the type of serial communications interface to use: RS232, RS485, IPNET or SNMP. The operator will be asked to
verify any to change to the Serial Interface setting. Communication with the amplifier may be affected.

Buzzer Enable [9]
Enable or Disable the audible buzzer on the unit.
Standby Mode [10]

Select Hot Standby or Cold Standby. In Cold Standby mode, the RF module is muted when its Standby Select setting is set
to Standby.

HPA Status [11]

Select HPA1, HPA2 or HPAS. For use in redundant systems.

RF Power Units [12]

Select the type of unit displayed on the front panel: dBm or Watts.
Standby Select [13]

Select the disposition of the amplifier in a redundant system: Standby or Online.

SSPA Attenuation [14]

The Gain Adjustment of the unit is adjustable here, from 0 to 20 in 0.1 dB steps.

Amplifier Address [15]

Sets a network address for the unit. Range is 0 to 255. Click the 'Change' button to change the address. The operator will be
asked to verify any to change to the Amplifier Address setting. Communication with the amplifier may be affected.

User Password [16]

Sets a password for the unit. Range is 0 to 255.

Menu Password Protection [17]

Enable or Disable password protection for the unit.

Priority Select [18]

For use in 1:2 Mode only. Assign whether the standby unit will be switched to Pol1 or Pol2 if the amplifiers transmitting to
both polarities exhibit failures and the standby unit must switch to one of the polarities. All units in a 1:2 configuration must
use the same Priority Select setting.

Fault Setups [19]

The user may Enable or Disable fault latching, and set the fault logic and handling for RF Switch faults, Auxiliary faults, BUC
faults, Forward RF faults and High Reverse RF faults. Logic settings are Logic Low or Logic High.

RF Switch Fault Handling settings include Ignore, Minor Fault, Major Fault, and Switchover Mute.
Auxiliary Fault Handling settings include Ignore, Minor Fault, Major Fault, Minor Fault with Mute, and Major Fault with Mute.

Forward RF Fault Handling settings include Ignore, Low RF Major Fault, Low RF Minor Fault, ALC On, High RF Major Fault,
High RF Minor Fault, and High RF Major Fault with Mute.

High Reverse RF Fault Handling settings include Ignore, Major Fault, and Minor Fault.

The user can also set the threshold levels for Forward RF and High Reverse RF.

Faults Tab



The third screen is the "Faults" tab, shown in Figure 6. It shows the user the status of all faults on-board the SSPA. These
include: Summary, Module # faults, Standby State (green = Online; red = Standby); Power Supply, Low DC Voltage and
Current, Fans, BUC, High Temperature, Forward RF and High Reflected RF, Auxiliary, switch faults (for units configured in a
redundant system), and optional faults.
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Figure 6: Universal M&C Software > Faults Tab

Each RF Module in the SSPA is monitored for faults in addition to the SSPA itself. If the SSPA does not include a module,
non-existent modules will show up with a status of 'N/A" in the Module Status box, and the indicator will turn yellow.

IP Setup Tab

The fourth screen is the "IP Setup" screen, shown in Figure 7. It displays all of the TCP/IP settings on the SSPA.
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Figure 7: Universal M&C Software > IP Setup Tab

When the IP Address is modified, the SSPA must be reset for it to use the new IP Address. Until the SSPA is reset, it will use
the old IP Address. The Local Port is the port that the SSPA uses for UDP requests. The SSPA also answers requests using
the same port. If the Local Port is changed, the SSPA must be reset.
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The Gateway Address and Subnet Mask are standard settings for TCP/IP communications. If either of these settings is
changed, the SSPA must be reset for the new settings to take effect.

The IP Lock Address is used for security. If it is set to something besides 0.0.0.0 or 255.255.255.255 it will only answer the
address it is set to. For example, if the IP Lock Address is 192.168.0.50, then a request from 192.168.0.100 will not be
accepted. The IP Lock Address may be changed without resetting the SSPA.

N+1 Settings Tab

The fifth window is the "N+1 Settings and Conditions" tab, as shown in Figure 8. This screen is used for setting N + 1 system

parameters, and monitoring N+1 system conditions. Note that only the master module in an N+1 system will show the N+1
Master settings.
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Figure 8: Universal M&C Software > N+1 tab

See the Overview of the PowerMAX M&C section for more information on Master/Slave functions using the N+1 Settings
Tab.

SNMP Tab

The sixth window is the "SNMP Settings" tab, as shown in Figure 9. This screen is used for setting SNMP communication
parameters, and for assigning trap conditions.


http://stc-ppapp-web02/Intranet/xml/216594/images/universal-mc-n1-tab.png
http://stc-ppapp-web02/Intranet/xml/216594/images/universal-mc-n1-tab.png

File Action About

321 231A2Q)

Universal Monitor and Control

IUritl |

Status | Settings | Fauits | 1P Setup | N +1 {5 |

~Read Community
Current Getting information from unit...

Write Community
Tt Getting information from unit...

Trap Manager IP Address
Number of times to send Fault Trap
Number of times to send Conditions Trap
Selected Conditionto Trap
Conditions Trap Lower Limit
Conditions Trap Upper Limit

Conditions Trap Subset

New [pubiic New fprivate
[V Modify Read Community Change | [V Modify Write Community Change |
—Trap Setup
Description Current Value New Value

0.0.0.0 [ 19216801 Change |
0 lﬂ Change |
0 lﬂ Change |
Not Valid lm Change |
0 m Change |
0 m Change |
0 lﬂ Change |

Query Count: 3105

IConneched

N

Figure 9: Universal M&C Software > SNMP tab
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Add CO Unit to M&C

Launch the Teledyne Paradise Datacom Universal Monitor and Control software from the Programs Menu of your PC. Upon
installation, a shortcut to the software may have been added to your desktop.

Click the 'Action' menu and select 'Add Unit' from the pull-down menu. Select 'Compact Outdoor SSPA' from the menu
choices. See Figure 10.
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Figure 10: Universal M&C > Add Unit > Compact Outdoor SSPA

A new dialog window will open. Enter the following information where applicable: Unit ID; if using a RS-232 Connection, the
Serial Port and Baud Rate. See Figure 11.

Add Compact Outdoor SSPA - o X
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Searching while connected to multiple units is not recommended.

Create Cancel

Figure 11: Add Compact Outdoor SSPA > Serial Connection

If using an Ethernet Connection, enter the unit's IP Address and Port number. See Figure 12.


http://stc-ppapp-web02/Intranet/xml/216594/images/mc-action-add-unit-co.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-action-add-unit-co.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-action-add-unit-co-serial.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-action-add-unit-co-serial.png

Add Compact Outdoor SSPA — O X

Unit ID:/CO SSPA 1

" Serial Connection ' Internet Connection c SNMP

IP Address

192.168.0.9

Port
1007 =%

AmplifierAddress

1 EIC
Search for Unit

Log File Location (REQUIRED) Browse...

C:\WMonitor Logs|

Searching while connected to multiple units is not recommended.

Create Cancel

Figure 12: Add Compact Outdoor SSPA > Internet Connection

Specify the unit's Address in the Amplifier Address box. If you don't know the address of the unit you may search for it. Be
aware that this search feature is only useful when you have only one unit connected to your PC at a time.

If you wish to change the log file location, click on the 'Browse' button and navigate to the desired location.

Click on the 'Create' button to generate the operation window for this unit.
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Overview of the CO M&C

The operational status, settings and conditions of the connected Compact Outdoor amplifier are displayed in the Universal
M&C application's four tabs:

+ Status Tab
 Settings Tab

* [P Setup Tab

* SNMP Settings Tab

Status Tab

The Universal M&C Software will initialize and open to the Status tab, the main monitoring display. See Figure 13. The
Status tab shows the current conditions (or state) of the Compact Outdoor SSPA. In addition, the status screen allow the
user to alter the Mute condition of the carrier and adjust the on-board Attenuator for gain control.
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Figure 13: Compact Outdoor SSPA > Status Tab

Upon connection with a unit, the M&C application obtains and displays the unit ID, the amplifier's model number and serial
number. The SSPA module's firmware version number is also displayed here for convenience.

The unit's network address and serial COM or IP address are also listed, which can be helpful in optimizing serial
communications.

Signal Indicators

Three rows of indicators show the connection status of the connected amplifier. Top-most is an indicator that displays a
green square when Connected, or a red square when Disconnected. Immediately below are two indicators for the TX and RX
paths. The third row displays the mute state (Carrier Enable). The operator may click on the indicator to toggle between
enabling or muting the amplifier. See Figure 14.
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Figure 14: Status Tab > Signal Indicators

Fault Status Indicators

The Fault Status frame in the lower left side of the Status tab contains a 3x4 grid of SSPA fault lights. See Figure 15.
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Figure 15: Status Tab > Fault Status Indicators

Summary Alarm: The Summary Alarm is simply a logical 'OR' of any major alarm indicators.

Unit Online: This is a status indicator that illuminates green when the unit is online.

External Mute Alarm: The External Mute line gives an indication that the SSPA has been externally muted by J4-
Pin B. This alarm can be configured to trigger a summary alarm if desired. Factory default is to signal a External
Mute fault but no summary alarm.

e Auxiliary & Spare Alarms: The Auxiliary and Spare Alarms are configurable from the Settings Window.

These alarms can be configured to trigger a summary alarm. See the Settings Tab section.

Low DC Current Alarm: The Current Fault is factory preset to alarm if the SSPA module current falls below 60% of
its nominal value. This alarm will also trigger a summary alarm.

Low DC Voltage Alarm: The Voltage Alarm is factory preset to alarm if the SSPA module current falls below 80% of
its nominal value. This alarm will also trigger a summary alarm.

High Temperature Alarm: The Temperature Fault indicator is factory preset to alarm at 80°C. The amplifier will
continue to operate up to 90°C. Beyond 90°C the DC power will be interrupted to the SSPA module. This measure
will protect the sensitive microwave transistors from catastrophic failure. The fans and monitor and control circuitry
will continue to operate normally. This function has approximately a 5°C hysteresis window which will allow the
amplifier to re-enable itself when the ambient temperature is reduced by 5°C. This alarm will also trigger a
summary alarm.

Forward RF Alarm: The Forward RF Fault Alarm indicates when the RF output of the amplifier falls below the
threshold set in the Settings Window.

BUC Alarm: The BUC fault is only active in units that are supplied with an optional L-Band Block Up Converter
module. If the Up Converter's phase locked local oscillator loses lock, a BUC alarm is set and the amplifier is
muted so that spurious RF cannot be transmitted. This alarm can be configured to trigger a summary alarm.
EEPROM Alarm: The EEPROM Alarm is primarily used as a Fiber RX Link alarm for Compact Outdoor SSSPA
units configured with a fiber-optic interface.

RF Switch Alarms: The RF Switch 1 Alarm is only active if a 1:1 Redundant System has been configured in the
M&C program. The RF Switch 2 Alarm is only active is a 1:2 Redundant System has been configured. These
configurations are covered in Section 7.

Voltage, Current and Temperature Display

On the right side of the Status window is a thermometer display that reports the present baseplate temperature of the
amplifier. The baseplate temperature typically experiences a 20-30 degree rise above ambient on the highest power
Compact Outdoor amplifiers and 15-20 degree rise on lower power units. See Figure 16.
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Figure 16: Status Tab > Signal Indicators

To the left of the thermometer display are several indicators that show various operating conditions of the Compact Outdoor
Amplifier in real time. These indicators are helpful for any diagnostic procedures and consist of: Power Supply Voltage
monitor SSPA DC Current monitor Regulator Voltage monitor Gate Voltage monitor.

The Power Supply voltage indicator displays the primary 12 volt power supply output. SSPA DC Current is the total current
drawn by the microwave transistors. Regulator Voltage is the DC voltage of the drain circuitry that feeds the GaAs

transistors. The Gate Voltage indicator monitors the DC voltage of the gate circuitry of the microwave GaAs transistors.
These indicators provide direct access to the active device operating characteristics.

Gain Adjustment (Attenuation Control)

The Gain Attenuation Control is located above the Fault Condition Indicators and below the Carrier Enable status. See
Figure 17.

Attenuation

Figure 17: Status Tab > Attenuation Control
The gain can be adjusted by setting the Attenuation Control. An Attenuation Control of 0 dB is the maximum gain (typically
75 dB) setting on the amplifier. By setting the Attenuation Control to 20 dB; the gain is set to 55 dB. The Attenuation Control

can be varied using the up/down arrows to the right of the displayed value or by typing a value between 0 and 20 in the field
and hitting the Enter key.

Forward/Reflected RF Power Display

The Forward RF Power is displayed in the central part of the Operation window. This indicator reports the approximate
forward output power of the amplifier. It uses the voltage from the RF Power Detector to determine a corresponding power
level in dBm. The accuracy of the power indicator is £1 dB at the mid-point of the specified band, with a single CW or QPSK
carrier.

Units with the reflected power meter option also display the Reflected RF Power. See Figure 18.

Forward RF Power
52 dBm

Reflected RF Power
SdBm

Figure 18: Status Tab > Forward/Reflected RF Power Display

Settings Tab

Figure 19 shows the Settings tab of the Universal M&C software. The Settings tab contains many of the global settings that
are available in the SSPA.
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Figure 19: Compact Outdoor SSPA > Settings Tab
The Compact Outdoor amplifier will power up with the "last-state" settings before the unit was powered down. Whatever

attenuation setting or mute state the amplifier was in when powered down will be the restored settings when the amplifier is
powered back on.

Operation Mode [1]

Select between stand-alone (single unit), Dual 1:1 mode, 1:1 Redundant mode, or Maintenance Switch mode.

Hierarchical Address [2]

Identifies each amplifier in a redundant system as HPA 1, HPA2 or HPA 3.
Standby Select [3]

Selects whether the unit should start up as the online amplifier or the standby amplifier. When in a redundant system
configuration, if the amplifier Standby Select state is changed from the Online state to the Standby state, the system will
drive the switch so that another amplifier in the system is in the Online state. Only the Online amplifier can give away its
Online state. This setting is saved upon unit shut-down, and the unit will start up in the last saved state.

Mute State [4]

Determines if the unit should start up muted (transmit disabled) or mute cleared (transmit enabled).

Gain Control [5]

Select between serial communication control of the unit's gain or analog voltage gain control via J4.

Protocol Select [6]

The operator may select either the standard string protocol, Terminal mode, IPNET or SNMP (as well as legacy Binary Mode
and NDSatcom protocols). The operator will be asked to verify any change in protocol. Communication with the amplifier
may be affected.

Baud Rate Select [7]

Sets the baud rate of the unit. The supported baud rates include: 2400, 4800, 9600, 19200, and 38400 baud. The factory
default baud rate is 9600. The operator will be asked to verify any change to the baud rate. Communication with the amplifier
may be affected.
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Standby Mode [8]

Selects between Hot and Cold standby mode for units in redundant systems.

BUC Reference [9]

Selects between an Internal or External reference for an optional block up converter integrated with the unit, or allows the
unit to Auto-switch between Internal and External reference.

Fan Speed [10]

Selected GaN units are equipped with a Fan Speed Control option. The fan speed control circuit is shared with the RF power
detector analog output (pin R on M&C connector J4). This pin remains not connected on units with the fan speed control
option installed. Available control options: Auto, High, Low, Default/Off

¢ Auto - This setting allows the unit to control the cooling fan speed according to the internal RF module
temperature. If the module plate temperature remains below 50 °C, the fan speed will be set to minimum. If the
registered module plate temperature is above 50 °C, unit will gradually increase the fan speed. Fan speed will
reach maximum at a plate temperature of 65 °C.

« High - This option sets the fan speed to maximum. Air velocity will remain at the same level regardless of other
operation parameters.

¢ Low - This option sets the fan speed to minimum. Air velocity will remain at the same level regardless of other

operation parameters.

Default/Off - This setting should be set on units without the fan speed control option. It will allow proper functioning

of the RF power monitor analog output. Applying this setting on units with the fan speed control option allows the

fan speed to be proportional to the output RF level. Fan speed will be set at the minimum when output RF is below

a detectable level. Fan speed will gradually increase when RF output increases within the detectable RF range.

Fan speed will be at maximum level when unit reaches saturated power (Psat).

Gain Calibration Mode [11]

This feature is disabled for most users. Should be set for Temp. Comp. (Temperature Compensation) Mode. Consult the
factory if set for Calibration Mode.

Attenuation Level [12]

L]

The Gain Adjustment of the unit is adjustable here, from 0 to 20 in 0.1 dB steps.

Amplifier Address [13]

Sets a network address for the unit. Range is 0 to 255. Click the 'Change' button to change the address. The operator will be
asked to verify any to change to the Amplifier Network Address. Communication with the amplifier may be affected.

Low Current Fault (Slave) [14]

This feature is not available on all units. Consult the factory.

Switch Mute [15]

This is a read-only view of the Switch Mute setting. Higher power amplifiers which include a maintenance switch or are
configured in a system which includes a transfer switch may be set to mute on switch (setting = On) at the factory.

Spare Fault Wizard [16]

This feature allows the user to set the Spare Fault Trigger using the Spare Fault Wizard.

Click on the Spare Fault Wizard button, which opens a new window. See Figure 20. Select between the following fault
triggers: Analog Gain Adjust Voltage, Gate Voltage, Regulator Voltage, Power Supply Voltage, SSPA Current, External Mute,
or None.
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Figure 20: Spare Fault Wizard

Set the range of thresholds (maximum and minimum) that would trigger the selected fault, and configure the fault handling
via a pull-down menu (Major Fault, Minor Fault, Major Fault plus Mute).

Click the OK button to set the fault trigger for the Spare Fault.
Fault Setups [17]

The user may also adjust the Spare, Auxiliary, BUC, and Forward RF Fault Status and Handling via the appropriate pull-
down menus on the Settings Window.

o Spare/Auxiliary/BUC/Forward RF Fault Handling: Selects whether the associated fault should be a major or minor
fault, and whether the fault should mute the unit. A minor fault will trigger a Spare/Auxiliary/BUC/Forward RF Fault
alarm but not trigger a Summary Fault. A major fault will trigger both an Spare/Auxiliary/BUC/Forward RF Fault and
a Summary Fault.

e Spare/Auxiliary/BUC Fault Status: Determines if the associated fault input should be ignored or enabled based on
the available selections.

¢ Forward RF Threshold: Allows the user to assign the threshold at which a Forward RF Fault will be triggered.

Fault Thresholds [18]

Allows the user to set the limit for triggering the unit's Current Fault or High Temperature Fault.

¢ High Temperature Alarm Threshold: Range is 0 to 125 °C.
e Low Current Fault Threshold: This setting is factory pre-set.

& Take care not to adjust the High Temperature Alarm Threshold within the temperature range of the
amplifier's normal operation. Doing so will trigger unneccessary high temperature alarm faults.

IP Setup Tab

If the user wishes to set up the networked Compact Outdoor SSPA with custom IP settings, the internal IP settings need to
be modified. Click on the IP Setup Tab. See Figure 21.
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Figure 21: Compact Outdoor SSPA > IP Setup Tab

In this window, the user may enter custom IP settings, including the IP Address of the unit, the Gateway Address, the Subnet
Mask and the Local Port.

The IP Lock Address allows the operator to set the IP address from which the amplifier will accept requests. This selection
gives the operator the ability to increase the security measure for the IPNet protocol. The SSPA will only answer a request
which comes from the assigned IP address.

To disable this feature in firmware versions prior to 6.00, set the Lock IP Address value to 0.0.0.0 or 255.255.255.255. The
Lock IP address function was updated in firmware version 6.00 to allow "Binding" and "Masking" functions. "Binding" means
that the first datagram re-trieved for this socket will bind to the source IP address and port number. Once binding has been
set, the SSPA will answer to the bound IP source until the unit is restarted or reset. Without binding, the socket accepts
datagrams from all source IP addresses. Address 0.0.0.0 allows all peers, but provides binding to the first detected IP
source; Address 255.255.255.255 accepts all peers, without binding. If the Lock IP Address is a multicast address, then the
amplifier will accept queries sent from any IP address of the multicast group.

Click on the 'Change IP Settings' button to save the entered settings into non-volatile memory.

The user may also modify the web password used when accessing the web-based remote M&C. Tick the 'Modify Web
Password' checkbox to enable the New Password field. Enter a new password and click on the 'Change' button to save.

Using Custom IP Settings with Quick Start Cable

If the Quick Start Cable is connected to Port J4 when power is applied to the amplifier, it will use the default settings.

Default Settings with Quick Start Cable Connected:

Interface: IPNET

IP Address: 192.168.0.9
Local Port: 1007

Gateway: 192.18.0.1
Subnet Mask: 255.255.255.0
IP Lock: 255.255.255.255
Web password: paradise
Read Community: public
Write Community: private
Unit Starts Up: Unmuted

To use custom IP settings while using the Quick Start cable, remove power from the amplifier.

Unplug the Quick Start cable from the M&C connector, J4. (If the unit is restarted with the Quick Start cable connected, it will
always come up with default IP settings).
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Connect power to the SSPA.

Connect the Quick Start cable to J4, and check connectivity with the custom IP settings. Make sure that the Protocol setting

in the Settings tab of the Universal M&C is set to IPNet.

If custom IP settings will be used in normal operation, the user will need to construct an IP cable or modify the Quick Start
Cable by disconnecting the interface control pins (pins j and e, Baud Select 0 and Baud Select 1) from ground.

In this configuration, the SSPA will always use the saved communication control settings rather than the default

configuration.

SNMP Settings Tab

The SNMP Settings Tab allows the operator to change the Read/Write Community strings and the Trap settings (if

communicating over SNMP protocol). See Figure 22
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Figure 22: Compact Outdoor SSPA > SNMP Settings Tab

The current Read/Write Community strings are displayed as read from the connected unit. Tick the Modify Read/Write
Community checkbox to enable the New Read/Write Community field. Enter a new password and click on the 'Change'

button to save.
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Add HPO Unit to M&C

Launch the Teledyne Paradise Datacom Universal Monitor and Control software from the Programs Menu of your PC. Upon
installation, a shortcut to the software may have been added to your desktop.

Click the 'Action' menu and select 'Add Unit' from the pull-down menu. Select 'High Power Outdoor SSPA' from the menu
choices. See Figure 23.
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Figure 23: Universal M&C > Add Unit > High Power Outdoor SSPA

A new dialog window will open. Enter the following information where applicable: Unit ID; if using a RS-232 Connection, the
Serial Port and Baud Rate. See Figure 24.
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Figure 24: Add High Power Outdoor SSPA > Serial Connection

If using an Ethernet Connection, enter the unit's IP Address and Port number. See Figure 25.
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Figure 25: Add High Power Outdoor SSPA > Internet Connection

Specify the unit's Address in the Amplifier Address box. If you don't know the address of the unit you may search for it. Be
aware that this search feature is only useful when you have only one unit connected to your PC at a time.

If you wish to change the log file location, click on the 'Browse' button and navigate to the desired location.

Click on the 'Create' button to generate the operation window for this unit.
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Overview of the HPO M&C

The H-Series High Power Outdoor SSPA uses the same protocol as the Compact Outdoor SSPA, and also the same
structure of Universal M&C.

See the Overview of the CO M&C section when using the software with a High Power Outdoor SSPA.



Add Indoor PowerMAX System to M&C

Launch the Teledyne Paradise Datacom Universal M&C software from the Programs Menu of your PC. Upon installation, a
shortcut to the software may have been added to your desktop. An Indoor PowerMAX system requires Universal M&C
version 4.4.8b or later.

Add Each RM SSPA to M&C

Each individual amplifier in the PowerMAX System should first be added to the Universal M&C. Follow the instructions
detailed in the Add RM Unit to Universal M&C section.

PowerMAX systems are typically configured with four, eight or 16 amplifiers.
Set the N+1 Settings for each individual unit to include the Array Size (four, eight or 16) for the PowerMAX System and the

unique Priority Address for each unit. The amplifier assigned with the lowest Priority Address (typically 1) is granted the
Master status for the N+1 system, and controls the other (Slave) amplifiers in the system.

Add PowerMAX System to M&C

To add the PowerMAX System, click the 'Action' menu and select 'Add Unit' from the pull-down menu. Select 'N+1 System'
from the menu choices. See Figure 26.
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Figure 26: Universal M&C > Add Unit > N+1 System

A new 'Add N+1 System' dialog window will appear, as shown in Figure 27. If the individual amplifier N+1 settings were
properly set, the Unit #s should automatically populate in ascending Priority Address order, using the Unit ID entered in the
M&C. Otherwise, select the Unit # for each unit in the system and enter a System Name in the field at the bottom of the
window. Click on the 'OK' button to initialize the system.
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Figure 27: Add N+1 System Selection Window

& The System window may take several moments to load as the software collects and compiles the data
from each unit in the system.
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Overview of the Indoor PowerMAX M&C

The N+1 System tab displays an overview of each unit in the system, and overall system performance. The Universal M&C
screen shown in Figure 28 displays the N+1 system tab (labeled PowerMAX System), as well as tabs for each of the eight
(8) SSPA units (labeled 1, 2, 3, 4, 5, 6, 7 and 8) being monitored.

[" Paradise Datacom LLC Universal M&C Utility M=) X |
File Action About
© 4 Devices 1 2 s |+« |s e |7 |s [ Powermax system
Comms State  Priority Mute  Fault
@ @ Master 1 J °
@ Slave 2 J °
° Slave 3 J °
@ Slave 4 J °
D Slave 5 J °
@ Slave 6 J °
Iu:);? ° Slave 7 J °
;‘;;788 o Slave 8 J °
System Forward Power: 0 dBm System Gain:  60dB Auto Gain
System Reflected Power: 0 dBm System Faults: Three Units

Figure 28: N+1 System Tab

For each unit in the system, the PowerMAX System tab displays the unit's serial number, comms status, master/slave state,
N+1 priority in the system, mute state and fault state.

Also shown are the System Forward Power, Reflected Power, System Gain and number of System Faults. A checkbox at the
lower right of the window allows the user to quickly enable or disable the Auto Gain function. See the Auto Gain description
in the Touchscreen Menu Structure section.

By hovering the mouse over the individual unit buttons, as shown in Figure 29, the unit's conditions are detailed.

[mbe Datacom LLC Universal M&C Utility =) X

File Action About

@ D Master 1 J °
Serial Number: 300071 ) Y
Temperature: 29 C
Summary Alarm: Faulted E ®
Power Supply: Faulted 2 P
Low Forward RF: Ignore
High Reflected RF: Clear
Fan: Clear o °
High Temperature: Clear
Low DC Voltage: Clear v °
Low DC Current: Clear
& Auxiliary: Ignore J °
J °
System Forward Power: 0 dBm System Gain:  60dB Auto Gain
System Reflected Power: 0 dBm System Faults:  Three Units

Figure 29: N+1 System Tab > Unit Info on Hover
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Clicking on the Unit # button to switch to the Status tab for that unit. You may also click on the unit's tab to navigate to the
M&C windows for that unit.

The N+1 tab for each unit shows the N+1 settings for that unit. Depending on whether the unit is assigned Master status or
Slave status, the N+1 screen will show slightly different information. Figure 30 shows the display for the Master unit.

File Action About

< Devices

-
~N
w

4 s | | 7 s PowerMAX System |

| Status | Settings | Fauks | P Setup | N+1 |

[ N + 1 Settings | [ N + 1 Conditions ]

Array Size 8 E N+ 1State Master
Priority Address |1 EI System Faults Three
SSPA Attenuation 6d8
[ N+ 1Master Settings | N +1 System Forward Power
Auto Gain on I 00,8040 20
100/

N + 1 System Gain

58 60 62
56, T B4
N +1 System Reflected Power
0 -60 -40 op
100 0
Connected
Figure 30: N+1 Tab > Master Unit
Figure 31 shows the display for the Slave units.
atacom LLC Universal M&C Ut =Ja 1
File Action About
1 |2 3 « |s |e |7 8 PowerMAX System |
| Status | Settings | Fauks | IP Setup | N+ 1 |
[ N + 1 Settings | | N + 1 Conditions
Array Size s [l N+ 1state Slave
Priority Address |2 v System Faults Disabled
SSPA Attenuation 6dB
[ N+ 1Master Settings |
N + 1 System Gain
6254 66
eoMse
Query Count: 74 Connected

Figure 31: N+1 Tab > Slave Unit
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Add Outdoor PowerMAX System to M&C

The Outdoor SSPA Controllers in an Outdoor PowerMAX system can be monitored by the Universal M&C Application. All
information is read-only.

The operator must load each of the Outdoor SSPA Controllers individually. Refer to Table 1 for the default IP addresses to
use.

Table 1: Outdoor SSPA Controllers, IP Addresses for Universal M&C

Controller ID IP Address

Outdoor SSPA Controller 1 (Master) 192.168.0.11
Outdoor SSPA Controller 2 (Slave) 192.168.0.12

Launch the Teledyne Paradise Datacom Universal Monitor and Control software from the Programs Menu of your PC. Upon
installation, a shortcut to the software may have been added to your desktop.

With the system operating, select the Action pull-down menu, select Add Unit, and select Outdoor PowerMAX Controller Box.
See Figure 32.

@ Universal Monitor and Control

File Action Maintenance and Database About

;3’ Add Unit > Compact Outdoor SSPA
a Remove Unit Mini Compact Outdoor SSPA
3 Very Quick Polling High Power Outdoor SSPA
Rackmount
RIS Weatherproof
Preferences... 5 P P Ser Box
Controller

Maintenance Switch Controller
Figure 32: Universal M&C > Add Unit > Outdoor PowerMAX Controller Box

A new dialog window will open. Select the Internet connection. See Figure 33.

Add Outdoor Controller Box - O X

Unit ID:|Master SSPA 1 |

" Serial Connection % Internet Connection C SNMP

IP Address

192.168.0.11
Port
I 100733

AmplifierAddress

I 255 3:
Search for Unit

[~ Use PassThrough

Host Address| 13

Log File Location (REQUIRED) Browse...

Gy

Searching while connected to multiple units is not recommended.

Create | Cancel
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Figure 33: Add Outdoor PowerMAX Controller Box

Enter the Unit ID text that will be used to identify the unit in the M&C application. For example, "Master SSPA 1" for
Controller 1.

Enter the IP address of the Master or Slave unit . Refer to Table 1.
Use the default port 1007, or change to reflect the local network.

Enter the global address (255) in the Amplifier Address field, and click on the [Search for Unit] button. The utility will locate
the unit on the network. See Figure 34. Click on the [OK] button.

Search for Outdoor Controller Box n

Unit Found at the following Address:
11

Figure 34: Dialog Window, Search for Outdoor Controller Box
Click on the [Create] button to open the M&C windows.
Repeat for each Outdoor SSPA Controller.
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Overview of the Outdoor PowerMAX M&C

This section describes the information available in each of the Universal M&C screens for the Outdoor SSPA Controllers
used in Outdoor PowerMAX systems.

Status Window for Outdoor SSPA Controllers

The Status Window for the Outdoor SSPA Controllers (Controller 1, typically the Master controller) shows the operational
status of the array of four (4) SSPA modules for that system. See Figure 35.

~
(B el Moni o oo, s il i ==
——

File Action Maintenance and Database About 'u
g D—[’z I Master HPA1 Master HPA2 Pol/Phc controller Pol Sel controller VBUC controller Maint Sw1 Maint Sw2 SlaveH ¢ | »
S ~ o |
2 Status || settings | Fauts | 1P Setup | N + 1 | Calibration | Serial Number Utity | Special | s |
3 . Connecled ) —_—————

X® RX® UnitID Master HPA1 SSPAType | Four_Module |
Device Type | Rackmount SSPA | IPAddress [ 152168010 |
Model Number | 12136561 ] Unit Address 1 ]
Serial Number 400683 1/0 Board Revision | 21 ]
Fi Version Ver.622 Digital Core Board 135
Forward RF Power (dBm) SSPA Core SSPADC Current
Temperature
Summary Fault %\3\20
42 a4 a5 48 Main Supply Voltage 1  Booster Supply Voltage 1
16182022 2224282330
Reverse RF Power (dBm) 14 m
Main Supply Voltage 2 Booster Supply Voltage 2
0 10 16,082 o, 2 2% 28
2 1 2T
IQuery Count: 48 Packets Rec: 48 Missed Packets: 0 Disconnects: 0 Packets Resent: 0 Connected

Figure 35: Status Window, Outdoor SSPA Controllers

This window displays the Mute status (Carrier Enable, indicated by "Enabled", if unmuted, or "Muted"), Attenuation and
Summary Fault status LED. Also included is information about the System Forward RF Power, Reverse RF Power, SSPA

Core Temperature, Main Supply Voltages, DC Current and Booster Supply Voltages.
& Note: Changes to Mute Status and Attenuation made in this window will be overwritten by the system.

Settings Window for Outdoor SSPA Controllers

The Settings Window, shown in Figure 36, is common for all controllers, and is used to select the operation settings for the
unit.
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Figure 36: Settings Window, Outdoor SSPA Controllers

See your system manual for the required settings for each controller.

& Note: All settings are read-only. Changes made to settings in this window will be overwritten by the
system.

Faults Window for Outdoor SSPA Controllers

The Faults Window, shown in Figure 37, is common for all controllers, and is used to monitor the various fault conditions for
the SSPA Modules connected to the unit.

i

Maintenance and Database About
- Devices Master HPA1 | Master HPA2 | PolfPhc Pol Sel e VBUC 2 MaintSwl | MaintSw2 | SlaveH ¢ |»
Status | Settings [Fauts | P setup | N +1 |

291 d1Aaq '?
0
)

[ Fault Status ]
Standby
|Summary ISbb lBUC |
RF Switch 2
Module 1 . Power " High ") Inactive
Clear Supply Temperature
Optional
Faults Port 1 125*
Module 2 LowDC
Choe . | |W,wo Q | ‘Fwd RF Off ‘
tional 206
Faults Port 2
Module 3 Low DC , High
Clear 9 | Current 9 I lRelcaod Re ¥ l Cabinet .
Fan —
R | Fan 9 | lAuxiliary | |PreAmo | I
Packets Rec: 55 Missed Packets: 0 Disconnects: 0 Packets Resent: 0 Connected Y

Figure 37: Faults Window, Outdoor SSPA Controllers
Table 2 shows how the fault LEDs in this window correspond with the SSPA Modules for the indicated Outdoor Controller.
Table 2: Identifying SSPA Module Faults in Universal M&C Faults Window

Module # Fault LED SSPA Module
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Module 1 for the Faults Window of Controller 1 SSPA 1.1
Module 2 for the Faults Window of Controller 1 SSPA 1.2
Module 3 for the Faults Window of Controller 1 SSPA 1.3
Module 4 for the Faults Window of Controller 1 SSPA 1.4
Module 1 for the Faults Window of Controller 2 SSPA 2.1
Module 2 for the Faults Window of Controller 2 SSPA 2.2
Module 3 for the Faults Window of Controller 2 SSPA 2.3
Module 4 for the Faults Window of Controller 2 SSPA 2.4

IP Setup Window for Outdoor SSPA Controllers

The IP Setup Window is common for all controllers, and is used to adjust the IP settings for the connected unit. The IP
Address, Gateway Address, Subnet Mask, Local Port and IP Lock Address may all be modified. See Figure 38. Changes to
these settings require a unit restart before they are applied.

ri_!.

Action Maintenance and Database About
|Masu=rrm1 Master HPA2 | PolPhc Pol Sel I VBUC I MaintSwl | MaintSw2 | SlaveH ¢ | )

Status | Settings | Fauts [PSetp]|N+1 |
IP Settings MAC Address

IP Address [192.168.0.11 MACAddress 00:90:C2:F6:9C:7D
Gateway Address (192, 168.0.1 Change

Subnet Mask (355, 255, 255.0

201) dIAaQ

Web Password
Local Port (1007 -

Password
IP Lock Address [255,255.255.255

New Password
Change IP Settings I~ Modify Web Password k I

Count: 57 Packets Rec: 57 Missed Packets: 0 Disconnects: 0 Packets Resent: 0 Connected y

Figure 38: IP Setup Window, Outdoor SSPA Controllers

In addition, the operator may modify the read/write community and web passwords. The operator must check the box to
unlock the field for the new password, then click on the [Change] button to implement the change.
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Add RCP Unit to M&C

Launch the Universal M&C software. Click on the Action menu and select "Add Unit", then choose "Controller" from the pull-
down menu. See Figure 39.

(& Universal Monitor and Control — o X
File | Action Maintenance and Database About
g Add Unit > Compact Outdoor SSPA
5 Remove Unit Mini Compact Outdoor SSPA
Very Quick Poling High Power Outdoor SSPA
Rackmount

Launch Protocol Tester Westherproof

Logging. Outdoor PowerMAX Controller Box
Preferences... Controller

Maintenance Switch Controller

3100 VSAT BUC

vBUC

Evo Modem

Internal Redundant System >

N+1System

Ka ZBUC

RF Detector Box

ZBUC

Storage Facility

PLOBUC

Z's RF Detector Box

FSK PLO BUC

Figure 39: Universal M&C, Add New Controller Unit

A new dialog window will appear. See Figure 40. Select the method of communication (Serial Connection, Internet
Connection, or SNMP).

@ Add Controller - o X | [@ Add Controller - a X | (@ Add Controller - o X
unt > wen ] wen ]
@ Seral Connecton € DtemetComecton stwe € Seril Connecton @ DtemetComecton swp € Serid Connecton C intemetComecton & s
Serial Port 1P Address 1P Address
[comz: < 10.100.225.49 10.100.225.
Baud Rate port Community Read
[Baud 5600 < 10073

AmpliierAddress Amplifieraddress Community Wri
= =) fprvate
Search for Unit Search for Uit
Log File Location (REQUIRED) Browse... Log File Location (REQUIRED) Bronse... Log File Location (REQUIRED) Bronse...
C:\Users\Documents C:\Users\Documents. ‘ [c \Users\Documents
Searching while connected to multiple units is not recommended. Searching while connected to multiple units is not recommended. Searching while connected to multiple units is not recommended.

coe | ot el e o | G

4

Figure 40: Add Controller (Serial, Internet or SNMP Connection)

For Serial Connections, select the Serial Port and Baud Rate, and select the amplifier address. If you don't know the address
of the unit you may search for it. Click the Search for Unit button.

For Internet Connection, enter the IP address of the unit, and select the port and amplifier address. Click the Search for Unit
button if you don't know the address of the unit.

& Note: The Search for Unit feature is only useful when you have only one unit connected to your PC at a
time.

For SNMP, enter the IP address of the unit and the community read/write passwords.
The default Community Read password is public.
The default Community Write password is private.

A Unit ID is not required although it is recommended. If a Unit ID isn't entered the Unit ID will be assigned by the M&C. Click
the Create button to open the M&C windows.

Choose a log file location by clicking the Browse... button. The default is the "My Documents” folder. The log file name will be
the UnitID and the extension ".log" appended to it. i.e. "Unit1.log".

Click on the Create button to open the M&C windows.
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Overview of the RCP2 M&C

The Universal M&C user interface features five screens which are used to monitor and control the system.
« Status

* |P Setup

» Conditions

 Settings

* HPA Control Panel

Status Tab

The first screen is the "Status" window shown in Figure 41.

[& Universal Monitor and Control - [m] X

File Action Maintenance and Database About
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Figure 41: Universal M&C, Status Tab

The status screen reflects the Online/Standby status of each amplifier in the system, and the switch position of each
waveguide switch in the system. In addition, Internal and Device fault indicators are displayed. When there is no fault
condition on a given unit, the indicator illuminates green. When a fault condition exists, the indicator illuminates red.

& Note that in Figure 41 above, there is an RF Switch Fault. The RF Switch fault indicator is illuminated red
in the Internal Faults panel, and the RF Switch State in the mimic panel shows "Faulted”. In addition, the
baseball switch icons are colored red to indicate a switch faulit.

The user may click on one of the triangular amplifier icons to set that amplifier as the Standby unit in the system.

IP Setup Window

The second screen is the "IP Setup" window, shown in Figure 42.
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Universal Monitor and Control
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Figure 42: Universal M&C IP Setup Window

It shows the user all of the TCP/IP settings on the unit. When the IP Address is modified the unit must be reset for it to use
the new IP Address. Until the unit is reset it will use the old IP Address. The Amplifier Local Port is the port that the unit
monitors for UDP requests. The unit also answers requests using the same port.

If the Amplifier Local Port is changed the unit must be reset. The Gateway Address and Subnet Mask are standard settings
for TCPI/IP communications. If either of these settings is changed the unit must be reset for the new settings to take effect.
The IP Lock Address is used for security. If it is set to something besides 0.0.0.0 or 255.255.255.255 it will only answer the
address it is set to. For example, if the IP Lock Address is 192.168.0.50 then a request from 192.168.0.100 will not be

accepted. The IP Lock Address may be changed without resetting the unit.

Conditions Window

The third screen displays the Conditions of the units connected to the controller, as shown in Figure 43.
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Figure 43: Universal M&C, Conditions Window

The system forward power, reflected power, power supply voltages and LNA/LNB currents and temperatures are all
monitored. In addition, the calibration points of each LNA/LNB are displayed.
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Settings Window

The fourth screen is the "Settings" screen, shown in Figure 44.
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Figure 44: Universal M&C, Settings Window

It shows the user all available settings on the unit. All user-adjustable settings may be modified to suit the specific needs of
the customer. However, it should be noted that the units are pre-configured for the customer at the factory. If modification of
any settings is necessary, refer to the Table 7 of the Remote Control Interface section.

HPA Control Panel Window

The fifth screen is the "HPA Control Panel" screen, shown in Figure 45.
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Figure 45: Universal M&C, HPA Control Panel Window

From this window, the user may select the type of amplifier used in the system, choose the RF power units displayed, mute
or unmute the system, and set the attenuation levels of the system or individual amplifier offsets. The user may also monitor
the forward RF, temperature and DC current conditions of the HPA subsystem.
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Universal M&C Advanced Features

Universal M&C Preferences

The user can adjust certain preferences of the Universal Monitor and Control software. Click on the Action pull-down menu
and select Preferences. See Figure 46.
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Figure 46: Universal M&C > Action > Preferences

Queries

Click on the Queries icon at left to open the Query Settings menu. Select the PC Source Address. Adjust the interval that the
software queries the unit. Tick the Queries Enabled checkbox to begin sending queries to the connected unit. Note that if
queries are disabled, there will be no communication with the unit at startup. Untick the bottom checkbox to disable
commands on units set to Local Control Mode. See Figure 47.
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Figure 47: Universal M&C Preferences > Queries

Logs

Click on the Logs icon at left to open the Log Settings menu. Adjust the interval that selected parameters are recorded (in
minutes or seconds). Tick the checkbox to enable logging. See Figure 48.
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Figure 48: Universal M&C Preferences > Logs

TCP/IP

Click on the TCP/IP icon at left to open the TCP/IP Settings menu. Select the Local UDP Port (the software must be
restarted to take effect). Note that each UDP address must be unique. Default Unit UDP Port is 1007. See Figure 49.
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Figure 49: Universal M&C Preferences > TCP/IP

Appearance

Click on the Appearance icon at left to open the Appearance menu. Set the transparency of the M&C Windows. A setting of 0
indicates no transparency. Maximum value is 80. See Figure 50.
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Figure 50: Universal M&C Preferences > Appearance

Startup
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Click on the Startup icon at left to open the Startup menu. Tick the checkbox to enable auto-loading of the last-used device
configuration. See Figure 51.
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Figure 51: Universal M&C Preferences > Startup

Using the Device Logger

The Universal Logger may be used to show a real-time log of selected parameters. Before opening the logger, at least one
unit must be connected and added to the Universal M&C. To open the Logger, click on the Action pull-down menu and select

'Logging..." as shown in Figure 52.
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Figure 52: Universal M&C Action > Logging...

The Device Logger will open, as seen in Fig

ure 53.
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Figure 53: Universal M&C Device Logger Window

Click on the 'Add/Remove' button, which opens a new window as shown in Figure 54. Select the desired device in the
Available Devices pull-down menu. Individually select which parameters to log (or remove unwanted parameters).
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Figure 54: Universal M&C Device Logger > New Log Items Window

After choosing the parameters, the Logger window will be similar to Figure 55. Click on the Done button to accept the list of
selected parameters.
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Figure 55: Universal M&C Device Logger > New Log Items > Items Selected

You may modify the log interval by entering the number of seconds between each record. Default interval is 1 second. Click
on the Start Logging button to begin logging the selected parameters.
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Figure 56: Universal M&C Device Logger > Start Logging

Click on the 'File' menu and select 'Print' to print the graph and legend as shown in Figure 56. You may stop, start, and clear
the data at any time.

& While running the Logger, you may continue to use the Universal M&C to monitor the status of or make
settings modifications to any connected unit.

Saving M&C Configurations
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The Universal M&C allows users to save multiple configurations to a variety of units. In addition, the software features a
'Load Last Configuration' option that will reload the last configuration used by the M&C.

Save a Single Configuration

To save a single configuration, add the desired units to the Universal M&C and select 'Save Configuration' from the 'File’
menu. See Figure 57. After saving, a confirmation message will appear that states the success of the save. This saved
configuration may be reloaded even after a computer restart. It is important to note that the Universal M&C will occasionally
perform this save automatically.

Universal Monitor and Control - [m] X
File Action About
Load Configuration from File...
Load Last Configuration Settings | SNMP Settings |
Save Configuration UnitID: cot1 Model #: HPAC2400AM
. . Device Type: Compact Outdoor SSPA R
E——— s S -
ave Configuration As. A e Serial #: 123456
Save Configuration and Exit Address: | 1 Fi Version: [ Ver659
Exit Enable Forward RF Power Power S":’;va“h’
52dBm 10 14
CEnabled 8Ty
A i Reofl d ower )
ﬂ 9 dBRF = SSPADC Current
0.0 - m
43 50 52
46 54
" . External m
Summary Unit Online Mute
LowDC LowDC
- ow ow 10 12 14
‘Au)(lllary HSpare ‘ Current ‘ Voltage ‘ ams
High Forward RF Reflected '
Temperature Fault RF Fault Gate Voltage
6 4
BUC EE| A7 a7 P 2
[ Switch 1 Switch 2 104 0
Query Count: 12309 Connected p

Figure 57: Universal M&C File > Save Configuration

To be certain the proper configuration is saved, select 'Save Configuration As..."' from the 'File' menu, and navigate to a
directory to which the file will be saved. You may wish to name the file with descriptive text about the connected unit.

Load the Last Configuration

To load the last configuration, select 'Load Last Configuration' from the 'File' menu. See Figure 58. The M&C will load
whatever unit(s) were previously loaded. You may set the Universal M&C Preferences to automatically load the last
configuration used by the Universal M&C software when the software is run. See the Startup Preferences section.
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Figure 58: Universal M&C File > Load Last Configuration
Load a Configuration from a File

To load a specific configuration from a file, select 'Load Configuration from File..."' from the 'File' menu. Select the location of
the file as shown in Figure 59. Click the Open button to load the configuration to the Universal M&C.
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Figure 59: Universal M&C File > Load Configuration from File
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Use and Disclosure of Data

This product is classified as EAR99 and is subject to U.S. Department of Commerce regulations. Export, reexport or
diversion contrary to U.S. law is prohibited.



Proprietary and Confidential

The information contained in this document is the sole property of Teledyne Paradise Datacom. Any reproduction in part or
as a whole without the written permission of Teledyne Paradise Datacom is prohibited.

Information in this document is subject to change without notice.

All other company names and product names in this document are property of the respective companies.



Data Security

Teledyne Paradise Datacom amplifiers and controllers do not inherently provide encryption to transmitted data, and have
limited security measures to protect it. If the unit will be accessible over the Internet, exercise appropriate data security

protocols. Teledyne Paradise Datacom strongly recommends placing the equipment behind a protective Firewall or setting up
a VPN link with dual authentication for remote access.



About Teledyne Paradise Datacom

Teledyne Paradise Datacom, a division of Teledyne Defense Electronics LLC, is a single source for high power solid state
amplifiers (SSPAs), Low Noise Amplifiers (LNAs), Block Up Converters (BUCs), and Modem products. Operating out of two
primary locations, Rancho Cordova, CA, USA, and Chelmsford, England, Teledyne Paradise Datacom has more than a 20
year history of providing innovative solutions to enable satellite uplinks, battlefield communications, and cellular backhaul.

Teledyne Paradise Datacom
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(814) 238-3450
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+44(0)1245 847520
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